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ТАНИХ ТЭМДЭГ

АсуудалОйлгохуй Мэдэхүй Чадахуй Хэрэглэхүй Анхаарахуй

ӨМНӨХ ҮГ

XXI зууны иргэний чухал нэгэн чадвар бол компьютер, мэдээллийн технологийн 
дэвшилтэт талуудыг хэрэгцээндээ тохируулан зүй зохистой хэрэглэж сурах явдал билээ. 
Ингэснээр мэдээллийн нийгэмд хөл нийлүүлэн амжилттай сурч амьдрах боломж та 
бүхний өмнө нээгдэх болно. Уг сурах бичгийг мэдээллийн технологийн мэдлэг, чадварт 
суралцах, түүнийгээ өдөр тутмын амьдрал, хичээл сургалтад хэрэглэх, мэдээллийн 
технологи ашиглан аливаа мэдээллийг боловсруулах, мэдээллийн нийгмийн ёс 
зүйд суралцах, хэвшүүлэх, цахим ертөнцийн аливаа эрсдэлээс өөрийгөө хамгаалах, 
бүтээлч, үндэсний өв уламжлалаа дээдэлдэг сурагч болоход чиглүүлэн боловсруулж, 
та бүхэндээ өргөн барьж байна. Сурах бичиг нь хоёр бүлэгтэй. 

Мэдээллийн технологийн үндсэн ойлголт бүлгийн хүрээнд:
 - Мэдээллийн нийгэм, түүний ирээдүйн талаар мэдлэгээ гүнзгийрүүлж, мэдээллийн 

нийгмийн соёлтой, ёс зүйтэй иргэн болох; 
 - Компьютерын сүлжээний зохион байгуулалт, ажиллагааны зарчмыг ойлгох, 

сүлжээний орчинд мэдээлэл солилцох, чөлөөт, нээлттэй эхийн программыг 
хэрэгцээндээ тохируулан сонгон ашиглах;

 - Аливаа үйл ажиллагааг явуулах, мэдээлэл боловсруулах, асуудал шийдвэрлэх 
үйлийг төлөвлөн гүйцэтгэх.

Мэдээлэл боловсруулах технологийн хэрэглээ бүлгийн хүрэнд:
 - Баримт бичиг боловсруулах технологийн талаарх мэдлэгээ тэлж, мэдээллийн 

технологи болон бусад хичээлээр хийсэн бичил судалгааны ажлынхаа үр дүнг 
баримтыг нэгтгэн боловсруулах;

 - Зураг боловсруулах технологийн талаар ойлгож, бэлэн зургийг засварлах, зургийн 
бүтээлийг зохиомжлон боловсруулах;

 - Хүснэгтэн мэдээлэл боловсруулах технологийн талаарх мэдлэг, чадвараа ахиулж, 
тооцоолол бүхий хүснэгтэн мэдээлэл боловсруулах, хүснэгтэн мэдээллийн  
загварыг байгуулах;

 - Цахим үйлчилгээ, цахим ертөнц дэх зохиогчийн эрх, үүрэн холбооны технологийн 
талаарх мэдлэг, ойлголтоо гүнзгийрүүлж, хайлтын системийн хэрэглэх.

Бүлэг бүрийг хичээнгүйлэн судалж, түүний хүрээний мэдлэг, чадварыг эзэмших нь 
мэдээллийн нийгмийн боловсролтой, ёс зүйтэй гишүүн болон төлөвшихөд ихээхэн 
чухал. Тиймээс сурагч та сурах бичгийг судлахдаа:
 - Компьютер, мэдээллийн технологи ашиглан аливаа асуудлыг шийдвэрлэх, 

мэдээллийг боловсруулахдаа төлөвлөгөө гарган түүнийхээ дагуу үр бүтээлтэй 
ажилладаг;

 - Хэрэгцээт мэдээллээ боловсруулахдаа мэдээллийн технологи, хэрэгслийг зөв 
сонгон ашигладаг;

 - Компьютер, мэдээллийн технологийг ёс зүйтэй, соёлтойгоор бие даан болон 
хамтран хэрэглэх, эзэмшсэн мэдлэг, чадвар, туршлагаа технологи ашиглан 
бусадтай хуваалцах арга барилд суралцахад анхаараарай.

Зохиогчид
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МЭДЭЭЛЛИЙН ТЕХНОЛОГИЙН 
ҮНДСЭН ОЙЛГОЛТБҮЛЭГ I

1.1. МЭДЭЭЛЭЛ, ЗАГВАР

Яагаад судалж байна вэ? 
XXI зууны сурагчид амьдарч буй нийгмийнхээ хөгжил, чиг хандлагыг танин мэдэх.

Сэдвийг судалснаар юу хийж сурах вэ? 

• Мэдээллийн нийгэм, түүний онцлогт дүн шинжилгээ хийх;
• Мэдээллийн нийгмийн ёс зүйг даган мөрдөх;
• Мэдээлэл, харилцаа холбооны технологи (МХХТ)-ийг амьдрал ахуйдаа ашиглах;
• Мэдээллийг хамгаалах, мэдээллийн аюулгүй байдлыг хангах;
• Мэдээллэн загварын жишээ, физикийн загвар байгуулах.

1.1.1. Мэдээллийн нийгэм, түүний давуу тал
Жил бүрийн 5 дугаар сарын 17-ыг “Дэлхийн мэдээлэлжсэн нийгэм”-ийн өдөр 
болгон дэлхий даяар тэмдэглэдэг уламжлалтай. Багш энэ арга хэмжээг 
хэрхэн тэмдэглэн өнгөрүүлэх талаар төлөвлөгөө гаргаж, ханын сонин хийх 
даалгаврыг сурагчдад өгөв. Сурагчид мэдээлэлжсэн нийгмийн талаар 
материал цуглуулах болов. Хаанаас, хэрхэн цуглуулах вэ? 
Мэдээллийн нийгмийн тухай нийгэм, улс төрийн үзэл баримтлал хөгжингүй 
орнуудад 1970-аад оны эцэс, 1980-аад оны эхэнд бараг нэгэн зэрэг үүсжээ. 
Энэ нэр томьёог хэд хэдэн утгаар хэрэглэдэг. Үүнд:
1. Аж үйлдвэржсэний дараах нийгмийн хамгийн сүүлчийн төрлийн нэг;
2. Аж үйлдвэржсэн нийгмийн хөгжлийн хамгийн сүүлчийн үе шат;
3. Нийгэм-эдийн засгийн бүрдлийн өвөрмөц төрөл;
4. Хүн төрөлхтний хөгжлийн шинэ үе гэх мэт.
Мэдээллийн нийгэм нэр томьёог анхлан хэрэглэсэн мэргэжилтнүүд 
мэдээллийн үйлдвэрлэлийг чанарын өндөр түвшинд явуулж, түүнийг хадгалах, 
боловсруулах, хэрэглэхэд зайлшгүй шаардлагатай техник технологийн 
нийгэм хэмээн тайлбарласан байдаг. Мэдээллийн нийгэм үүсэн төлөвшихөд 
нөлөөлсөн мэдээллийн хувьсгал нь хүний нийгмийн хөгжлийн түүхэнд, тэр 
дундаа мэдээллийн салбарт эрс өөрчлөлт авчирсан (Зураг 1.1.1).

Мэдээллийн дөрөв дэх 
хувьсгал

Микропроцессор, мэдээлэл, харилцааны нэн шинэ 
техник, технологийн хөгжил (мэдээллийг хадгалах, хайх 

болон боловсруулах системийн эрс өөрчлөлт)

Мэдээллийн гурав дахь 
хувьсгал

Холбоо харилцааны шинэ техник технологийн хөгжил  
(радио, цахилгаан, телевиз)

Мэдээллийн хоёр дахь 
хувьсгал

Ном хэвлэлийн хэвлэн нийтлэл, түгээн дэлгэрүүлэлт 

(шинжлэх ухаан, техникийн хөгжил)

Мэдээллийн анхны 
хувьсгал

Бичиг үсгийн боловсрол, соёлын хөгжил төлөвшил  
(мэдлэгийг хуримтлуулах болон дэлгэрүүлэх)

Зураг 1.1.1 Мэдээллийн хувьсгалын үе шат
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БҮЛЭГ
I

МЭДЭЭЛЛИЙН ТЕХНОЛОГИЙН ҮНДСЭН ОЙЛГОЛТ БҮЛЭГМЭДЭЭЛЛИЙН ТЕХНОЛОГИЙН ҮНДСЭН ОЙЛГОЛТ

Мэдээллийн нийгэмд шилжихэд тухайн 
технологийн хөгжлийн үйл явц, тэдгээрийн 
ач холбогдлыг өргөжүүлдэг ба энэ нь Зураг 
1.1.2-т үзүүлсэн бүрэлдэхүүн хэсэгтэй байна.

Мэдээллийн нийгмийн хамгийн гол онцлог 
шинжийг үндэсний, бүс нутгийн, дэлхийн 
хэмжээнд үйлчилдэг өндөр технологийн 
мэдээллийн сүлжээ юм хэмээн үздэг. 

Мэдээллийн нийгэмд мэдээллийг 
зохион байгуулах, үйлдвэрлэх, түгээхэд 
хэвлэл, радио, телевиз болон олон нийтийн 
мэдээллийн хэрэгслийн бусад төрөл, хэлбэр 
гол байр суурийг эзэлдэг. 

Мэдээллийн нийгмийн сөрөг тал
Мэдээллийн нийгмийн хөгжлийн зэрэгцээ сөрөг асуудлууд гарсаар байна. 

Тухайлбал, интернэт болон сүлжээг буруу зорилгоор ашиглах, хувийн нууц 
болон зохиогчийн эрхийг зөрчих, оюуны өмчийн хулгай гэх мэт. 

Мэдээллийн үнэ цэнэ өсөхийн хэрээр мэдээллийн хамгаалалт, аюулгүй, 
найдвартай байдлын асуудал хурцаар тавигдаж байна. 

Компьютерын вирус ч багагүй хохирол учруулж байна. Энэ нь сүлжээгээр 
дамжин өөрийгөө тархаах боломжтой. Вирус нь программд нэвтрэн кодоо 
залгах, эсвэл MS Word программын макро хэлбэрээр ч тархдаг. Компьютер 
дэх мэдээллийг хулгайлан өөр сервер рүү нууцаар илгээх (Spyware), реклам 
сурталчилгаа гаргах зориулалтаар халдварлах (Adware), өөр хүнийг таны 
компьютерт зөвшөөрөлгүй хандахад зориулагдсан (Trojan Horse) гэх мэтээр 
вирусний хэлбэр өөрчлөгдөж байна.

харилцаа 
холбооны 
дэд бүтэц

үүсгэх

сүлжээнд 
хандах 

ерөнхий 
дүрэм 
гаргах

мэдээллийн 
систем 
үүсгэх

Зураг 1.1.2 Мэдээллийн 
нийгмийн шилжилт

1. Ямар нийгмийг мэдээллийн нийгэм гэж үзэх вэ? Бид ямар нийгэмд 
амьдарч байна вэ? Энэ талаар анги хамт олноороо хэлэлцүүлэг явуулж, 
дүгнэлт бичээрэй.

2. Биологийн болон компьютерын вирусний төсөөтэй ба ялгаатай шинжийг 
тоочин бичиж, тайлбарлана уу.

1.1.2. Мэдээллийн нийгмийн гүйцэтгэх үүрэг

А. Өдөр тутмын амьдралд
Мэдээлэл, харилцаа холбооны 

технологийн эрчимтэй хөгжил, 
мэдээллийн технологийн иж бүрэн 
байдал нь мультимедиа технологийг 
хэрэглэх боломж олгож байна. Орчин 
үеийн мультимедиа систем нь дараах 
системүүдээр холбогдох боломжтой 
(Зураг 1.1.3).

Мэдээлэл дамжуулах технологийн 
хөгжилд тулгуурлан цаг хугацаа, орон 
зайнаас үл хамааран хүмүүс хоорондоо 
хялбархан харилцаж, өдөр тутмын 
амьдралаа зохицуулдаг болсон байна.

Зураг 1.1.3

МХХТ 
(мэдээлэл 

дамжуулалт)

компьютер

факс зурагт

проекторгар утас

радио 
хүлээн 
авагч

автомат 
хариулагч
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1. Цаг агаарын мэдээг ямар эх үүсвэрээс хүлээн авдаг вэ?
2. Гар утсаа ямар зорилгоор ашигладаг вэ?
3. Дотоод, гадаадад байгаа хэн нэгэнтэй хэрхэн холбогдох вэ?
4. Яаралтай мөнгөн шилжүүлгийг хэрхэн хийдэг вэ?
5. Шинэ бүтээгдэхүүний талаарх мэдээллийг ямар аргаар олж авдаг вэ?
6. Монголд төдийгүй гадаадад болж буй үйл явдлын тухай мэдээллийг хэрхэн 

хүлээн авдаг вэ?

Б. Ажил үүрэгт:
МХХТ-ийн хөгжил нь зөвхөн салбарын хөгжлөөр хязгаарлагдахгүй дараах 

салбаруудад эрчимтэй нэвтэрч байна. Үүнд:
• Эдийн засаг, банк санхүү: Гар утас ашиглан мөнгөн гүйлгээ хийх, дансны 

үлдэгдлээ шалгах, цаг хугацаанаас үл хамааран бэлэн мөнгөний машин 
(ATM) ашиглах гэх мэт олон боломжийг хэрэглэгчдэд олгож байна. 

• Засаглал: Байгууллагууд мэдээлэл харилцааны технологийн тусламжтай 
иргэд, аж ахуйн нэгжтэй харилцаж, хамтран ажиллаж байна. 

• Үйлдвэр: Тоног төхөөрөмж ашиглан үйлдвэрлэлийн үйл ажиллагааг 
автоматжуулж байна. Цахим худалдаа нь хэрэглэгч, үйлдвэрлэгчид 
үйлчилгээний шинэ урсгалын бүтцийг бий болгов. 

• Анагаах ухаан: Төрөл бүрийн оношилгоо хийх цахим багаж төхөөрөмж бий 
болж, мэргэшсэн мэргэжилтнүүдийг бэлтгэх хэрэгцээ үүсэж байна. 

• Боловсрол: Интернэтээс сургалтын хэрэгцээт мэдээллийг хайх, сургалтын 
тоглоом болон программ хангамжийг ашиглах, зайн сургалтын системийг 
нэвтрүүлэх зэрэг ажил хийгдэж байна. 

• Харилцаа холбоо: Мэдээлэл, харилцаа холбооны технологийн хөгжилд 
тулгуурлан гэрээсээ ажлаа хийх шинэ хэлбэр бий болж байна. 

• Урлаг: Компьютерын график, медиа урлаг нь кино, реклам, зурагтын 
программ, тоглоомд өргөнөөр ашиглагдаж байна. 

Төсөлт ажил

Дараах асуултаар багаар бичил судалгаа хийж, ангийнхантайгаа хэлэлцээрэй. 
• Мэдээлллийн нийгэмд хувь хүний оролцоо ямар байх вэ?
• Асуудал шийдвэрлэх чадвараа дээшлүүлэхэд МХХТ-ийг хэрхэн ашиглах 

вэ?
• Та нар МХХТ-ийг юунд ашиглаж байна вэ? 

Зураг 1.1.4

Харилцаа

Шүүмжлэлт 
сэтгэлгээ

Мэдээлэлтэй ажиллах

Бүтээх

Асуудал 
шийдвэрлэх

Хамтын ажиллагаа

Инновац

В. Хувь хүний хөгжилд:
Мэдээллийн нийгэмд амьдарч буй 

иргэн бүр тодорхой чадварыг эзэмших 
нь чухлаар тавигдах болсон (Зураг 
1.1.4). Үүнд:
• Харилцаа: Төрөлх хэлээ сайн 

эзэмшихээс гадна МХХТ ашиглан 
бусадтай харилцах, харилцааны 
соёлтой байх;

• Шүүмжлэлт сэтгэлгээ: Мэдээлэлд 
дүн шинжилгээ хийж, өөрийн байр 
суурийг илэрхийлэх;
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1.1.3. Мэдээллийн нийгэмд шилжих үйл явц 

Мэдээллийн технологийн үеийг хүн амын талаас илүү нь мэдээлэл-оюуны 
үйлдвэрлэл, үйлчилгээний салбарт ажиллаж байгаагаар тодорхойлж болно. 
Дараах хүснэгтээр нийгмийн хөгжлийн онцлог, шинж чанарын талаар мэдээлэл 
өгөхийг зорилоо.

Хүснэгт 1.1.1 Мэдээллийн нийгэм рүү шилжих үйл явц

Эртний соёл 
иргэншлийн нийгэм

Боловсронгуй
(соёлжсон) нийгэм Мэдээллийн нийгэм

Шилжилтийн 
эхлэл

Нийтийн тооллын 5 
дахь мянган жил XV зууны дундаас XX зууны төгсгөл

Шилжилтийн 
урьдчилсан 

нөхцөл
Гар бичмэл Ном хэвлэл Мэдээллийн нэгдмэл 

орчин

Боловсрол Элит ангид Олон нийтэд Олон нийтийн, тасралтгүй
Үйлдвэр Гар аргаар Механик Автомат

Үйлдвэрлэлийн 
хэлбэр

Гар хийцийн, 
цехийн үйлдвэрлэл Корпорац Үндэстэн дамнасан 

корпорац
Санхүү Алт, мөнгө Цаасан мөнгө Цахим төлбөр

Эдийн засгийн 
бодлого

Материаллаг 
нөөц бүрдүүлэлт, 
хуваарилалт

Нийгмийн баялгийн 
сан бүрдүүлэлт, үр 
дүнтэй хуваарилалт

Зах зээл Орон нутгийн Үндэсний Даяарчлагдсан

Үйлчилгээний 
хүрээ

Газар зүйн орон 
зайг эзэмшил

Улсуудад 
хуваагдсан газар 
зүйн орон зай 

Корпорацад хуваагдсан 
мэдээллийн орон зай

Олон нийтийн 
мэдээллийн 

хэрэгсэл
Байхгүй Хэвлэн нийтлэл Цахим мэдээлэл

Олон улсын 
байгууллагын 

үүрэг

Дайнаар 
зохицуулагдсан 
орнуудын улс 
төрийн бодлого

Эдийн засаг ба 
худалдаагаар 
зохицуулагдсан 
орнуудын улс 
төрийн бодлого

Мэдээллээр 
зохицуулагдсан бодлого:
- Нэгдсэн стандарт
- Хуулийн нэг журам

1. Хүснэгтийн өгөгдлийг ашиглан 
график байгуулж, дүгнэлт хийгээрэй.

2. Энэ хичээлийн жилд ямар хичээлийг 
долоо хоногт хэдэн цагаар судалж 
байна вэ? Хичээл тус бүрээр юу 
судалж, ямар мэдлэг, чадварыг 
эзэмшиж байна вэ? Юу нөлөөлсөн талаар эргэцүүлэл хийж, багаар 
хамтран ярилцаарай. 

Хичээлийн нэр Судлах цаг
Монгол хэл 2

Математик 4

Мэдээллийн технологи 1

....

• Мэдээлэлтэй ажиллах: Мэдээллийг хайх, хүлээн авах, боловсруулах, 
хадгалах, ашиглах, түгээх чадвар;

• Инновац: Шинийг эрэлхийлж, шинэ санаа олох, хэрэгжүүлэх;
• Бүтээх: Мэдээ, мэдээлэлд тулгуурлан мэдлэг бүтээх;
• Асуудал шийдвэрлэх: Тулгарч буй асуудлыг тодорхойлж, зөв шийдэл 

гаргаж, шийдвэрлэх;
• Хамтын ажиллагаа: Бусадтай багаар хамтран ажиллах.
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Төсөлт ажил 

Мэдээллийн нийгэмд шилжихэд гарч буй өөрчлөлтийн талаар багаар 
бичил судалгаа хийнэ үү. Үүнд:
1. Эдийн засгийн бүтэц болон хөдөлмөрийн зохион байгуулалтын өөрчлөлт;
2. Олон нийтийн МХХТ-ийн ашиглалт, хөгжил; 
3. Мэдээллийг хүртэх хязгааргүй орон зайн боломж;
4. Хүн амын мэдээлэлтэй ажиллах соёлын дэвшил; 
5. Боловсролын системийн өөрчлөлт;
6. Хүмүүсийн амьдралын хэв маягийн өөрчлөлт.

1.1.4. Мэдээллийн нийгмийн ирээдүй

Юбиктос (Ubiquitous)
Энэ нь мэдээллийг хэзээ ч, 

хаана ч ухаалгаар боловсруулах, 
дүн шинжилгээ хийх, хөгжүүлэх 
чадвартай компьютер гэсэн утгатай 
юм. Жишээлбэл, юуг ч, хэн ч гэдэг нь 
зөөврийн компьютеруудыг холбоод 
зогсохгүй гэр ахуйн цахилгаан хэрэгсэл 
эд зүйлсийг хооронд нь холбож 
болно гэсэн үг. Автомашин, гэрийн 
тэжээвэр амьтан төдийгүй бага насны 
хүүхэд, өндөр настанд бичил чипийг 
суурилуулснаар тэдгээрийн байрлал, 
хөдөлгөөний талаарх мэдээллийг системд илгээж, улмаар хугацааны бодит 
горимд аюулгүй байдлыг автоматаар хянах, хангах боломжийг олгодог. 

Төсөлт ажил 1

“9 дүгээр ангийн улсын шалгалтын жишиг даалгавар”-ыг Google хайлтын 
систем ашиглан хайж, татаж авна уу. Татаж авсан даалгаврыг гүйцэтгэнэ үү. 

Татаж авч 
чадсан

Гүйцэтгэсэн 
даалгаврын тоо

Гүйцэтгэж чадаагүй 
даалгаврын тоо

Яагаад 
чадаагүй?

Математик
Байгалийн ухаан
Монгол хэл
Нийгмийн ухаан

Төсөлт ажил 2

Мэтгэлцээн: МХХТ-ийг ашигласан сургалтын хэлбэрийг цаашид 
хөгжүүлэх хэрэгтэй юу? 

Бэлтгэл: Мэдээлэл цуглуулах, судалгаа хийх, боловсруулалт хийх, 
оролцох хэлбэрийг сонгох, мэтгэлцэх орчноо бүрдүүлэх, тухайн өдрийн ажлын 
төлөвлөгөөг зохиох.

1.1.5. Мэдээллийн аюулгүй байдал, хамгаалалт

Номин нэгэн байгууллагын серверт үл таних этгээд нэвтэрч, тус 
байгууллагын санхүүгийн мэдээллийг хулгайлж, нийт ажилтнуудын хувийн 

Зураг 1.1.5

СҮЛЖЭЭ
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3. Мэдээллийн нууцлал: Мэдээлэлтэй ажиллах дурын үйлдэл нь тодорхой 
дүрмийн дагуу хийгдэж, аюулгүй байдлыг хангасан байна. Тодорхой 
мэдээлэлд хандах ёсгүй, эсвэл түүнийг ашиглах эрхгүй хүмүүс мэдээллийг 
ашиглах тохиолдолд түүний нууцлал алдагдана.
Мэдээллийн аюулгүй байдлын аливаа асуудлыг шийдвэрлэхийн тулд 

мэдээллийн аюулгүй байдал, хамгаалалт технологиудын талаар ойлголттой 
байх шаардлагатай. Орчин үед хурууны хээ, дуу хоолой таних зэрэг 
системүүдийг ашиглан зөвшөөрөлгүй хандалтаас хамгаалж байна.

Зураг 1.1.7. Мэдээллийн хамгаалалтын төрөл

М
эд

ээ
лл

ий
н 

ха
м

га
ал

ал
т

Энэ нь компьютер, техник хэрэгсэл, программ хангамж зэрэг физик 
биетийн хамгаалалт юм. Жишээ нь: ажилтны бүртгэлийн систем, карт 
уншигч машин, өгөгдлийн нөөц хувь, ус болон гал үл нэвтрэх газар...

Энэ нь хэрэглэгчийг систем, мэдээллийн санг бүхэлд нь болон хэсэгчлэн 
хандах хандалтыг зохицуулж, системийг зөвшөөрөлгүй хандалтаас 
хамгаална. Жишээ нь: системд хандах хэрэглэгчийн нууц үг...

физик

логик

МЭДЭЭЛЛИЙН АЮУЛГҮЙ БАЙДАЛ

Дүрэм журам 
(байгууллагын 

аюулгүй байдал)

Бүтээгдэхүүн 
(физик аюулгүй 

байдал)

Хүмүүс (хувийн 
аюулгүй байдал)

Мэдээллийн 
бэлэн байдал

Мэдээллийн бүрэн 
бүтэн байдал

Мэдээллийн 
нууцлал

Мэдээлэл
Харилцаа 

холбоо

Программ 
хангамж

Техник 
хангамж

Зураг 1.1.6 Мэдээллийн аюулгүй байдал

1. Компьютерт байгаа мэдээллээ хэрхэн хамгаалдаг талаар 60-80 үгтэй 
зөвлөмж бичиж, бусадтай туршлагаа хуваалцаарай. 

2. Хурууны хээ, дуу хоолойгоор таних системийн талаар бичил судалгаа 
хийн хэлэлцэж, дүгнэлт гаргана уу.

3. «Мэдээллийн аюулгүй байдлын талаарх мэдлэгээ дээшлүүлэх ямар арга 
зам байж болох вэ?» сэдэвт хэлэлцүүлэг хийж, эргэцүүлэл бичнэ үү.

мэдээллийг интернэтэд байршуулж, олон нийтэд тараасан баримтыг уншсан 
тухайгаа мэдээллийн технологийн багш болон ангийнхандаа ярив. 

Мэдээллийн аюулгүй байдал гэдэг нь мэдээлэл болон мэдээллийн 
системийг тэдгээрт зөвшөөрөлгүй хандах, хэрэглэх, тараах, саад учруулах, 
засвар өөрчлөлт хийх, нарийвчлан судлах, шалгах, бичлэг хийх, устгах 
зэрэг үйлдлээс хамгаалах явдал юм. Энэ нь мэдээллийн нууцлал, үнэн зөв, 
ашиглахад бэлэн бөгөөд бүрэн бүтэн байдлыг хангахад оршино.
1. Мэдээллийн бэлэн байдал: Мэдээлэл аюулгүй байдалд байж, 

хэрэглэгч хандах боломжтойгоор хадгалагдсан байна. Үүний тулд тоног 
төхөөрөмжүүд хэвийн ажиллагаатай, хадгалах төхөөрөмжүүд эвдрэлгүй, 
зохих программ хангамжуудтай, бүх тохиргоо хийгдсэн байх шаардлагатай.

2. Мэдээлийн бүрэн бүтэн байдал: Энэ нь тодорхой дүрэм бүхий 
мэдээллийн логик бүтцээр тодорхойлогддог. Мэдээллийг өөрчлөх болон 
боловсруулахад түүний бүрэн бүтэн байдал хадгалагдах ёстой.
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Физикийн загвар 
байгуулцгаая

Физикийн объектын   
гол   чухал шинж чанарт 
тулгуурлан  түүний 
мэдээллэн загварыг 
байгуулна. Ийм мэдээллэн 
загвар байгуулах нь 
физикийн объектын гол 
шинжийг илэрхийлж чадах 
тоон өгөгдлүүдийн хамаарлыг математикаар загварчлахад хүргэнэ. Физикийн 
загвар байгуулах үйл ажиллагааны бүдүүвчийг Зураг 1.1.9-д харууллаа.

БҮЛЭГ
I

МЭДЭЭЛЛИЙН ТЕХНОЛОГИЙН ҮНДСЭН ОЙЛГОЛТ

1.1.6. Мэдээллэн загвар, түүний жишээ

Загваруудыг нийтлэг болон 
онцлог шинжээр нь нэгтгэн 
ангилж болно. Ингэснээр 
нэг ангилал дахь мэдээллэн 
загварыг байгуулахад ижил 
арга хэрэглэх боломжтой. 
Мэдээллэн загварыг 
математикийн, физикийн, 
химийн, хэлний, логикийн 
гэх мэтээр ангилдаг. 8 дугаар 
ангид хялбар математик 
загварын талаар судалсан. 
Аливаа загварыг байгуулах 
үйлийн дарааллыг 
зураг 1.1.8-д үзүүлснээр 
тодорхойлж болно.

4. Хувь хүний мэдээллийг интернэтэд байршуулж, олон нийтэд тараасан 
хэргийг ёс зүй болон хамгаалалт талаас шүүн хэлэлцээрэй. Үүнээс ямар 
хор уршиг гарч болох вэ?

Зураг 1.1.8 Загварчлах үйл явц

Загварчлалын 
объект

Загварчлалын 
зорилго

Үгүй

Тийм

Объектын илэрхий байгаа 
шинж чанарт задлан 

шинжилгээ үнэлгээ хийх

Гол чухал шинж чанарыг 
сонгон авах

Дүрслэлийн хэлбэрээ 
сонгох

Хийсвэрчлэх

Загварын хэрэглээ

Загвараа гаргаж авах

Загвар 
зөрчилтэй эсэх

Загвар 
объект болон 
зорилгодоо 
дүйцэж буй 

эсэх

Тийм

Үгүй

Зураг 1.1.9. Физикийн загвар байгуулах бүдүүвч

 

Байгуулсан мэдээллэн загварт үндэслэн физикийн системийг 
тайлбарлах 

Гол шинж 
чанарыг 
тодруулах 

Физик 
объектыг 
төлөөлөх 
эсэх Физикийн объект Физикийн объектын 

математик загвар 
 

Физикийн объектын 
мэдээллэн загвар 
 
 
 

Жишээ болгон дараах хялбар бодлогыг авч үзье.
Бодлого: Баатар хүү тоглоомын машинаа V

0
 (м/с) хурдтай түлхэв. Машин 

шулуун замаар хөдөлж, t секундийн дараа зогссон бол хэдий хэмжээний зам 
туулсан бэ? Энэхүү бодлогод дараах хязгаарлалтуудыг авч үзье. Үүнд:

•  Хөдөлгөөн зөвхөн шулуун замаар явагдана.
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1. Багаараа мэдээллийн аюулгүй байдлын өдөрлөгийг зохион байгуулах хөтөлбөр 
боловсруулж, танилцуулга хийнэ үү. 

2. Оросын эрдэмтэн Д.И.Менделеевийн зохиосон үелэх систем нь мэдээллэн 
загварын жишээ болох уу? Түүний шинжлэх ухаан дахь хэрэглээний талаар юу 
мэдэх вэ? Тодорхой жишээ гаргаж, хос хосоороо ярилцана уу.

3. Физик болон математикийн сурах бичигт олон тооны бүдүүвч зураг, харин түүхийн 
сурах бичигт гэрэл зураг байдгийг тайлбарлаарай.

4. Загварчлалын объектыг “байшин” гэж үзвэл дараах тохиолдол бүрд объектын ямар 
шинж чанар нь хамгийн чухал байх вэ? 
а. Байшингийн план зураг зохиож буй үед;
б. Барилга барихад зайлшгүй шаардлагатай материалын тооцоог урьдчилан 

гаргаж байгаа үед;
в. Байшингийн эргэн тойрны тохижилтын зураг бүтээж буй үед.

5. Координатын систем дээр  ба   функцүүдийн графикийг 
  завсарт, 0.5 алхамтай байгуулж, огтлолцлын цэгийн координатыг 

олоорой.
6. Жигд удаашрах хөдөлгөөний загварын анхны хурд, хугацааны тодорхой утгад 

замыг тооцоолж, тайлбарлаарай. 
7. Жишээнд авч үзсэн тоглоомон машин t хугацааны дараа зогсоогүй ба V1 

хурдтай байсан гэвэл загварыг шинэчлэн байгуулж, тодорхой утгад замыг 
тооцоолоорой.

•  Машины хөдөлгөөнд саад учруулах ямар нэг зүйл байхгүй.
•  Машины зам нь налуу биш, тэгш байна. 
Эдгээр нөхцөлийг хангаж байгаа бол жигд хувьсах, тодруулбал жигд 

удаашрах хөдөлгөөний бодлого гэж үзэж болно.
Жигд хувьсах хөдөлгөөний хувьд замыг дараах томьёогоор олдгийг 

физикийн хичээлээс та бүхэн мэдэх болсон. 
2

0

2

at
S V t= +       (1)

Энд S-машины туулах замын урт. Бодлогод олохоор өгсөн. 
V
0
-машины анхны хурд (бодлогын өгүүлбэрт өгсөн)

t-хугацаа (бодлогын өгүүлбэрт өгсөн)
a-жигд хувьсах хөдөлгөөний хурдатгал 
Хурдатгал нь нэгж хугацаан дахь хурдны өөрчлөлтийг илэрхийлнэ. Жигд 

хувьсах хөдөлгөөний хувьд хурдатгалыг дараах томьёогоор олдог.
1 0
V V

a
t

−
=       (2)  Энд V0 нь эхний, V1 нь эцсийн хурд

Баатарын тоглоомын машин эцэстээ зогссон. Тиймээс t хугацааны дараах 
хурд буюу V1 нь 0 байна. Үүнийг (2) томьёонд тооцвол:

0
V

a
t

−
=     (3)

(3) томьёог (1) томьёоны хурдатгал a-ын оронд орлуулбал (4) томьёо гарна.
20

0 0

0 0

2 2 2

V
t

V t V tt
S V t V t

−

= + = − =  буюу   0

2

V t
S =     (4)

Ингээд Баатарын V
0
 м/с хурдтай хөдөлгөсөн машины t секундийн дараа 

зогсохдоо (4) томьёогоор тооцоологдох S замыг туулна. 
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1.2. КОМПЬЮТЕР

Компьютерын лабораторийн нэг компьютероос бусад компьютерт хичээлд 
хэрэглэх том хэмжээний цахим материалыг богино хугацаанд хуулах шаардлага 
гарав. Дараах аргуудын аль илүү тохиромжтой вэ? Файлыг агуулж буй хавтсыг 
хуваалцах горим (file share)-д тавьж, бусад компьютероос хандан хуулж авах, 
флаш зэрэг зөөврийн төхөөрөмж ашиглан бусад компьютер нэг бүрд хуулах, CD 
эсвэл DVD-д бичиж бусад компьютер нэг бүрд хуулах.

Зураг 1.2.1 Сүлжээний төрлүүд
а) б) в)

Хоёр болон түүнээс дээш тооны компьютер, бусад төхөөрөмжийг хооронд нь 
холбосноор дотоод сүлжээ үүснэ. Дотоод сүлжээ нь нэг болон хэд хэдэн барилга 
хамарсан байж болдог. Дотоод сүлжээнд хэвлэгч, сканнер гэх мэт төхөөрөмжийг 
дундаа ашиглах, хоорондоо мэдээлэл солилцох, мэдээлэл, программ хамтран 
эзэмших боломж бүрдэнэ. Тухайлбал, сургуулийн мэдээллийн технологийн кабинетийн 
компьютеруудыг дотоод сүлжээнд холбосноор багш заах хичээлтэй холбоотой нөөц 
материалыг сүлжээгээр түгээх, хоорондоо харилцах, сурагчдын хийсэн ажлыг өөрийн 
компьютероос үзэх, үнэлэх, бусад сурагчдад үзүүлж болно. Сүлжээнд удирдлага, 
багш, номын сан, бусад ажилтнууд холбогдсоноор сургуулийн дотоодод мэдээлэл 
солилцох орчин бий болно (Зураг 1.2.1a). 

Орон нутгийн сүлжээ нь улс доторх томоохон байгууллагын сүлжээ юм. Төмөр 
замын өртөө хооронд, хөдөө орон нутагт салбар бүхий томоохон банк хоорондын 
сүлжээ нь энэ төрлийн сүлжээ болно (Зураг 1.2.1б). 

Гадаад сүлжээ буюу интернэт нь дэлхий нийтийг хамарсан аварга том сүлжээ 
юм (Зураг 1.2.1в). Интернэтийн сүлжээг хэрэглэгчид зайнаас үл хамааран харилцах, 
мэдээллийг үзэх, татаж авах, дуу сонсох, кино үзэх, суралцах, хамтран ажиллах 
зэргээр хэрэглэдэг. Энэ бүх үйлчилгээ нь интернэтэд холбогдсон алс хол орших 
компьютеруудын хооронд хийгддэг. Жишээлбэл, багш болон сурагчид өөр газар 
байсан ч нэг зэрэг холбогдон сургалт явуулах боломжийг интернэт олгоно. 

Яагаад судалж байна вэ? 
Сүлжээ, нээлттэй эхийн программ хангамжийн талаар ойлгож, дотоод сүлжээ, 

чөлөөт программ хангамжийг хэрэгцээндээ тохируулан ёс зүйтэйгээр сонгон хэрэглэх.
Сэдвийг судалснаар юу хийж сурах вэ? 

• Компьютерын сүлжээ, сүлжээний орчинд мэдээлэл солилцох;
• Нээлттэй эхийн программ хангамж, түүний стандартын талаар ойлгох;
• Нээлттэй программ хангамжийг хэрэгцээндээ нийцүүлэн сонгон хэрэглэх.

1.2.1. Компьютерын сүлжээ

Холболтын төхөөрөмж, хэрэгслээр холбогдсон компьютер, бусад 
төхөөрөмжүүдийн цогцыг компьютерын сүлжээ гэдэг. Компьютерын сүлжээг 
бий болгосноор компьютер дахь нөөц, тоног төхөөрөмжийг хамтран эзэмших, 
мэдээлэл дамжуулалтыг түргэн шуурхай болгох боломж бүрддэг.

Компьютерын сүлжээг хамрах хүрээгээр дотоод сүлжээ (LAN-Local Area 
Network), орон нутгийн сүлжээ (MAN-Metropolitan Area Network), гадаад сүлжээ 
(WAN-Wide Area Network) буюу интернэт гэж хуваана. 
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Сүлжээ болон интернэтэд холбогдсон аливаа 
компьютер нь протокол хэмээх дүрмээр харилцдаг. 
Протокол нь мэдээлэл дамжуулах үйл ажиллагааг 
зохицуулдаг дүрмийн багц юм. Протоколыг үүрэг 

зориулалтаар нь хэрэглээний, дамжуулалтын, сүлжээний гэж хуваана. 

Протокол Товч тайлбар
Хэрэглээний протокол 
(Application Protocol)

Сүлжээнд өгөгдөл оруулах, хүлээн авах программын 
хоорондын харилцааг зохицуулах үүрэгтэй.

Дамжуулалтын протокол 
(Transport Protocol)

Сүлжээний компьютер хооронд өгөгдлийг алдаагүйгээр 
дамжуулах үүрэгтэй. 

Сүлжээний протокол 
(Network Protocol)

Мэдээлэл дамжих чиглэлийг тогтоож, өгөгдлийг дамжуулах 
үед гарах алдааг хянах, шаардлагатай бол өгөгдлийг 
буцаан дамжуулах үүрэгтэй.

0 7 15 23 31

10010001 00001010 00001010 00000011

145 10 34 3

145.10.34.3

Зураг 1.2.2 а) Сүлжээний карт, б) UTP кабель в) Шилэн толгой (RJ45)  
г) Свич д) Шилэн кабель

а) б) в) г) д)

Интернэтийн үндсэн харилцааны хэл буюу протокол бол TCP/IP 
(Transmission Control Protocol/Internet Protocol) юм. TCP нь өгөгдлийн алдаагүй, 
найдвартай дамжуулалтыг хангадаг бол IP нь өгөгдөл хэрхэн хаашаа дамжих 
мэдээллээр хангаж, илгээгч хүлээн авагчийн хаягийг агуулдаг. Интернэтэд 
холбогдсон компьютер бүр IP хаягтай байна. 

Сүлжээг ажиллагааны зарчмаар нь хоёр хуваана. Үүнд:
Тэгш эрхт сүлжээ (peer-to-peer) – сүлжээний компьютер 

бүр бусад компьютертойгоо ижил тэгш холбогдох боломжтой. 
Клиент/сервер (client/server) сүлжээ – нэгийг толгой 

болон бусдыг нь үйлчлүүлэгч хэлбэрээр зохион байгуулсан 
сүлжээ. Толгой компьютер нь 
сүлжээн дэх бусад компьютерыг 

удирдах, холболт үүсгэх, программ, мэдээлэлд 
хандах эрх тогтоох зэрэг үүрэгтэй. Үйлчлүүлэгч 
нь сүлжээнд олгосон эрхийн дагуу толгой болон 
бусад компьютертой ажиллахад хэрэглэгдэнэ. 

Жишээлбэл, интернэтээр www.gmail.com 
цахим шуудангийн үйлчилгээ авах хүсэлт 
илгээхэд уг хүсэлт нь цахим шуудангийн сервер 
компьютерт хүрнэ. Сервер нь хүсэлтийг хүлээн авч, веб хөтчид сайтыг ачаална.  
www.gmail.com нь уг серверийн домэйн нэр, харин түүний IP хаяг нь 
74.125.224.86 хэлбэрийн багц тоо байна. 

Сүлжээний төхөөрөмжүүд
Компьютерыг сүлжээний карт (NIC, Network Interface Card)-аар сүлжээнд 

холбодог (Зураг 1.2.2а). Уг карт нь сүлжээгээр мэдээллийг илгээж, хүлээн 
авна. 
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UTP (Unshielded Twisted Pair), шилэн кабель гэх мэт олон 
төрлийн кабелийг сүлжээнд ашиглана. UTP нь дөрвөн эрчилсэн 
хос металл утас бүхий кабель (Зураг 1.2.2б) бөгөөд төгсгөлд нь 
шилэн толгой буюу холбогчийг бэхлэн компьютерын сүлжээний 
картад, нөгөөг нь свич (Switch)-д холбоно (Зураг 1.2.2в). Дотоод 
сүлжээнд UTP кабелийг ашигласан бол зохион байгуулалт нь 

од хэлбэртэй байна. Од хэлбэрийн дотоод сүлжээнд свичийг 
ашиглана. Бүх компьютерыг свичид холбосноор дотоод 
сүлжээнд холбогдоно. Шилэн кабель нь гэрлийн долгион 
ашиглан мэдээллийг дамжуулах олон тооны шилэн утаснаас 
тогтдог (Зураг 1.2.2д). Уг кабель нь бусад металл кабелийг 
бодвол мэдээллийг дамжуулах хурд өндөр байдаг. 

Свич нь шилэн толгойгоор компьютерыг холбох олон нүхтэй. Эдгээр нүхийг 
порт (Port) гэдэг (Зураг 1.2.2г). Свич нь 4,8,16, 24, 32 порттой байна. Порт бүрд 
жижиг гэрэл байх ба гэрэл нь асаалттай, анивчиж байгаа нь порт (сүлжээ) ажиллаж 
байгааг илтгэдэг.

Утасгүй сүлжээ (Wireless network)-нд радио долгион 
ашиглана. Зөөврийн компьютер, ухаалаг гар утас нь утасгүй 
сүлжээнд холбогдсоноор интернэтийн үйлчилгээ авах өргөн 
боломжтой. Утасгүй сүлжээнд холбогдохын тулд орчин (Wi-Fi) 
үүсгэнэ. Ийм орчин үүсгэх утасгүй сүлжээний рөүтер (Wireless 

router) зэрэг төхөөрөмж бий. Өдгөө интернэт зурагт (IPTV) ашигласнаар утасгүй 
интернэтийн үйлчилгээг ашиглах болсон.

Суурин утасны шугамыг ашиглан интернэтэд холбогдох 
үед модем (Modem) хэмээх төхөөрөмжийг ашиглана. Модем 
нь телефон шугамаар дамжин ирсэн аналоги мэдээллийг 
тоон мэдээлэлд хувиргах, компьютероос дамжиж буй тоон 
мэдээллийг аналоги мэдээлэл хувирган илгээх үүрэгтэй. 

Сүлжээнд мэдээлэл дамжих хурдад кабелийн сонголт чухал нөлөөтэй. 
Сүлжээгээр мэдээлэл дамжих хурдыг нэг секундэд сүлжээгээр илгээх/хүлээн 
авах бит (bps-bit per second (bit/s), томсгосон нэгж: kbps-kilo bit per second, mbps-
mega bit per second гэх мэт)-ийн тоогоор хэмждэг. Жишээлбэл, сүлжээний хурд 
100 mbps гэвэл нэг секундэд 100 сая бит мэдээлэл дамжуулах эсвэл хүлээж авна 
гэдгийг илэрхийлнэ. 

Сүлжээний зохион байгуулалт 
Сүлжээний зохион байгуулалтын геометр зүй тогтлыг сүлжээний топологи 

гэдэг. Сүлжээг гол шугамт (Bus), од (Star), цагариг (Ring) топологиор эсвэл 
эдгээрийг хослуулан (Hybrid) зохион байгуулна. 

Од сүлжээ нь бүх компьютерыг свич рүү холбон зохион байгуулдаг. Энэ 
хэлбэрийн сүлжээнд гэмтлийг илрүүлэхэд хялбар байдаг. Кабелийн гэмтэл нь 
тухайн хэсэгт холбогдсон компьютеруудад  л нөлөөлдөг, сүлжээний бусад хэсэг 
хэвийн ажилладаг давуу талтай (Зураг 1.2.3a). 

Зураг 1.2.3 Сүлжээний топологи
а) б) в)
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1

2

3

4

5

Ингэснээр сонгосон хавтсанд дотоод сүлжээн дэх компьютероос хандаж 
болно. Уг хавтсанд файл хуулах, хавтсан дахь файлын мэдээллийг өөрчлөх 
боломжтойгоор зөвшөөрөх тохиолдолд Advanced Sharing цонхны Permission 
4  товчийг сонгоход гарч ирэх цонхны Permission for everyone хэсгийн 

Change (Change-өөрчлөх, Full control-бүх эрхийг олгох) 5  сонголтыг хийнэ. 
Ингэснээр сүлжээн дэх компьютероос уг хавтсанд буй файлыг өөрчлөх, 
файл ба программыг хуулах боломжтой болно. Энэ нь уг хавтсаар дамжин 
компьютерт вирус халдварлах нөхцөлийг бүрдүүлдэг тул уг сонголтыг хийхдээ 
анхааралтай хандаарай.

Зураг 1.2.4 myShare хавтсанд дотоод сүлжээнээс хандах зөвшөөрөл олгох 

Гол шугамт топологийн сүлжээ нь нэмэлт төхөөрөмж шаардлагагүй, 
кабельд хэмнэлттэй боловч сүлжээнд гэмтэл гарахад нийт сүлжээ ажиллахгүй 
болох ба гэмтлийг илрүүлэхэд төвөгтэй байдаг (Зураг 1.2.3б).

Цагариг сүлжээнд мэдээлэл нь компьютеруудын хооронд цагаригийн 
дагуу дамжина. Ингэхдээ компьютерын сүлжээний карт нь мэдээллийг хүлээн 
авч шуурхай санах ойдоо түр хадгалаад дамжуулдаг. Иймээс сүлжээнд нэг 
карт эвдрэхэд нийт сүлжээ ажиллахгүй болоход хүрдэг (Зураг 1.2.3в). 
1. Танай сургуулийн мэдээллийн технологийн кабинетийн дотоод сүлжээ 

хэрхэн зохион байгуулагдсан байна вэ? Ямар кабель ашигласан байна вэ? 
Тэгш эрхт сүлжээ юу? Эсвэл клиент/сервер сүлжээ юу? Толгой компьютер 
байна уу? Ямар топологитой сүлжээ вэ? Яагаад ингэж зохион байгуулсан 
болон давуу тал, боломжийн талаар ярилцаарай. 

2. Компьютерыг сүлжээнд холбосноор ямар давуу тал болон сөрөг тал 
байгаа талаар ярилцаарай.

3. Гэрийн компьютерыг сүлжээнд холбох төхөөрөмжүүдийг судлан үнэ, 
үзүүлэлтийг харьцуулсан судалгаа хийж, үр дүнг нэгтгэн бичээрэй.

1.2.2. Дотоод сүлжээнээс хавтсанд хандах
Дотоод сүлжээнд холбогдсон компьютероос нөгөө компьютерын 

зөвшөөрөл (share) бүхий хавтсанд хандаж болно. Хандах зөвшөөрлийг 
дараах алхмаар хийнэ (Зураг 1.2.4). 
• Хавтсаа идэвхжүүлж хулганын баруун товчлуурыг товших 1 ;
• Харагдаж буй цэснээс Properties командыг сонгох;
• Нээгдсэн цонхны Sharing хуудсыг сонгох;
• Энэ хуудаснаас Advanced Sharing товчийг сонгох 2 ;
• Нээгдэх цонхны Share this folder сонголтыг хийх 3 ;
• OK товчийг сонгох;
• Properties цонхны Close товчийг сонгох.
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Хавтсанд хандах 
зөвшөөрлийг цуцлахдаа өмнөх 
үйлдлээ давтан хийж, Share 
this folder сонголтыг хүчингүй 
болгоно. 

Зураг 1.2.5-д дотоод 
сүлжээнээс хандах зөвшөөрөл 
олгосон компьютерт хандаж 
харууллаа. Ингэхдээ 
компьютерын нэр эсвэл IP 
хаягийг хөтөч программын 
хаягийн мөрд өгөх хэрэгтэй.

Сүлжээ нь дараах үүрэгтэй. 
Үүнд:
• Харилцаа холбоог бий 

болгох. Хэрэглэгчид цахим 
шуудан, мессеж, цахим яриа 
(chat), видео хурал зэрэг харилцааг үүсгэнэ. 

• Техник хангамжийг хамтарч хэрэглэх. Сүлжээний компьютер бүр нь тус 
сүлжээнд холбоотой техник хангамжийг хэрэглэх боломжтой болно. 

• Файл, мэдээллийг хамтарч хэрэглэх (share). Сүлжээний орчинд 
баталгаажсан хэрэглэгч нь сүлжээний эрх олгосон компьютероос файл, 
мэдээлэлд хандаж болно. 

• Программ хангамжийг хамтарч хэрэглэх. Сүлжээнд холбогдсон хэрэглэгч 
нь холын зайд орших компьютерт программ ажиллуулж болно. 

Зураг 1.2.5 Зөвшөөрөл олгосон хавтсанд 
дотоод сүлжээний компьютероос хандах

1. Дотоод сүлжээний нэг компьютерт хавтсанд хандах зөвшөөрөл (мэдээлэл 
бичих зөвшөөрөлгүйгээр) олгож, бусад компьютероос хандаж үзнэ үү. 

2. Дотоод сүлжээний нэг компьютерт хавтсанд хандах зөвшөөрөл (мэдээлэл 
бичих зөвшөөрөлтэйгээр) олгож, бусад компьютероос хандаж үзнэ үү. 
Эдгээрийн ялгааг тайлбарлан ярилцана уу.

3. Хэвлэгчийг хамтран ашиглах тохируулга хийх үйлдлийн дараалал бичнэ үү. 
4. Компьютерын IP хаягийг тодорхойлох үйлдлийн дараалал:

1. [Start]→[All Programs]→[Accessories] хавтас нээ.
2. Command Prompt программыг ажиллуул. 
3. Командын мөрөнд ipconfig гэж бичээд Enter товчлуур дар. 

Уг үйлдлийн дарааллыг ашиглан компьютерынхоо IP хаягийг тодорхойлоорой. 
Бусад мэдээлэл нь юуг илэрхийлдэг болохыг ангиараа ярилцаарай. 

1.2.3. Нээлттэй эхийн программ хангамж
Анх программ хангамж нь тоног төхөөрөмжөө дагалдаж ирдэг байсан тул 

тэдгээрийн код нь нээлттэй, үзэх, өөрчлөх боломжтой байсан. 1980-аад оны 
дунд үеээс программ хангамжийг тоног төхөөрөмжөөс тусад нь худалдан 
борлуулах болсноор программын код хаалттай болжээ. Энэ нь одоогийн 
арилжааны зориулалттай программ юм. Тухайлбал, Microsoft компаний 
боловсруулж буй бүх программууд (Windows үйлдлийн систем, MS Office багц 
программ) нь үнэтэй, код нь хаалттай программ юм. 
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Программыг чөлөөтэй (үнэгүй байж болно) хэрэглэхээс гадна зохиогч нь 
программын эх кодыг хэрэгцээндээ тохируулан өөрчлөн хөгжүүлж, хэрэглэхийг 
зөвшөөрсөн программ хангамжийг чөлөөт, нээлттэй эхийн программ хангамж 
(Free and Open Source Software) гэдэг. Чөлөөт болон нээлттэй эхийн программ 
хангамжид тавих шаардлагыг олон нийтийн лиценз (GPL, General Public 
License)-ээр зохицуулна. Чөлөөт программ хангамж нь дараах шаардлагуудыг 
хангасан байна. Үүнд:
1. Программ хангамжийг хэрэглэгч чөлөөтэй хэрэглэж болно.
2. Хэрэглэгчид программын ажиллах ажиллагааг судлах, тодорхой 

зорилгоор программын ажиллагааг өөрийн хэрэгцээнд тохируулан 
өөрчлөх боломжтой.

3. Программ хангамжийг хэрэглэгч нь бусдад чөлөөтэй дамжуулж болно.
4. Хэрэглэгч нь программ хангамжийг шинэчлэн өөрчлөх, сайжруулах 

боломж чөлөөтэй байх ба энэ хувилбараа өмнөх эрхтэй ижил эрхтэйгээр 
нийтэд тарааж болно.
Чөлөөт программ хангамж (Free Software) нь нээлттэй эх кодтой байдаг. 

Нээлттэй эхийн программ хангамжийн эх код нь нийтэд ил, үзэх, судлах, 
үнэлэх дүгнэх, шинэчлэн өөрчлөх боломж бүгдэд адил тэгш байна. Чөлөөт 
программ хангамж нь түүнийг хөгжүүлэн хэрэглэх эрх чөлөөг илэрхийлэхээс 
программын үнэд хамаатай ойлголт биш юм. Өөрөөр хэлбэл, нээлттэй эхэд 
суурилан боловсруулсан боловч арилжааны зориулалттай программ цөөнгүй 
байдаг. 

Өдгөө чөлөөт болон нээлттэй эхийн Linux 
үйлдлийн систем, OpenOffice хэрэглээний багц 
программууд өргөнөөр ашиглагддаг. Манай 
улсын мэдээллийн технологийн мэргэжлийн 

хэсэг залуус нээлттэй эхийн Linux үйлдлийн системийн 
анхны Монгол хувилбарыг бий болгож, түүнийгээ 
Soyombo Linux хэмээн нэрлээд байна. Энэ нь монгол хэл 
дээрх анхны үйлдлийн систем юм. Мөн OpenOffice багц программын Windows 
үйлдлийн системд зориулсан монгол хувилбарыг боловсруулжээ.

1. Чөлөөт, нээлттэй эхийн программ хангамжийг хэрэглэх давуу болон сул тал 
юу вэ? 

2. Дараах хүснэгтэд буй чөлөөт программуудыг Windows үйлдлийн системд 
ашиглаж болно. Багаар ажиллаж, эдгээр программаас сонгон интернэтээс 
татан авч хэрэглэж үзээд, үүрэг зориулалтыг тодорхойлж, программыг 
ашиглах зөвлөмж боловсруулан ярилцаарай. 

Ангилал Чөлөөт программ 
хангамж Үүрэг зориулалт

График дизайн
GIMP
Inkscape

Мультимедиа

Mixxx
Blender3D
MPlayer
Audacity

Агуулга 
боловсруулах

GeoGebra
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1.3. ҮЙЛДЛИЙН ДАРААЛАЛ, АЛГОРИТМ

Гүйцэтгэгчид зориулсан үйлдлийн дарааллыг алгоритм гэнэ (Мэдээллийн 
технологи VIII). Аливаа алгоритм нь өгсөн мэдээлэл (оролт)-д үйлдлийн 
дарааллаар боловсруулалт хийж, үр дүн (гаралт)-г гаргаж авах үйл ажиллагаа 
юм. Жишээлбэл, өмнөх алгоритмын гадсыг тойргийн төв, аргамжааг тойргийн 
радиус r гэж төсөөлбөл, дугуйн талбай s-ийг олоход төвөггүй. Алгоритмыг 
туршихдаа оролтод тодорхой утга өгч үр дүнг тооцно. Жишээлбэл, π тоог 3.14 
гээд r-ийн өгсөн утгад дугуйн талбайг тооцоолсныг хүснэгтэд үзүүллээ. 

Радиус: r 6 м 15 м 39 м 51 м 100 м
Талбай: s 113.04 м2 706.5 м2 4775.94 м2 8167.14 м2 314 м2

Алгоритмын оролт, гаралт болон тооцоололд хэмжигдэхүүнийг ашиглана. 
Өмнөх алгоритм дахь r, s нь хэмжигдэхүүн юм. Хэмжигдэхүүн нь нэр, утга, 
төрөлтэй байна. Хүснэгтээс r-ийн утга 6 м үед s-ийн утга 113.04 м2 байна. 

Аливаа мэдээллийг компьютероор боловсруулах үйл ажиллагаа нь 
үйлдлийн дараалал буюу алгоритм байдаг. 

Зураг 1.3.1 Дугуйн талбай олох бодлогын а) Загвар б) Алгоритм бичвэрийн аргын 
дүрслэл в) Turtle Art программын дүрслэл

Алгоритм 1:
1. Аргамжааны урт r-ийг оруул.
2. Дугуйн талбайг тооцоолж, s-д оруул. s = 2

 

3. Морь өвсийг идэх талбайн хэмжээ s-ийн  
утгыг хэвлэ.

4. Төгсгө б) в)

1.3.2. Алгоритмыг блок схемээр дүрслэх. Шугаман алгоритм
Алгоритмыг гүйцэтгэгч нь түүнийг нэгэн утгатайгаар ойлгон биелүүлдэг 

байх ёстой. Үүнийг алгоритмыг биелэгдэх зайлшгүй нөхцөл гэнэ. Бодлого 
1-ийн алгоритмыг үгээр, Turtle Art программаар дүрсэлжээ.
Алгоритмыг үгээр илэрхийлэхээс гадна геометрийн дүрс ашиглан дүрсэлнэ. 

Алгоритмд хэрэглэдэг геометрийн дүрсийг (Хүснэгт 1.3.1)-д үзүүллээ.
Алгоритмыг геометрийн дүрс ашиглан дүрсэлснээр түүнийг илүү ойлгомжтой 

болгодог. 

1.3.1. Алгоритм дахь хэмжигдэхүүн
Малчин Эрдэнэ морио r метр урттай аргамжаагаар 

аргамжжээ. Морь хэдий хэмжээний талбайн өвсийг идэх 
вэ? Үйлдлийн дарааллыг үгээр илэрхийлнэ үү. 

Шийдэл: Гадас нь тойргийн төв, аргамжааны урт r 
нь тойргийн радиус болно гэвэл 2

  хэмжээний талбайн 
өвсийг морь идэж чадна. Алгоритмыг үгээр илэрхийлбэл: а)

s = 2
 

r

Яагаад судалж байна вэ? 
Алгоритмыг дүрслэх нийтлэг хэлбэр болох блок схемийн аргыг таньж 

мэдэх, алгоритмыг блок схемээр дүрслэх.
Сэдвийг судалснаар юу хийж сурах вэ? 

• Алгоритмд хэмжигдэхүүнийг ашиглах;
• Алгоритмыг блок схемээр дүрслэх;
• Алгоритмыг тодорхой өгөгдөл дээр хэрэгжүүлж, үр дүнг тооцоолох.
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Хүснэгт 1.3.1 Алгоритмыг дүрслэх блокууд

Блок схем Үүрэг, зориулалт

эхлэл

төгсгө
Алгоритмын эхлэл болон төгсгөлийг тэмдэглэх блок 
(дугуй өнцөгт тэгш өнцөгт). 

хэмжигдэхүүн
Хэмжигдэхүүнд гараас утга хүлээн авах, мөн 
хэмжигдэхүүний болон алгоритмын бусад үр дүнг 
гаргах үйлдлийг тэмдэглэх блок (параллелограмм).

үйлдэл
Хэмжигдэхүүнд утга олгох үйлдлийг тэмдэглэх блок 
(тэгш өнцөгт). Хэмжигдэхүүнд олгож буй утга нь 
илэрхийллийн утга байж болно.

0 1
нөхцөл

Салаалах үйлдлийг тэмдэглэх блок (ромбо). Өгсөн 
нөхцөл үнэн эсэхээс хамааруулан хийх үйлдлээ 
сонгох (1 нь нөхцөл биелсэн, 0 нь нөхцөл биелээгүйг 
тэмдэглэнэ) тохиолдолд хэрэглэнэ.

Алгоритм 1-ийг блок схемийн дүрслэлтэй харгалзуулан Зураг 1.3.2-т үзүүллээ.

1. Аргамжааны урт r-ийг оруул.
2. Дугуйн талбайг тооцоолж, s-д хий. s= 2

 

3. Морь өвсийг идэх талбайн хэмжээ s-ийн утгыг хэвлэ.
4. Төгсгө

эхлэл

r

s

s=
2

 

төгсгө

Зураг 1.3.2 Дугуйн талбай олох бодлогыг үгээр ба блок схемээр илэрхийлсэн 
алгоритмын харгалзаа

Үйлдлийн дарааллыг эхнээс нь дараалан биелүүлэхээр тодорхойлсон бол 
шугаман алгоритм гэдэг болохыг өмнөх ангид судалсан. Шугаман алгоритмыг 
блок схемээр дүрслэхэд ромбо дүрсийг ашиглахгүй. Өмнөх жишээний алгоритм 
нь шугаман алгоритм байна.

Алгоритмд утга олгох үйлдлийг = (тэнцүүгийн тэмдэг)-ээр тэмдэглэнэ. Утга 
олгох үйлдэл нь илэрхийллийн утгыг тэмдгийн өмнөх хэмжигдэхүүнд олгоно. 
Алгоритмд математик илэрхийллийн + (нэмэх),  (хасах), × (үржүүлэх), ÷ (хуваах) 
зэрэг арифметик үйлдлийг ашиглана (Хүснэгт 1.3.2).

Хүснэгт 1.3.2 Математик илэрхийллийн компьютерт тооцоолох дүрслэлийн жишээ

Математик илэрхийлэл Компьютерт тооцоолохоор дүрсэлсэн нь
(17  (17 × a + 3 × b) × c

30
 7 × n / 30

3
+

2
 3 ÷ (x + 2) + 2 ÷ (x + 2)

2 2
 (5 × x - 3) ÷ (x × x + 3 × x + 1) - (2 × x - 8) ÷ ( x × x + 3 × x + 1)
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1. Блок схемээр дүрсэлсэн алгоритмын гүйцэтгэгч нь хэн (юу) байх вэ?
2. Шугаман алгоритмыг блок схемээр дүрслэхэд ямар блокуудыг ашиглах 

вэ?
3. r радиустай тойргийн уртыг олох алгоритмыг блок схемээр дүрсэлнэ үү. 

Алгоритмаа Turtle Art программаар бодуулж, r-ийн өгсөн утгад тойргийн 
уртыг олж, хүснэгтийг нөхөөрэй.

Радиус: r 6 м 9 м 22 м 39 м 47 м 56 м 96 м
Урт: l ...... м ...... м ...... м ...... м ...... м ...... м ...... м

4. r-ийн өгсөн утгад морины өвс идэх талбайг Turtle Art  программаар бодуулж,  
хүснэгтийг нөхөөрэй. 

Радиус: r 16 м 29 м 42 м 69 м 99 м 101 м 156 м

Талбай: s ...... м2 ...... м2 ...... м2 ...... м2 ...... м2 ...... м2 ...... м2

5. а талтай кубийн бүтэн гадаргуугийн талбай, 
эзлэхүүнийг олох алгоритмыг блок схемээр 
дүрслээрэй. Уг алгоритмаар Turtle Art 
программд дүрслэн a-ийн өгсөн утгад s ба v-г 
тодорхойлж, хүснэгтийг нөхөөрэй. 

a s=6*a*a v=a*a*a a s=6*a*a v=a*a*a
5 150 125 16

8 33

6. Өгсөн дүрсийн талбай болон периметрийг 
олох алгоритмыг блок схемээр дүрслээрэй.

1.3.3. Салаалсан алгоритм

Бодлого 1. Өгсөн x, y тоог өсөх эрэмбээр 
хэвлээрэй. 

Бодолт: Хэрэв x-ийн утга y-ээс бага бол x, y 
дарааллаар, үгүй бол y, x дарааллаар хэвлэхэд 
хоёр тоо өсөх эрэмбэтэй болно. Алгоритмын 
блок схемийг Зураг 1.3.3-д үзүүллээ. 

Алгоритм нь ямар нэг нөхцөлөөс хамааран 
өөр өөр үйлдэл гүйцэтгэж байхаар дүрслэгдсэн 
байвал түүнийг салаалсан алгоритм гэнэ. 
Нөхцөл (ромбо дотор бичигдсэн) нь үнэн эсвэл 
худал утгатай илэрхийлэл бөгөөд нөхцөл нь 
биелж байвал үнэн (тийм), биелэхгүй бол худал 
(үгүй) утгатай байна. Нөхцөлд ашигладаг жиших 
үйлдлийг Хүснэгт 1.3.3-д үзүүлжээ.

23 км

3 км

11 км

14 км

6 км

5 км

3 км

3 км

18 км

x нь y-ээс 
бага уу?

x, y

y, x

0 1

x, y

эхлэл

төгсгө

Зураг 1.3.3 Бодлого 1-ийн 
алгоритм

Хүснэгт 1.3.3 Жиших үйлдлүүд

Тайлбар a=10, b=25 
үеийн үр дүн Тайлбар a=10, b=25 

үеийн үр дүн
< Их a<b ? Үнэн >= Бага буюу тэнцүү a>=b ? Худал
<= Их буюу тэнцүү a<=b ? Үнэн = Тэнцүү a=b ? Худал
> Бага a>b ? Худал <> Ялгаатай a<>b ? Үнэн
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Нөхцөл шалгах үйлдэлд хэд 
хэдэн нөхцөлийг зэрэг шалгаж 
болно. Энэ үед “ба“, “буюу” логик 
үйлдлүүдийг ашиглана. 

Салаалах үйлдлийн хоёр 
хэлбэрийг Зураг 1.3.4-д үзүүллээ. 
Салаалсан алгоритм нь нөхцөл 
биелэхгүй байх үед үйлдэл хийхгүй 
байж болно.

Хүснэгт 1.3.4 Бодлого 1-ийн алгоритмыг 
тодорхой жишээн дээр биелүүлсэн нь

x y Хэрэв x<y ? хэвлэх

100 98 100<98 үгүй 98, 100 гэж хэвлэ

120 131 120<131 тийм 120, 131 гэж хэвлэ

111 111 111<111 үгүй 111, 111 гэж хэвлэ

Нөхцөл 

Үйлдэл

үгүй тийм Нөхцөл 

Үйлдэл 2Үйлдэл 1

үгүй тийм

Зураг 1.3.4 Салаалах үйлдлийн блок схемийн дүрслэл а) гүйцэд бус салаалалт  
б) гүйцэд салаалалт

1. Өгсөн a тоог тэгш эсвэл сондгой эсэхийг 
тодорхойлох бодлогын блок схем өгчээ. 
Тэгвэл а) хоосон блокт зохих үйлдлийг 
бичиж алгоритмыг гүйцээгээрэй. б) 
a-ийн өгсөн утгуудад алгоритм хэрхэн 
биелэхийг харуулаарай.

a Нөхцөл Үр дүн
10

29

2. Өгсөн a, b тооны ихийг олох алгоритмын 
блок схемийн хоосон орхисон блокуудад 
зохих үйлдлийг нөхөж гүйцээгээд, уг 
алгоритмыг үгээр илэрхийлээрэй. a, 
b-ийн өгөгдсөн утгад алгоритм ямар үр 
дүнг хэвлэх вэ?

a b Хэрэв a>b Үр дүн
11 2

3 8

9 9

а

эхлэл

төгсгө

үгүй тийм

а-тэгш тоо

эхлэл

төгсгө

үгүй тийм
а>b

3. Өмнөх хоёр бодлогоор зохиосон алгоритмаа Turtle Art программд дүрслэн 
бодуулна уу. Нөхцөл биелж байх үед 1, биелэхгүй бол 0 утгыг үр дүн 
болгон хэвлээрэй. 

4. Хоёр тооны багыг олж хэвлэх алгоритмыг блок схемээр болон үгээр 
илэрхийлээрэй.

Бодлого 1-ийн алгоритмыг x, y-ийн тодорхой утгад биелүүлэн туршсаныг 
Хүснэгт 1.3.4-д үзүүллээ.
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1.3.4. Давталттай алгоритм

Алгоритмд ижил үйлдлийг хэд хэдэн удаа 
давтан гүйцэтгэж байвал түүнийг давталттай 
алгоритм гэнэ. 

Бодлого 2. Өгсөн дүрсийг зурах 
алгоритмыг дүрслээрэй. 

Бодолт: Эхлээд  тахир шугамыг 
зурна. Тахир шугамын төгсгөлд яст мэлхийг 
баруун тийш 90 градус эргүүлэн уг тахир 
шугамыг зуруулна. Энэхүү үйлдлийг 3 удаа 
(эхний тахир шугамтай нийлээд 4 удаа) 
давтан гүйцэтгэснээр дүрс зурагдана. 
Алгоритм, Turtle Art программыг Зураг  
1.3.5-д харууллаа. Яст мэлхийн анхны чиглэл 
дээшээ харсан байна.

Зураг 1.3.5 Бодлого 2-ын алгоритм. а) Turtle Art программд дүрсэлсэн нь б) блок 
схемээр дүрсэлсэн нь

Давталттай алгоритмын давталтын 
доторх бүлэг үйлдлийг давталтын бие гэнэ. 
Зураг 1.3.5-д Бодлого 2-ын давталтын биеийг 
шар хүрээгээр тэмдэглэн харуулсан бөгөөд 
зурах дүрсийн нэг хэсэг болох тахир шугам 
зурж байна.

Бодлого 3. a, b эерэг бүхэл тоонууд 
өгчээ. a<b бол [a, b] завсарт орших бүхэл 
тоонууд болон тэдгээрийн нийлбэрийг олж 
хэвлэх алгоритм дүрслээрэй.

Бодолт: a-аас эхлэн b хүртэлх (a<b) бүх 
элементийг авч хэвлэх ба мөн нийлбэрийг 
авна. Алгоритмыг Зураг 1.3.6-д үзүүлэв. 
Давталтад k хэмжигдэхүүн нь a-аас b хүртэл 
давтаж, энэ завсарт орж буй бүхэл тоонуудыг 
хэвлэн, нийлбэрийг s-д авч байна. Давталт 
дуусаад нийлбэр s-ийг хэвлэнэ. Алгоритмыг 
a=10, b=15 байхад хэрхэн биелэхийг Хүснэгт 
1.3.5-д үзүүллээ. 

i = 1

эхлэл

төгсгө

үгүй тийм

Баруун тийш 
90° эргэ

60 нэгж 
шулуун зур

Зүүн тийш 
90° эргэ

60 нэгж 
шулуун зур

Баруун тийш 
90° эргэ

100 нэгж 
шулуун зур

i = i + 1

i < = 4

a, b

s

k=a, s=0

эхлэл

төгсгө

үгүй тийм

k

s = s+k

k=k+1

k < = b

Зураг 1.3.6 Бодлого 3-ын 
алгоритм

а) б)
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Бодлого 2-т тахир шугамыг 4 удаа зурж, 
Бодлого 3-д a-аас b хүртэл нэг алхмаар 
давтаж байна. Эдгээр бодлогод эхлэх болон 
төгсөх утга тодорхой байна. 

Давталтын эхлэх болон төгсөх утга 
тодорхой үед тоолуурт давталтыг ашиглах 
нь зохимжтой.

Бодлого 4. k тооноос багагүй m тоонд 
хуваагдах хамгийн бага тоог олно уу.

Бодолт:

Блок схемийг Зураг 1.3.5-д үзүүллээ. Энэ алгоритмд давталт нь m-д хуваагдах 
тоо олдох хүртэл хийгдэнэ.

Ийм байдлаар тодорхой нөхцөл биелэх хүртэл давталтыг хийдэг байхаар 
давталтыг зохион байгуулж болно. Үүнийг нөхцөлт давталт гэдэг.

Хүснэгт 1.3.6 Бодлого 4-ийн алгоритмыг k=9, m=6 үед биелүүлсэн нь

k=9, m=6, t=9
t t нь m-д хуваагдахгүй юу? t = t + 1
9 9 нь 6-д хуваагдахгүй юу? тийм t=9+1=10
10 10 нь 6-д хуваагдахгүй юу? тийм t=10+1=11
11 11 нь 6-д хуваагдахгүй юу? тийм t=11+1=12
12 12 нь 6-д хуваагдахгүй юу? үгүй

12-ыг хэвлэ

k, m

t

t = k

эхлэл

төгсгө

үгүй тийм

t = t + 1

t нь m-д 
хуваагдахгүй 

юу?

Алгоритмыг тодорхой жишээн дээр туршин хэрэгжүүлснээр алгоритмд  
алдаа байвал түүнийг илрүүлэх, цаашилбал түүнийг ойлгоход ихээхэн чухал. 
Ингэхдээ тухайн алгоритмыг хэрэгжүүлэхэд тохиромжтой хүснэгтийг ашиглана.

Хүснэгт 1.3.5 Бодлого 4-ийн алгоритмыг a=10, b=15 үед биелүүлсэн нь

a=10, b=15, k=10, s=0 
k Хэрэв k<=15 Давталтын бие

10 10<=15 тийм 10-ыг хэвлэ s=0+10=10 k=10+1=11
11 11<=15 тийм 11-ийг хэвлэ s=10+11=21 k=11+1=12
12 12<=15 тийм 12-ыг хэвлэ s=21+12=33 k=12+1=13
13 13<=15 тийм 13-ыг хэвлэ s=33+13=46 k=13+1=14
14 14<=15 тийм 14-ийг хэвлэ s=46+14=60 k=14+1=15
15 15<=15 тийм 15-ыг хэвлэ s=60+15=75 k=15+1=16
16 16<=15 үгүй 75-ыг хэвлэ

Зураг 1.3.7 Бодлого 4-ийн 
алгоритм

1. k, m-д утга оруул.
2.  t-д k-ийн утгыг өг.
3.  Хэрэв t нь m-д хуваагдахгүй бол t-ийн утгыг 

1-ээр нэмэгдүүлж, 3 дугаар мөрд шилж. t нь 
m-д хуваагдаж байвал 4 дүгээр  мөрд шилж.

4.  t-ийн утгыг хэвлэ.
5.  Төгсгө.
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1. Эхний цифр нь a (a≠0) байх хоёр оронтой тоонуудыг хэвлэх бодлогын үгээр 
илэрхийлсэн алгоритм өгөгджээ. Уг алгоритмыг блок схемээр илэрхийлж, 
a-ийн өгсөн утгад алгоритм хэрхэн биелж буйг хүснэгтээр үзүүлээрэй. 

1. Аливаа үйлдлийг хийх дарааллыг .......................... хэлбэрээр дүрсэлж болно.
2. ................. үйлдлийн дарааллыг блок схемээр дүрслэхэд ........................ 

блокыг ашигладаггүй.
3. Салаалсан алгоритмд шалгах нөхцөлийг ........................... блокоор дүрсэлнэ.
4. Логик холбоост ............................... үйлдлүүдийг ашиглана.
5. Нэг үйлдлийг ........... удаа ........ гүйцэтгэж байвал түүнийг ........ алгоритм гэнэ.

Хоёр оронтой тоо: a×10+t
Нэгжийн  
цифр (t)

Аравтын  
цифрийн утга (a)

0 1 2 3 4 5 6 7 8 9

3 3×10+0=30 3×10+1=31
9

2. Нэг төвтэй K ширхэг квадрат зурах алгоритмыг үгээр болон блок схемээр 
илэрхийлнэ үү. Хамгийн жижиг квадрат нь 10 нэгж талтай, дараагийнх нь 
өмнөхөөсөө хааш хаашаа 5 нэгжээр урт талтай байна. 

3. 1-ээс N хүртэлх тоонуудаас: 
а. K тоонд хуваагдах тоонуудыг хэвлэх;
б. Сондгой тоонуудын нийлбэрийг олох;
в.  Q цифрээр төгссөн тоонуудын тоог хэвлэх алгоритмыг 

дүрслээрэй.
4. 1-ээс n хүртэлх тооны нийлбэрийг олох 

алгоритмын блок схемийн орхигдсон 
үйлдлүүдийг нөхөж, алгоритм хэрхэн 
биелэхийг алхам бүрээр хүснэгтээр 
үзүүлээрэй. 

n=3, j=0, s=0 
j j<=n s=s+j j=j+1

1

2

3

4 …... хэвлэ

n

эхлэл

төгсгө

үгүй тийм
i<=n

s=0

1. a-д аравтын цифрийг олго;
2. Нэгжийн цифр t-д 0 утга олго;
3. Аравтын цифр a-г 10-аар үржүүлж, нэгжийн цифр t-г нэм;
4. Гарсан үр дүнг хэвлэ;
5. t-ийн утгыг 1-ээр нэм;
6. Хэрэв t<10 бол 3 дугаар мөр рүү шилж. Үгүй бол 7 дугаар мөр рүү шилж;
7. Төгсгө.

Өөрийгөө сориорой
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Сурагчид математик, хими, физикийн хичээлүүдээр түгээмэл хэрэглэгддэг нэр, 
томьёоны лавлах хийхээр болов. Багш лавлах номын гарчгийг автоматаар 
үүсгэх, нүүр хуудас хийх, хуудсанд хөл толгойн мэдээлэл оруулах, ашигласан 
материал, нэр томьёоны зүүлт, тайлбар хийх хэрэгтэйг сануулав. Математик, 
хими, физикийн хичээлийн лавлах хийхэд тусгай тэмдэгт, томьёо, тэгшитгэл 
бичих шаардлага гарав. Эдгээрийг хэрхэн хийх вэ?

2.1.1. Баримтын гарчиг автоматаар үүсгэх

Багш лавлах номынхоо гарчгийг автоматаар үүсгээрэй гэсэн. Энэ ямар 
хэрэгтэй юм бол? 

Баримтад гарчиг үүсгэх нь мэдээллийн бүтцийг тодорхойлох, зохиомжлох, 
төлөвлөгөө гаргахад дөхөм болдог. Мөн баримтад нэмэлт өөрчлөлт оруулах 
үед гарчигт харгалзах хуудасны дугаар автоматаар өөрчлөгддөг давуу талтай.

Сэдвийг судалснаар юу хийж сурах вэ?
• Баримтад автоматаар гарчиг үүсгэх;
• Тусгай тэмдэгт томьёо оруулах, ашиглах;
• Зүүлт, тайлбар хийх;
• Нүүр хуудас хийх.

Яагаад судалж байна вэ?
Аливаа баримт бичгийг эмх цэгцтэй, тодорхой илэрхийлэх боловсруулалт, 

хэлбэржүүлэлт хийж чаддаг байх нь мэдээлэл боловсруулах чадварын үндэс 
болно. 

Гарын авлага, лавлах хийхийн тулд түүний агуулга, бүтцийг тодорхойлох, 
зохиомжлох, мэдээлэл цуглуулах, боловсруулах төлөвлөгөө гаргах 
шаардлагатай байдгийг бид мэднэ (6 дугаар анги Цахим харилцаа, интернэт 
технологи; 7 дугаар анги Баримт бичиг боловсруулах технологи сэдвийн 
хүрээнд бяцхан ном хийсэн).
Дээрх хичээлүүдийн сурах бичгийг ашиглаж өөрийн хийх лавлахын бүтцийг 
тодорхойлж, гарчиг үүсгээрэй. 

Дасгал 1. Физикийн хичээлээр гарчиг үүсгэж үзье (Физик I сурах бичиг, 2014).
1. Баримт бичиг боловсруулах программаа нээнэ.
2. Шинэ баримт нээж, хуудасны тохиргоог А4 болгоно.
3. Лавлах номын гарчгийн бүтцийг тодорхойлж, дараах байдлаар бичиж оруулна.

Бүлэг 1. Биеийн ерөнхий шинж чанар
1.1. Уртыг хэмжих
1.2. Массыг хэмжих
1.3. Хугацааг хэмжих
1.4. Эзлэхүүнийг хэмжих
1.5. Нягтыг хэмжих

2.1. БАРИМТ БИЧИГ БОЛОВСРУУЛАХ ТЕХНОЛОГИ
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Contents
Бүлэг 1. Биеийн ерөнхий шинж чанар .......................................................................1

1.1. Уртыг хэмжих ............................................................................................1

1.2. Массыг хэмжих..........................................................................................1

1.3. Хугацааг хэмжих .......................................................................................1

1.4. Эзлэхүүнийг хэмжих .................................................................................1

1.5. Нягтыг хэмжих ...........................................................................................1

Гарчиг
Бүлэг 1. Биеийн ерөнхий шинж чанар .......................................................................1

1.1. Уртыг хэмжих ............................................................................................1

1.2. Массыг хэмжих..........................................................................................1

1.3. Хугацааг хэмжих .......................................................................................1

1.4. Эзлэхүүнийг хэмжих .................................................................................1

1.5. Нягтыг хэмжих ...........................................................................................1

Бүлэг 1. Биеийн ерөнхий шинж чанар
1.1. Уртыг хэмжих
1.2. Массыг хэмжих
1.3. Хугацааг хэмжих
1.4. Эзлэхүүнийг хэмжих
1.5. Нягтыг хэмжих

4. Ерөнхий гарчгийг идэвхжүүлээд [Home]→[Style]→[Heading 1] загвараас 
сонгоно.

5. Дэд гарчгийг идэвхжүүлээд [Home]→[Style]→[Heading 2] загварыг сонгож, 
хэлбэржүүлнэ.

6. Хулганын заагчийг гарчгийн эхэнд байрлуулаад [References]→[Table of 
Context]→[ Automatic Table 1] командаар гарчгийн бэлэн загварыг сонгоно.

7. “Contents” хэсгийг сонгож, “Гарчиг” болгон өөрчилнө.

8. Файлаа Documents\lavlakh\lavlakh_[сурагчийн нэр].docx нэрээр 
хадгална.

Дасгал 2. Баримтад хөл, толгойн мэдээлэл оруулах 
1. Documents\lavlakh\lavlakh_[сурагчийн нэр].docx файлаа нээнэ.
2. [Insert]→[Header]→[Alphabet] загварыг сонгоно.
3. Баримтын толгойн текстэд _[сурагчийн нэр] оруулж өгнө. 
4. [Insert]→[Footer]→[Alphabet] команд сонгоно. Хөлийн текстэд 

“Физикийн хичээлийн лавлах” мэдээллийг оруулаад хэлбэржүүлнэ.

Бүлэг 1. Биеийн ерөнхий шинж чанар
1.1. Уртыг хэмжих
1.2. Массыг хэмжих
1.3. Хугацааг хэмжих
1.4. Эзлэхүүнийг хэмжих
1.5. Нягтыг хэмжих

9а ангийн сурагч Б.Оргил

Физикийн хичээлийн лавлах

Зураг 2.1.1 Хөл толгойн мэдээлэл оруулсан байдал
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1.

5.

1.  Дараагийн хичээлд ирэхдээ сурагч бүр IX ангийн математик, физик, химийн 
хичээлийн сурах бичгээс хэрэгтэй томьёо, тодорхойлолт, тэгшитгэл зэрэг 
мэдээллийг цуглуулж ирнэ үү.

2. Математик, физик, химийн хичээлийн томьёоны лавлах хийх бүтцээ 
тодорхойлж ирнэ үү.

2.1.2. Баримтад тусгай тэмдэгт, томьёо оруулах

Сурагчдын лавлах ном хийхээр цуглуулсан мэдээлэлд:

 гэх мэт тусгай тэмдэгт, томьёо, тэгшитгэл олон байна. 
Эдгээрийг гараас бичиж оруулах боломжтой юу?

Дасгал 1. Баримтад гараас оруулах боломжгүй тусгай тэмдэгтүүдийг 
оруулахдаа:
1. [Insert]→[Symbol]→[More Symbol] товчийг дарна. 
2. Бичвэрт оруулах тэмдэгтээ сонгоно.
3. [Insert] товчийг дарах, эсвэл сонгосон тусгай тэмдэгт дээр хулганаар 

товшино. Жишээ нь: ∑, ±, α, ≤, ≥ 
Дасгал 2. Баримтад математик, хими, физикийн томьёо оруулахын тулд бид 
математик хэрэгсэл ашиглана. Дараах томьёог бичиж оруулъя. 

1. [Insert]→[Equation]→[Insert New Equation] товчийг дарна. 
2. Үүний үр дүнд [Equation Tools]→[Design] хэрэгсэл идэвхжинэ (Зураг 2.1.2).

3.  хэсэгт математик хэрэгсэл ашиглан томьёогоо бичнэ (Зураг 
2.1.2).

Зураг 2.1.2 Математик хэрэгсэл

1. Дараах бичиглэлийг математик хэрэгсэл ашиглан бичээрэй. 

2. 3.

4. 6.
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3. Хүснэгтийг математик хэрэгсэл ашиглан гүйцээнэ үү (Хими II, Хөдөлгөөн ба 
хурдатгал, 86 дугаар тал, 2011 он). 

Суурийн үлдэгдэл Хүчлийн үлдэгдэл Давс Ангилал
Лити
Цайр
Кальци
Натри
Дигидроксо
Гидроксо висмут

4. Дасгалыг математик хэрэгсэл ашиглаж гүйцээнэ үү (Физик III, 88-89 дүгээр 
тал, 2011 он).
Галт тэрэгний хурд 20 с хугацаанд -аас  хүртэл өөрчлөгдсөн бол 
хурдатгалыг олно уу.
Анхны хурд:  Сүүлийн хурд:  

Хурдны өөрчлөлт:  

Хурдатгал:  

Галт тэрэгний хөдөлгөөнийг жигд хурдсах хөдөлгөөн гэвэл хурд нь 1 с бүрд 
-ээр нэмэгджээ.

5. Алкены хими шинжийг илэрхийлэх дараах урвалуудыг математик хэрэгсэл 
ашиглаж гүйцээж бичээрэй (Хими II, 145 дугаар тал, 2011 он). 

А хувилбар В хувилбар

а. а.

б. б.

в. в.

2. Хүснэгтийг математик хэрэгсэл ашиглан гүйцэтгэнэ үү (Математик IX, 
Арифметик ба геометрийн хэрэглээ, 127 дугаар тал, 2011 он).

Арифметик прогресс Геометр прогресс
Ерөнхий гишүүний томьёо

Чанар

Эхний n гишүүний нийлбэр
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6. Гэртээ лавлах номоо хийж дуусгаад багшдаа цахим шуудангаар илгээх, 
эсвэл зөөврийн дискт хадгалаарай.

7. Тусгай тэмдэгт ашиглаж үсэг, үг бүтээнэ үү. 

2.1.3. Баримтад зүүлт, тайлбар оруулах

Сурагчид аа, лавлах ном хийхдээ ямар материал ашигласан бэ? Хэн нэгний 
бүтээлээс шууд авч ашигласан уу? Хэрэв тийм бол шууд ингэж ашиглаж болох 
уу? Ямар нэг шинжлэх ухааны тайлбар шаардсан үг хэллэг орсон уу? Хэрэв 
тийм бол тухайн үг, хэллэгт хэрхэн тайлбар оруулах вэ?.

Зүүлтийг бичвэрт нэмэлт мэдээлэл хийхэд ашиглагддаг. Зүүлт нь автоматаар 
дугаарлагддаг. Зүүлтийг устгаж, зөөж, нэмэх боломжтой. Бичвэрт зүүлт буруу 
дугаарлагдсан тохиолдолд баримтын мөрийг засварлах хэрэгтэй. MS Word 
2010 программ нь зүүлтийн дугаарыг автоматаар засаж дугаарлах болно. 
Зүүлтийг нэмэлт тайлбар шаардлагатай шинжлэх ухааны нэр томьёонд 
ихэвчлэн ашигладаг.
Endnote нь бичвэрийн төгсгөл эсвэл бүлгийн төгсгөлд, харин Footnote нь 
бичвэрийн идэвхтэй байгаа хуудасны доод хэсэгт тус тус байрладаг. Зүүлтийг 
тоогоор, үсгээр болон өөр загвараар ч тэмдэглэж болдог. 

Дасгал 1. Бичвэрт зүүлт оруулах
1. Зүүлт оруулах бичвэрийг идэвхжүүлнэ. Жишээ 

нь, “Ньютон” гэдэг үгэнд зүүлт хийе.
2. [Reference]→[Insert Footnote] товчийг дарна. 
3. Зүүлтийн дугаар бүхий талбарт тайлбарыг 

оруулна. 

Исаак Ньютон1

1 Английн физикч, математикч, одон орон судлаач, байгалийн философич, алхимич 

Зураг 2.1.3 Зүүлтийн жишээ

Дасгал 2. Лавлах номын файлыг нээж цуглуулж, боловсруулсан материалдаа 
зүүлт, тайлбар хийгээрэй.

1. Зүүлтийг ямар номд хэрхэн ашигласан талаарх 3-5 жишээ олж ирнэ үү. 
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Зураг: 2.1.5 Shape зурсан байдал Зураг: 2.1.6 Shape объектыг 
өнгөгүй болгосон байдал

2.1.4. Баримтын нүүр хуудас хийх

Бид байгалийн ухааны хичээлүүдтэй холбоотой лавлах номоо хийж дуусгах 
гэж байна. Ном бүхэн нүүр хуудас, хавтастай байдаг. Лавлах номдоо хэрхэн 
нүүр хуудас хийх вэ? Нүүр хуудас ямар бүтэцтэй байдаг вэ?

Дасгал 1. 
1. Шинээр А4 хэмжээтэй шинэ хуудас 

[Blank document] үүсгэж, хэвтээ 
[Landscape] болгоно.

2. Лавлах ном хийхийн тулд баримтыг 
хоёр багана болгоно.

3. Баримтын эхний хуудсыг нүүр 
хуудас байхаар тооцоолоод 
хоёр дахь баганын дээд талд 
сургуулийнхаа нэрийг оруулан 
голлуулан байршуулна. 

4. Гоёмсог текстийн загваруудаас 
[WordArt] сонгож ... хичээлийн 
лавлах ном текстийг хэлбэржүүлэн 
бичиж байршуулна.

5. Сэдвээ тодорхойлон бичнэ.
6. Шалгасан болон гүйцэтгэсэн хүмүүсийн овог нэрийг байршуулна.
7. Баримтын доод хэсэгт огноо бичнэ.
8. [Insert]→[Shapes]→[Rectangle] объектыг сонгоно.
9. Баримтын хоёр дахь баганын зүүн дээд булангаас лавлах номын хүрээний 

хэмжээгээр хулганын зүүн товч дараастайгаар чирнэ.
10. Бидний зурсан дүрс Зураг 2.1.5-д үзүүлсэн байдалтай харагдана. Энд 

харагдаж байгаагаар бяцхан номын бичвэр, мэдээлэл харагдахгүй байна.
11. Бичвэр, мэдээллийг харагдуулахын тулд Shape объектыг сонгоод 

[Format]→[Shape Fill]→[No Fill] товчийг дарна. Лавлах номын нүүр 
      Зураг 2.1.6-д харуулсан байдалтай болно. 

Зураг: 2.1.4 Лавлах номын нүүр
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Бидний сайн мэдэх бичвэр мэдээлэл боловсруулдаг программ нь нүүр 
хуудасны бэлэн загваруудтай байдаг. Нүүр хуудасны бэлэн загварын зөвхөн 
бичвэрийг өөрийн бичвэрээр солиод ашиглаж болно.

Дасгал 2. Баримтад бэлэн загвар ашиглаж нүүр хуудас үүсгэх 
1. Лавлах номын файлаа нээнэ.
2. [Insert]→[Pages]→[Cover Page] команд сонгоно.
3. Нүүр хуудасны бэлэн загваруудаас сонгоно.
4. Нүүр хуудсыг лавлах номд тохирсон бүтэцтэйгээр хийнэ
5. Documents\lavlakh\lavlakh_[сурагчийн нэр].docx хадгална.

• Бичвэр өмнө нь нүүр хуудастай 
бол шинэ нүүр хуудас үүсгэхэд 
хуучин нүүр хуудас автоматаар 
өөрчлөгдөнө. 

• Өмнөх нүүр хуудас нь бичвэр 
боловсруулах MS Word 2010 
хувилбараас өмнөх хувилбараар 
үүсгэсэн тохиолдолд уг хуудсыг 
устгаад шинэ нүүр хуудас үүсгэх 
ёстой байдаг. Нүүр хуудсыг 
устгахдаа [Pages] бүлгийн 
[Insert]→[Cover Page]→[Remove 
Current Page] товчийн тусламжтай 
устгаж болно.

Өөрийгөө сориорой

1. Нүүр хуудасны бэлэн загварыг [         ]→[         ]→[         ] дарааллаар ашиглана.
2. Бичвэрт тусгай тэмдэгт оруулахдаа [          ]→[          ] алхмаар гүйцэтгэнэ. 
3. Зүүлт [            ], [            ] хоёр хэлбэртэй байдаг.
4. Хөл толгойн текст оруулахдаа [            ]→[              ] алхмаар гүйцэтгэнэ.
5. Нүүр хуудасны загвар 2-3 хувилбараар хийж ирнэ үү.
6. Бид баримтын A5, A4 формат байдгийг мэднэ. Өөр ямар формат байдаг вэ? 

1. Доорх загвар бүхий лавлах номын нүүр хуудас үүсгэнэ үү. 

2. А4 хэмжээтэй бие даалтын нүүр хуудас хийнэ үү. 

Зураг 2.1.7 Page бүлэг

Зураг: 2.1.9 Өөрчлөгдсөн нүүр хуудасЗураг: 2.1.8 Нүүр хуудасны эх загвар
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2.2. ЗУРАГ БОЛОВСРУУЛАХ ТЕХНОЛОГИ

Яагаад судалж байна вэ? 
Зургийн хэмжээг өөрчлөхөд өнгө, үзэмж нь яагаад алдагдаад байдаг вэ? 
Зургийн дүрслэлийг ялган таньж, зургийг хэмжих нэгжийн талаар ойлголттой 
болсноор зургийн программыг хэрэгцээндээ тохируулан сонгож зураг зурах, 
эх үүсвэрээс авсан зургийг засварлах, хадгалах чадвартай болно.

Сэдвийг судалснаар юу хийж сурах вэ?
• Зургийн дүрслэлийн учир холбогдлыг ойлгож, хэрэгцээндээ тохируулан 

зураг боловсруулах;
• Растер зургийг засварлах, нүдний улаан өнгийг арилгах;
• Зураг, бичвэрт эффект оруулах.

2.2.1. Зургийн дүрслэл, түүний хэлбэрүүд

Растер Растер Вектор Вектор

Зураг 2.2.1 Зургийн дүрслэлийн ялгаа

Чингүүн байгалийн ухааны хичээл дээр ургамлын бүтцийн тухай танилцуулга 
хийх болов. Тэр гэртээ ургуулж байгаа цэцгийн зургийг авлаа. Зургаа 
танилцуулгадаа нэмэхэд сайн харагдахгүй жижиг байв. Хэмжээг нь 
томруулахад арзайгаад дүрс нь муухай болчихлоо. Одоо яах вэ?

Дасгал 1. Зургийн хэмжээг өөрчилж, ажиглалт хийе.
Зургийн санд байгаа файлуудаас зураг сонгож аваад дараах үйлдлийн 
дарааллаар ажиллана уу?
1. [My Pictures]→[Sample picture] хавтаснаас Penguins.jpg нэртэй зургийг 

Paint.Net программ дээр нээнэ. 
2. Хэмжээг 5 дахин багасгаад, зургаа Penguins-Jijig.jpg нэртэйгээр хадгална. 
3. Хадгалсан файлаа дахин нээгээд 10 дахин томруулж хадгал. Файлын 

нэрийг Penguins-Tom.jpg гэж хадгална.
4. Анхны зураг, багасгасан болон томруулсан зургуудын хэмжээг Explorer 

программ дээр ажиглаарай (Зураг 2.2.2). Мөн гурван зургийг MS Word 
программ дээр нээж ажиглаад дараах хүснэгтийг нөхнө үү (Зураг 2.2.3).

Дээрх дасгалын дагуу хийгдсэн гурван зураг дээр судалгаа хийцгээе.

Зураг
Хэмжээ 1. Файлын хэмжээ хэрхэн өөрчлөгдөв?

 _______________________________________

2. MS Word программ дээр нээсэн зургаас юу 
ажиглагдаж байна?

 _______________________________________

Kб-аар Цэгээр

Penguins.jpg

Penguins-Jijig.jpg

Penguins-Tom.jpg
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Зургийг бийр, багс, дүрс, өнгө будгийн 
хэрэгсэл ашиглан зурдаг. Эсвэл гар утас, 
аппарат, камер ашиглан авсан бэлэн зургийг 
засварладаг. Мэдээллийг компьютерт 
дүрслэх хэлбэр нь хоёртын кодчилолтой 
холбоотой. Тэгвэл зургийг компьютерт 
дүрслэхдээ кодчилол хэрэглэнэ. Энэхүү 
кодоор хөрвүүлснээр зургийг растерын ба 
векторын график гэж хоёр төрөлд хуваана. 
Өөрөөр хэлбэл растерын график нь цэгэн 
дүрслэлээр, векторын график нь математик 
объектын төрлүүд болох зураасаар 
дүрслэгддэг. Тиймээс вектор график нь 
өнгө, нягтралын гажуудалгүй зурагддаг.

Зургийг ямар нэгжээр хэмждэг вэ? Зургийн нягтаршил

Зураг 2.2.3 Файлыг MS Word программ дээр оруулах

Зураг 2.2.4. Зураг боловсруулах 
программууд

Номин зурсан зургаа багш руугаа цахим шуудангаар илгээх гэтэл алдаа 
заагаад илгээж чадсангүй. Ямар алдаа гарч болох вэ? 
Зургийн хэмжээ юунаас болж ихсэх вэ? Зургийг хэмжих нэгж юу байх вэ? 
Дижитал аппарат бол тухайн зургийг цэгээр илэрхийлдэг тул түүний гол 
үзүүлэлтийн нэг нь пиксель буюу цэгэн нарийвчлал юм. 

Дасгал 2. Хэмжигдэхүүний нэгжээс хамааран тухайн объектын шинж чанарыг 
тодорхойлж болно. Дараах хэмжигдэхүүний нэгжийг гүйцээж бичнэ үү. Зурган 
мэдээлэл ямар нэгжтэй байх вэ? Эрэл хайгуул хийнэ үү.

Зураг 2.2.2 Файлуудын мэдээлэл (Explorer программ)
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Хэмжигдэхүүний 
нэгж

Хугацаа:
- - - - - -

Масс:
- - - - - -

Мэдээлэл:
бит, - - -

Зай:
- - - - - -

Зураг:
- - - - - -?

Цэгийн нягтрал, пиксель
Бид гар утас, компьютер худалдаж авахдаа үзүүлэлтийг нь шалгадаг. Энэ 

үзүүлэлт дотроос дэлгэцийн хэмжээг өөрийн хэрэгцээндээ тохируулан сонгож 
авдаг. Дэлгэцийн хэмжээ гэж юу вэ? Ямар нэгжээр хэмждэг вэ? Энэ асуултад 
хариулахад инч, пиксель гэсэн нэр томьёо гарч ирнэ.

Пиксель гэдгийг нэгж талбайд ногдож буй цэгийн тоо гэж ойлгож болно. 
Өөрөөр хэлбэл, компьютерын дэлгэц дээр тодорхой хэмжээг эзлэн дүрслэгдэх 
дөрвөлжин цэг гэж ойлгоно. Жишээ нь бидний компьютерын дэлгэцийг 
1280x1024 пикселийн харьцаагаар тохируулсан гэж үзвэл компьютер 
1280х1024=1310720 ширхэг пикселийг дүрсэлж байна гэсэн үг. Энэ нь 
ойролцоогоор 1.2 Megapixel буюу 1.2 сая цэг болох юм. Зурагт мөн цэг гэсэн 
ойлголт байна.

Растерын график нь нягтралаас бүрэн хамааралтай. Зургийн нягтралаас 
хамааран зургийн чанар сайжирна. Нэгж уртад хэдэн пиксель ногдож байгааг 
цэгийн нягтрал гэнэ. Түүнийг инч дэх пиксель ppi (pixel per inch) нэгжээр 
хэмжинэ. Дэлгэцэд харагдаж буй зургийг файл болгон хадгалахдаа зурагт 
орсон пикселийн инч дэх тоог цэгээр хэмжиж гаргадаг бөгөөд үүнийг инч дэх 
цэг буюу dpi (dots per inch) гэнэ. Зургийн хэмжээг тохируулахдаа зургийн урт, 
өргөний хэмжээ, түүний нягтралыг тооцдог (Зураг 2.2.6).

Зураг 2.2.5 Хэмжигдэхүүнийг нэгжээр илэрхийлэх нь

Зураг 2.2.6 1 inch дэх ppi ба dpi -ийн ялгаа

ppi

dpi
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Дасгал 1. Зураг дээр туссан нүдний улаан өнгийг арилгацгаая. 
• Paint.Net программыг нээнэ.
• C:\medeelliin technology хавтсанд байгаа tuulai.jpg зургийг нээнэ.
•  Ellipse Select хэрэгслийг сонгож туулайны улаан өнгөтэй нэг нүдийг 

идэвхжүүлнэ.
• [Effects]→[Photo]→[Red Eye Removel…] командыг сонгоно.
• Нээгдэх Red Eye Removel харилцах цонхны Strength талбарт тохиргоог 

хийгээд ОК товч дарна.
• Enter товчлуурыг дарахад идэвхтэй байсан муж арилж, нүдний улаан өнгө 

арилсан байна.

Зургаа нээнэ. Нүдийг сонгоно. Эффект оруулна.

Улаан өнгө арилна.Эффектийн тохиргоо хийнэ.

Зураг 2.2.7 Нүдний улаан өнгийг арилгах дараалал

2.2.2. Файлын сангаас бэлэн зурагтай ажиллах, засварлах

Чингүүн өөрийн тэжээдэг туулайн зургийг найздаа илгээх боллоо. Гэтэл 
туулайн нүд нь улаан өнгөтэй гарсан байв. Ийм зургийг яаж засах вэ?

Өнгийг хэмжих нь
Bit depth гэдэг нь нэг цэгт хэчнээн тооны өнгө байхыг тодорхойлно.
1 бит гэдэг нь 2 буюу хар цагаан өнгийг тодорхойлно. Өнгийг тодорхойлохдоо 
битийн тоог 2-ын зэрэг болгон бодож тооцоолно. Жишээ нь: 
1 бит → 21=2 өнгө  4 бит → 24=16 өнгө
2 бит → 22=4 өнгө  5 бит → 25=32 өнгө 
3 бит → 23=8 өнгө 6 бит → 26=64 өнгө гэх мэт
Өнгийн төрөл дэх тоо, хэмжээг олно уу?

Өнгийн төрөл Хэмжээ Тоо
Bitmap 1 бит ?
Grayscale ? бит 256

RGB 24 бит ?
CMYK 36 бит ?
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Зураг 2.2.8 Зургийг засварласан байдал

Дасгал 2. Бараан зургийг хэрхэн цайруулахыг авч үзье. 
• Paint.Net программыг нээнэ.
• C:\medeelliin technology хавтсанд байгаа багшийн бэлтгэсэн цэцгийн зураг 

(tsetseg.jpg) нээнэ.
• Зургийг цайруулах хоёр арга байна.
1 дүгээрт [Adjustments]→[Auto Level] командыг сонгоно (Зураг 2.2.9 а).
2 дугаарт [Adjustments]→[Brightness/Contrast…] командыг сонгоно. Нээгдэх 
Brightness Contrast харилцах цонхонд цайруулах, тодруулах тохиргоог хийнэ. 
(Зураг 2.2.9 б).

Дасгал 3. Цайвар зургийг яаж тод болгох вэ? 
• Paint.Net программыг нээнэ.
• C:\medeelliin technology хавтсанд байгаа baigali.jpg зургийг нээнэ.
• Зургийг цайруулах хоёр арга байна.
1 дүгээрт [Adjustments]→[Auto Level] командыг сонгоно (Зураг 2.2.9 а).
2 дугаарт [Adjustments]→[Levels…] командыг сонгоно. Нээгдэх Levels Adjustment 
харилцах цонхны Auto командыг сонгоход зураг тод болно (Зураг 2.2.9 б).

Зураг 2.2.9 Зураг засварлах аргууд

а) б)



38

БҮЛЭГ
II

БҮЛЭГМЭДЭЭЛЭЛ БОЛОВСРУУЛАХ ТЕХНОЛОГИЙН ХЭРЭГЛЭЭ МЭДЭЭЛЭЛ БОЛОВСРУУЛАХ ТЕХНОЛОГИЙН ХЭРЭГЛЭЭ

Реклам, зар сурталчилгаа болон гарчгийг төрөл бүрийн эффект оруулан 
хийдэг. Бид энэ удаа зураг болон бичвэрт эффект хийх аргуудтай танилцана. 
Эффект хийхдээ Effects цэсний командуудыг ашиглана.

Зургийн эффект хийхдээ тохиромжтой программуудыг сонгоно 

(Зураг 2.2.10).

Зураг 2.2.10 MS Word программыг ашиглан хийсэн зургийн эффект

2.2.3. Зургийн эффект

Дасгал 1. Бичвэрт эффект хийцгээе.
• Paint.Net программыг нээнэ.
• Хуудасны хэмжээг 500x200 px хэмжээтэй болгоё. [Image]→[Canvas Size…]
• Шинэ давхарга нэмээд, уг давхаргаа Mongol ger гэж нэрлэнэ.

Хэрэгсэл ашиглан зураг зурах болон аппаратаар авсан дижитал зургийг 
засварлаж, зургийн цомгоо баяжуулах нь бид бүхний сонирхол, хэрэгцээ 
билээ. Энэ бүх шаардлагыг хангадаг зургийн программыг ашиглах нь цаг 
хэмнэж, зорилгодоо хүрэх боломжийг олгоно. Бидний хэрэглэж буй 
Paint.Net программ энэ шаардлагыг сайн хангаж чадна. Зураг эвлүүлэх, 
цайрсан болон бараан гарсан зургийг засварлах, зураг болон бичвэрт эффект 
оруулах дасгал ажил хийцгээе.

Эффект хийхэд нэмэлт плагин программ суулгана. Плагин нь компьютерын 
нэр томьёонд plug-in, plugin гэж нэрлэгддэг бөгөөд программ хангамжийн нэгэн 
төрөл болно. Плагинийг нэмэлт (залгаас) программ гэж ойлгож болно. Өөрөөр 
хэлбэл тухайн программ хангамж дээр ажиллаж байх үед шаардлагатай 
нэмэлт программыг суулгаж хэрэглэнэ гэсэн үг. Тухайн программын нөхцөлөөс 
шалтгаалж плагинийг суулгах үйл явц төрөл бүр байдаг. Зарим 
нь "*.exe" файлын тусламжтай системд суулгадаг бол зарим нь 
шаардлагатай хавтсанд хуулна. Үүнээс хамааран бие даасан 
программ болж суух эсвэл нэмэлт хэрэгсэл болж ажиллана. 
Paint.Net программын хувьд Effects цэсэд нэмэлт хэрэгсэл 
болж сууна. Плагин файл *.dll өргөтгөлтэй байна. 
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(а)

(в)

(б)

(г)

(д)

Зураг 2.2.11 Бичвэрт эффект оруулах дараалал

• Text бичвэр бичих хэрэгслийг сонгоод, фонтын төрөл Times New Roman, 
хэмжээ 60pt, бичих хэлбэр Bold сонгоод, ажлын талбарт МОНГОЛ ГЭР гэж 
бичнэ (Зураг 2.2.11 а).

• Background, Mongol ger хоёр давхаргын хооронд шинэ давхарга нэмээд уг 
давхаргаа Textiin ungu гэж нэрлэнэ.

• Textiin ungu давхарга сонгож үсгийг тус бүрд нь идэвхжүүлэн өнгөөр ялган 
будна. Enter товчлуур дарж идэвхжилтийг авна (Зураг 2.2.11 б, в).

• Textiin ungu давхаргын дээд талд шинэ давхарга нэмнэ.
• Үүссэн давхаргыг хар өнгөөр будна.
• Mongol ger давхаргыг сонгоод [Adjustments]→[Invert Colors] командыг сонгож 

бичвэрийг цагаан өнгөтэй болгоно.
• Mongol ger давхаргыг үүсгэсэн шинэ давхаргатай нэгтгэнэ [Layers]→[Merge 

Layer Down] (Зураг 2.2.11 г).
• Нэгтгэсэн давхаргыг бүхэлд нь идэвхжүүлээд ([Edit]→[Select All] эсвэл Ctrl+A) 

хуулах ([Edit]→[Copy], Ctrl+C) команд сонгоно.
• Уг давхаргыг устгана ([Layers]→[Delete Layer]).
• Textiin ungu давхаргыг сонгоод [Effects]→[Alpha Mask…] командыг сонгоход 

нээгдэх Alpha Mask Settings харилцах цонхонд Mix Alpha, Paste from Clipboard 
сонголтыг идэвхжүүлээд, ОК товч дарна. Энэ үед бичвэрийн шрифт тус 
бүрийн өнгөөр ялгарсан зураг үүснэ (Зураг 2.2.11 д).

• Зургийг C:\medeelliin technology хавтсанд text-effect нэрээр хадгална.
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1. Зураг эвлүүлэх, улаан нүдний өнгө арилгах, бараан болон цайвар гарсан 
зургийн өнгийг засварлах үйл ажиллагаануудын аль нэгийг сонгоод яаж 
засварлах дарааллыг дэвтэртээ тэмдэглэнэ үү.

2. Tools цэсний хэрэгсэл тус бүрийн үүргээр танилцуулга хийнэ үү. 
Хэрэгслүүдийн зургийг дэвтэр дээрээ зурж, үүргийг бичиж загвар 
боловсруулна. Боловсруулсан загварын дагуу танилцуулгыг MS Word 
программ дээр хийнэ. Цаасны хэмжээ А5, хэвтээ байршилтай, дөрвөн 
захаас авах зай тус бүр см байхаар хуудсыг тохируулна. Форматын 
хувьд хуудсанд хүрээ оруулах, өнгө, форматыг өөрсдийн сонирхлоор 
боловсруулна. 

3. Багийн ажил-1 “Зурагт хуудас бүтээх”: 5 сурагч нэг баг болж ажиллана. 
Багууд доорх сэдвийн дагуу даалгаврыг гүйцэтгэж хамгаална.
• 1 дүгээр багийн сэдэв: “Шинэ жилийн мэндчилгээ”;
• 2 дугаар багийн сэдэв: “Миний хайртай ээж” эх үрсийн баярт зориулсан 

мэндчилгээ;
• 3 дугаар багийн сэдэв: Төрсөн өдрийн мэндчилгээ;
• 4 дүгээр багийн сэдэв: “Миний сайхан нутаг” зурагт хуудас;
• 5 дугаар багийн сэдэв: “Манай сургууль” зурагт хуудас.

Заавар: 
 Дээрх сэдвийн хүрээнд шаардлагатай зургуудыг бэлтгэнэ. Өөрсдөө 

зураг авах, бэлэн зураг болон интернэтээс авч ашиглаж болно. Харин 
интернэтээс зураг авбал хаягийг заавал зааж өгнө. Энэ нь зохиогчийн 
эрхтэй холбоотой асуудал тул нямбай хандаарай.

 Зургийн хуудасны хэмжээ 1000х600 pixels байна.
 Зургийн эвлүүлэг байхаас гадна мэндчилгээний бичвэр оруулна.
 Энэ даалгаврыг 14 хоногийн хугацаанд хийнэ.
4. Багийн ажил-2 “Бидний бүтээл”: багууд хийсэн ажил, боловсруулсан 

зургаа танилцуулна. 

Бидний танилцуулга Бүтээлийн танилцуулга

Сэдэв: 
 . . . . . . . . . . . . . . . . . . . . . 

Зураг зурахад ямар ажил хийсэн, ямар зургийн 
хэрэгсэл, команд ашигласан тухай бичнэ.

Багийн гишүүдийн овог нэр: Гишүүд ямар үүрэгтэй оролцсон:

1.

2.

3.

1.

2.

3.

Зураг боловсруулахад ямар бэрхшээл гарав? Түүнийг ямар арга замаар шийдсэн 
бэ?

Зураг, бичвэрт тусгай эффект оруулахын тулд нэмэлт программ (plugin) 
татаж компьютерт суулгана. Дээрх дасгалын хувьд Alpha Mask плагинийг 
суулгаж ашигласан. 
• http://forums.getpaint.net/index.php?/topic/1854-alpha-mask-import-

plugin-20, 
• http://boltbait.com/pdn/InstallingEffects.asp
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Дүрсэд эффект хийцгээе.
Хүснэгт 2.2.1 Эффект ашиглах дараалал

Зураг Хийгдэх үйлдлүүд Зураг Хийгдэх үйлдлүүд
• Шинэ давхарга үүсгэн 

дугуй дүрс зурна (Ellipse).
• Давхаргыг хувилна 

(Duplicate layer).
• Давхаргыг “Дугуй” гэж 

нэрлэнэ.

• Хувилсан давхаргыг 
цэнхэр өнгөөр будна (Paint 
Bucket).

• Давхаргыг хувилна 
(Duplicate layer).

• Давхаргыг “Цэнхэр” гэж 
нэрлэнэ.

• Хувилсан давхаргыг 
цагаан өнгөөр будна 
(Paint Bucket).

• Давхаргыг “Цагаан” гэж 
нэрлэнэ.

• “Цэнхэр” давхаргыг 
сонгоно.

• [Effect]→[Blurs]→[Zoom 
Blur…]

• 2 давхаргад доорх 
командыг хийнэ.

• [Effect]→[Distort]→[Dents]
• Scale: 25
• Refraction: 75
• Roughness: 10
• Tension: 10

• [Effect]→[Distort]→[Dents]
• Scale: 75
• Refraction: 60
• Roughness: 15
• Tension: 10

• [Effect]→[Distort]→[Dents]
• Scale: 50
• Refraction: 50
• Roughness: 50
• Tension: 10

Дасгал 2. Бичвэрийг 3D эффекттэй болгоё.
Энэхүү дасгалаар бид 3D хэлбэрийн бичвэрийг хэрхэн бүтээх талаар 

судлах болно. Хичээлд ашиглах плагинууд:

Үндсэн плагин Туслах плагин
3D Дүрс - Shape 3D: 
[Effects]→[Render]→[Shape 3D]
Тунгалаг байдал, гэрэлтүүлэг - 
Transparency:
[Adjustments]→[Transparency]
Томруулан бүрэлзүүлэх - Zoom blur: 
[Effects]→[Blurs]→[Zoom Blur...]

Олон өнгийн уусмал - Multi-Color 
Gradient: [Effects]→[Renders]→[Multi 
Color Gradients]
Гаднах хүрээний сонголт - Outline 
Selection:
[Effects]→[Selection]→[Outline Selection]

1. Ажлын хуудас бэлдэх
• Шинэ файлаа 2000х2000 px хэмжээтэйгээр нээнэ.
• 1 дүгээр давхаргыг (Background) хар өнгөөр дүүргэж будна.
• Шинэ давхарга нэмж, “Монгол гэр” гэж нэрлэнэ. 
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• Уг давхарга дээр МОНГОЛ ГЭР бичвэрийг Arial, 200pt, Bold форматаар 
бичнэ.

• Бичвэрийг зургийн төвд (Center) зэрэгцүүлнэ.
• 1 дүгээр давхаргыг нууцална.
• 2 дугаар давхаргын үсэг бүрийг Magic Wand хэрэгслээр идэвхжүүлнэ.
• [Effects]→[Renders]→[Multi Color Gradients] командаар бичвэрийг 

солонгорсон өнгөөр дүүргэнэ.
• 1 дүгээр давхаргыг ил гаргана. 
• Идэвхжилтийг зогсоовол (Ctrl+D) Зураг 2.2.12 үүснэ.

Зураг 2.2.13 Бичвэрт 3D 
эффект оруулах тохиргооЗураг 2.2.12 Бичвэр оруулсан байдал

2. 3D дүрс үүсгэх
[Effects]→[Renders]→[Shape 3D] командаар нээгдэх Shape 3D харилцах 
цонхонд өгөгдсөн дарааллаар тохиргоо хийж, ОК товч дарна (Зураг 2.2.13). 

3. Давхарга нэмэх
• 2 дугаар давхаргыг хувилж, 3 дугаар давхаргад “Цацраг” нэр өгнө.
• 3 дугаар давхаргыг сонгож, 2 дугаар давхаргын доор зөөж байрлуулна (Зураг 

2.2.14).

Зураг 2.2.14 “Цацраг” давхарга үүссэн байдал Зураг 2.2.15 Цацраг хэлбэрт сүүдэр 

3
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4.  Бичвэрт цацраг хэлбэртэй сүүдэр оруулах
"Цацраг” давхаргыг сонгоод [Effects]→[Blurs]→[Zoom Blur…] командаар 
нээгдэх Zoom Blur харилцах цонхны Zoom Amount талбарыг 90 болгож, ОК 
товч дарна (Зураг 2.2.15).

5. Бичвэрийн сүүдэрт гэрэл нэвтрэлт тохируулах
“Цацраг” давхаргыг сонгоод [Adjustment]→[Transparency] командаар нээгдэх 
харилцах цонхны Opaque талбарыг 35 болгож, ОК товч дарна (Зураг 2.2.16).

Зураг 2.2.16 Сүүдрийн гэрэл нэвтрэлт

6. Бичвэрийг идэвхжүүлэх
“Цацраг” давхаргыг сонгоод [Tools]→[Rectangle Select] хэрэгслийг сонгож 
зөвхөн бичвэрийн хэсгийг багтаан идэвхжүүлнэ (Зураг 2.2.17).

7. Давхаргыг сүүдрээс салгаж зөөх
• Энэ нь уг дасгал ажлын хамгийн чухал үе шат тул анхааралтай дагаж 

гүйцэтгээрэй.
• "Монгол гэр” давхаргыг сонгоод [Tools]→[Move Selected Pixels] хэрэгслийг 

ашиглан булангаас сунгаж, сонгогдсон хэсгийг томруулна (Зураг 2.2.18).

Зураг 2.2.18 “Монгол гэр” 
давхаргыг сүүдрээс салгаж зөөх

Зураг 2.2.19 Бичвэрийн гадна 
хүрээ сүүдэр оруулах

Зураг 2.2.17 Идэвхжүүлсэн бичвэр 



БҮЛЭГ
II

БҮЛЭГМЭДЭЭЛЭЛ БОЛОВСРУУЛАХ ТЕХНОЛОГИЙН ХЭРЭГЛЭЭ МЭДЭЭЛЭЛ БОЛОВСРУУЛАХ ТЕХНОЛОГИЙН ХЭРЭГЛЭЭ

8.  Зурагт хүрээ сүүдэр оруулах
• Зурагт хүссэн эффектээ оруулж болно. 
• “Монгол гэр” давхаргын үсэг бүрийг Magic Wand хэрэгслээр идэвхжүүлнэ.
• [Effects]→[Selection]→[Outline Selection…] командаар нээгдэх харилцах 

цонхонд гаднах хүрээ үүсгэх тохиргоо хийнэ (Зураг 2.2.18).
9. 3D зураг

Зургаа тайрч, хадгална. 3D зураг бэлэн боллоо (Зураг 2.2.19). 

Өөрийгөө сориорой

Анги: . . . . . .   Овог нэр: . . . . . . . . . . . . . . . . .

1. Бүлэг сэдвийн хүрээнд юу хийж чаддаг болсон бэ?

№ Зурган мэдээлэлтэй ажиллах чадамж
Сурагчийн тэмдэглэгээ
Чадна Чадахгүй

1. Зургийн дүрслэл, түүний хэлбэрүүдийг ойлгох
2. Өнгийн горим ба пикселийн талаар мэдэх
3. Хуудасны тохиргоо хийх
4. Давхаргатай ажиллах
5. Зураг цайруулах
6. Зургийн улаан нүдийг арилгах
7. Зургийг эвлүүлэх
8. Бичвэрт эффект оруулах
9. Зурагт эффект оруулах
10. Плагин суулгах, ашиглах

2. Асуултад хариулна уу.

1. ppi, dpi хоёрын ялгааг 
нэрлэнэ үү?
________________________
________________________

3. Командуудыг үүргээр нь холбоно уу?
a) Add New Layer
б) Delete Layer
в) Duplicate Layer

1. Зургийн файл оруулах
2. Давхарга хувилах
3. Давхарга устгах

2. Зургийн файлын 
өргөтгөлүүдийг нэрлэнэ үү?
a) *.docx    д) *.jpeg   
б) *.pdn     е) *.gif
в) *.psd     ё) *.txt 
г) *.com     ж) *.exe
Зөв хариу: _________________

г) Import From File…
д) Layer Properties…

4. Шинэ давхарга нэмэх
5. Давхаргын тохиргоо

Зөв хариу: б3,                                                           

4. Зургийг дахин засварлаж болно.
  а) Үнэн      б) Худал 

3. Зургийг хэмжих нэгж, өнгийн тоо, зургийн төрлийг гүйцээж нөхнө үү?
Хэмжээ (бит) Өнгө (тоо) Төрөл

1 бит Bitmap
256 өнгө

24 бит 16.7 сая өнгө
CMYK

4. Асуултад хариулна уу.
1. Нэмэлт (залгаас) программыг ________________ гэнэ. 
2. Плагин суугаагүй программд ямар алдаа гарах вэ?
3. Alpha Mask плагиний үүргийг нэрлэнэ үү?
4. Яагаад зураг болон бичвэрт эффект хийдэг вэ?

44
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2.3. ХҮСНЭГТЭН МЭДЭЭЛЭЛ БОЛОВСРУУЛАХ ТЕХНОЛОГИ

2.3.1. Өгсөн мэдээллийг агуулсан хүснэгт үүсгэх

Яагаад судалж байна вэ? 
Асуудлыг шийдвэрлэхдээ математик, статистикийн тооцоолол бүхий хүснэгтэн 
мэдээлэл боловсруулж, хэрэглэх.
Сэдвийг судалснаар юу хийж сурах вэ?
• Тооцоолол бүхий хүснэгтэн загвар байгуулах;
• Мэдээллийг тодорхой шинж чанараар эрэмбэлэх, хайх, шүүх;
• Тоон өгөгдлийн хамаарлыг график, диаграммаар илэрхийлэх.

Та бүхэн энэ хичээлийн жилд суурь боловсрол эзэмшиж, ахлах ангид 
дэвшин суралцана. Анхлах ангид элсэн суралцахад 6-9 дүгээр ангид хэрхэн 
суралцсан дундаж дүн, хандлага төлөвшлийг харгалздаг. Иймд цаашид хэрхэн 
суралцахаа төлөвлөх нь нэн чухал. Амжилттай суралцахын тулд сурлагын 
түвшин, ур чадварыг үнэлсэн үнэлгээндээ бодитой, тооцоотой хандаж, мэдлэг, 
чадварын ахиц амжилтаа нэмэгдүүлэхийн төлөө байнга хичээх хэрэгтэй. 
6-аас 8 дугаар ангид суралцсан дундаж дүнгийнхээ мэдээллийг өөрийнхөө 
хувийн хэргээс эсвэл esis.edu.mn сайтаас авч болно.

Тоон мэдээлэл үүсгэх хамгийн тохиромжтой хэлбэр нь цахим хүснэгт 
байдаг. Өмнөх ангид судалсан цахим хүснэгтийн тухай мэдлэгээ өргөтгөн тоон 
мэдээлэл үүсгэх аргатай танилцахдаа нүдэнд оруулах өгөгдлийн төрлүүд, 
өгөгдлийг боловсруулах арга зүйг судална.

Хүснэгт нь хүснэгтийн 
толгой, гарчиг, хажуу, 
талбараас тогтоно. Мөн 
хүснэгтэд дугаар өгч, товч 
агуулгыг илтгэх хүснэгтийн 
гарчгийг бичдэг болохыг сурах 
бичгээсээ ажиглаж болно.

Цахим хүснэгтэд дараах төрлийн өгөгдлүүдийг оруулдаг.

Цахим хүснэгт дэх өгөгдлийн төрөл

Ерөнхий Тоон Процент Мөнгөн тэмдэгт Хураангуй

Бичвэр
Тоо
Огноо
Цаг хугацаа

0; 1; 2; 3; 4; 
5; 6; 7; 8; 9 
цифрүүд, +; -; 
,; *; ^; (); /; $; %; 
E; e тэмдэгтүүд

Процент 
болгон 9.2% 
нарийвчлалтай 
гаргана.

Мөнгөн 
тэмдэгтийн нэгж 
гаргана.
999999₮

Хураангуй 
хэлбэрээр 
гаргана.
0.3=3.00Е-01
23456=2.35Е+04

Зураг 2.3.1 Хүснэгтийн толгой, талбар

Зураг 2.3.2 Өгөгдлийн төрлүүд

Талбар нь ажлын нүднүүдээс тогтоно. Нүдний хаяг, нүдэнд оруулсан 
өгөгдөл нь хаягийн талбарт байрладаг. 

Жишээ болгон “Миний гэр бүл” хүснэгтийг авч үзье. Уг хүснэгт нь дөрвөн 
мөр, дөрвөн багана, гарчиг ба дугаараас тогтож байна.
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Танай сургууль 9 дүгээр 
анги төгсөгчдөөс 10 дугаар 
ангид элсэх суралцагчдыг 
дараах хүснэгтэд үзүүлсэн 
дундаж дүнгээр эрэмбэлэн 
жагсаахаар шийдвэрлэжээ.  
Өөрийнхөө дүнгээр хүснэгтийг 
үүсгэж, шинжилгээ хийгээрэй.

Хичээл нэг бүрийн 
үнэлгээний хувийг бүхэл 
тоогоор оруулж, түвшинг тооцон 
гаргах томьёог харгалзах доод 
нүдэнд оруулж өгье.  Жишээ нь 
6 дугаар ангийн монгол хэлний 
хичээлийн хувь нь 90% байсан 
бол 90 гэсэн бүхэл тоон утгыг 
D4 нүдэнд оруулна. 

2.3.2. Нүдэнд оруулсан 
өгөгдөлд тооцоолол хийх

Ажлын талбарт өгөгдөл 
оруулсны дараа хийх 
тооцооллыг хялбаршуулах 
нь хүснэгтэн мэдээлэл 
боловсруулах программын нэг 
давуу тал юм. Дээрх хүснэгтэд 
оруулсан өгөгдөлд сурлагын 
амжилтын хувийг бүхэл тоон 
утгаар оруулсан дүнг түвшинд 
шилжүүлэх тооцоолол 
хийцгээе. 6 дугаар ангийн 
монгол хэлний хичээлийн D4 нүдэнд оруулсан тоон үнэлгээг D5 нүдэнд 
үнэлгээний түвшин болгон тооцох томьёог оруулъя. Томьёо ба функц нь 
хүснэгтэн мэдээлэл боловсруулах технологийн онцлох шинж юм. Тооцооллыг 
томьёо ашиглан хийнэ. Нүдэнд бичвэр болон тоон өгөгдөл оруулдаг. Харин 
тэнцүүгийн тэмдгээр эхэлсэн өгөгдлийг томьёо гэж ялгана. Тэнцүүгийн 
тэмдгийн дараа аргумент агуулсан математик илэрхийлэл, арифметик үйлдэл 
болон томьёог бичдэг. Томьёонд оруулсан аргумент нь тоо эсвэл нүдний хаяг 
байдаг. Арифметик үйлдэл нь + (нэмэх), - (хасах), * (үржүүлэх), / (хуваах), 
^ (зэрэгт дэвшүүлэх) үйлдлүүд байна. Цахим хүснэгт арифметик үйлдлийн 
утгыг тооцоолохдоо зүүнээс баруун тийш дэс дараалан гүйцэтгэхдээ 
эхлээд зэрэгт дэвшүүлэх, дараа нь үржүүлэх ба хуваах, төгсгөлд нь нэмэх 
ба хасах үйлдлийг гүйцэтгэнэ. Үйлдэл гүйцэтгэх дарааллыг дугуй хаалт () 
ашиглан тодорхойлж болно. Дугуй хаалт 
олон байвал дунд нь байгаа үйлдлийг эхэлж 
гүйцэтгэнэ. Томьёонд оруулж буй өгөгдлийг 
авах нүдний хаягийг өөр ажлын талбараас 
эсвэл өөр файлаас ч авч болдог. Бичиж буй 

Зураг 2.3.3 Дүнгийн хүснэгт

Зураг 2.3.4 Нүдэнд оруулсан 
томьёо ба үр дүн
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томьёо нүдэнд харагдаж байх боловч бичиж дууссаны дараа томьёогоор 
тооцоологдсон тоон утга харагдах болно. Харин тухайн утгыг гаргаж буй 
томьёо нь томьёоны мөрд харагдана. Зураг 2.3.4-д D1 нүдний томьёоны мөрд 
буй =A1^B1+C1 гэсэн томьёо харагдаж байна. Үр дүнд 57+9=78134 тоо гарсан 
байна.

Т ү г э э м э л 
х э р э г л э г д д э г 
томьёог адил хэв 
загварт оруулан нэр 
өгөөд функц гэж 
нэрлэдэг. Томьёонд 
орсон нүдний 
хаягт буй өгөгдөл 
нь бичвэр өгөгдөл 
байвал тооцоолол 
х и й г д э х г ү й , 
алдаатай болохыг 
сануулна.

Томьёо оруулах 
аргатай танилцахын 
өмнө тоон үнэлгээг 
түвшинд шилжүүлэх 
алгоритмыг авч үзье 
(зураг 2.3.5).

Тооцох алгоритм 
нь нөхцөл шалгах 
о п е р а т о р а а р 
хэрэгжинэ.

Үгчилбэл D4 
нүдний утга 90-ээс их буюу тэнцүү бол D5 нүдэнд “I” гэсэн утга олго, үгүй 
бол дараагийн алхамд шилж. Дараагийн алхамд D4 нүдний утгыг 80-аас их 
буюу тэнцүү эсэхийг шалгаад нөхцөл биелэгдвэл D5 нүдэнд “II” утгыг олгож, 
биелэгдэхгүй бол дараагийн алхамд шилжиж, дараагийн нөхцөлийг шалгана. 
Нөхцөл шалгах операторыг хүснэгтэн мэдээлэл боловсруулах программд IF 
(нөхцөл; утга1; утга 2) гэсэн функцээр хэрэгжүүлдэг. Нөхцөл биелэгдвэл утга 
1 хэрэгжинэ, биелэгдэхгүй бол утга 2 хэрэгжинэ. Алгоритмын блок схемээс 
харвал утга биелэгдэхгүй тохиолдолд дахин нөхцөл шалгах оператор байгаа 
учраас утга 2-ын оронд дахин нөхцөл шалгах операторыг авчээ. Эндээс 
харвал функцийн аргумент нь нүдний хаяг, логик болон тоон утга байхаас 
гадна функц байж болох ажээ.

D5 нүдэнд =IF(D4>=90,"VIII",IF(D4>=80,"VII",IF(D4>=70,"VI",IF(D4>=60,"V",
IF(D4>=50,"IV",IF(D4>=40,"III",IF(D4>=30,"II","I"))))))) томьёонд орсон >= 

бичиглэлийг нөхцөл шалгах логик функц гэж нэрлэдэг. Нөхцөл биелэгдвэл 
“I” утгыг авна, биелэгдэхгүй бол дараагийн алхамд шилжинэ. Математикийн 
хичээлээр судалсан тэнцэтгэл бишийн тэмдгүүдийг нэгэн адил ашиглах 
боловч тэнцүү биш нөхцөлийг шалгахдаа <> (их, багын тэмдэг) логик функцийг 
ашигладаг. Энэ үйлдлийг математикт ≠ гэж тэмдэглэдэг.

D5 нүдэнд томьёог оруулбал D4 нүдэнд оруулсан тоон хувийг түвшинд 

Зураг 2.3.5 Тоон үнэлгээг түвшинд шилжүүлэх 
алгоритм

Эхлэл

D4

Тийм

Тийм

Тийм

Тийм

Үгүй

Үгүй

Үгүй

Үгүй

D4>=90

D4>=80

D4>=70

D4>=60

Төгсөв

VIII

VII

VI

V

Тийм Үгүй
D4>=30

II I

Тийм Үгүй
D4>=50

IV Тийм Үгүй
D4>=40

III
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шилжүүлнэ. IF функц нь нөхцөл шалгах бөгөөд нөхцөл биелэгдэх эсэхийг 
шалгаж заасан үнэлгээний түвшинг гаргана. Энэ томьёогоо түвшин гэсэн 
нүднүүдэд хуулаарай.

Үнэлгээний  өгөгдлөө оруулсны дараа “I” үнэлгээтэй үнэлэгдсэн 
хичээлүүдийн тоог тоолж гаргана. Тоолохдоо функц ашиглая. Хоёр ба түүнээс 
дээш нүднүүдээс сонирхож буй мэдээллийг агуулсан нүдний тоог тоолж, 
тоон утга гаргадаг COUNTIF (Нүдний хаяг; нүдний хаяг;“хайх утга”) функцийг 
ашиглан I үнэлгээтэй нүдний тоог олж болно. Бидний жишээнд D42 нүдэнд 
=COUNTIF(D4:D41;”I”) гэж өгөгдөх функц нь D4-өөс D41 хаягаар орших 
нүднүүдээс “I” өгөгдөлтэй нүдний тоог тоолно. Үүнтэй адил аргаар бусад 
түвшиний  үнэлгээнүүдийг тоолох зорилгоор энэ томьёог хуулахад 4-өөс 41 
дүгээр нүд гэсэн хаяг өөрчлөгдөхгүй. “II” түвшингийн үнэлгээний тоог гаргах 
харгалзах нүднүүдэд D43 нүдэнд =COUNTIF(D4:D41;”II”) гэсэн өөрчлөлт 
хийхэд  хангалттай. 6 дугаар ангийн үнэлгээгээ бодуулсан бол хамтад нь 
D42–D49 нүдний томьёог Е–Н баганын харгалзах нүднүүдэд хуулаарай.

Есдүгээр ангийн дүнгийн мэдээлэл ороогүй боловч мэдээлэл агуулсан 
нүднүүдийн арифметик дунджийг бодож гаргах томьёог Н4 нүдэнд 
=AVERAGE(D4:G4) оруулъя. AVERAGE 
функц нь арифметик дунджийг гаргах 
бөгөөд энд D4-өөс G4 нүдний арифметик 
дундаж утгыг бодож байна.

Одоогоор оруулаад байгаа гурван 
ангийн дүнгийн дунджийг бодож 
гаргана. Есдүгээр ангидаа хэдэн хувьтай 
суралцвал зохих талаар мэдэхийг хүсвэл 
тухайн нүдэндээ хүссэн үнэлгээгээ 
оруулаад үзээрэй. Энэ томьёогоо уг 
баганын хувь гэсэн мөр бүрд хуулаарай.

Ингэснээр ирээдүйдээ тооцоотой 
хандаж, есдүгээр ангидаа аль хичээлд 
ямар хувьтай дүгнэгдвэл дундаж 
үнэлгээ өндөр байхыг бүрэн тооцоолж 
чаддаг боллоо.

Тоон өгөгдөлд тооцоо хийхэд гурван 
төрлийн функц ашиглах арга зүйтэй 
танилцлаа. Цахим хүснэгтийн [Formulas]→[Insert Function] цэсэнд 12 төрлийн 
400 гаруй функц бий. Функцийг ашиглах үед томьёог бичих шаардлагагүй, 
аргументыг тодорхойлж өгөхөд хангалттай. Функцийг стандарт ба хэрэглэгчийн 
гэж хоёр ангилна.

Функцийн ерөнхий бүтэц нь: 
Функцийн нэр (аргумент). Функцийн 
нэрийг том, жижиг үсгээр бичихэд 
программ танина. Аргументыг дугуй 
хаалтад бичнэ. Аргумент нь тогтмол 
утга, нүд ба нүдний хаяг, мужийн 
хаяг байж болно. Түүнчлэн логик 
тэмдгүүдийг ашигладаг. Функцийн 
аргумент нь функц байж болно. [IF(D4>=90;”I”;IF(D4>=80…] Өөрөөр хэлбэл 

Зураг 2.3.7 Функц сонгох цонх

Зураг 2.3.6 Функц сонгох дараалал

Зураг 2.3.8 Нийлбэр олох функцийн үр дүн
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давхар функцийг хэрэглэж болно. Аргумент нь утгаа тухайн ажлын эсвэл өөр 
ажлын хавтаснаас авч болдог.

Түгээмэл ашиглагддаг функц болох нийлбэр олох SUM() функцийг  
хэрэгслээр AutoSum  ашиглаж болно. Энэхүү хэрэгсэл нь тухайн мөр эсвэл 
баганад байгаа тоонуудын нийлбэрийг автоматаар олдог. Функцийн аргумент 
нь нийлбэр олох нүднүүдийн эхний ба эцсийн хаягаас тогтоно. Зөвхөн мөр 
баганын дагуу нийлбэр олоод зогсохгүй тодорхой мужид байх тоонуудын 
нийлбэрийг ч нэгэн адил олдог. Зураг 2.3.6-д мөр, багана, мужийн нийлбэр 
олсон томьёог харууллаа.

Нийлбэр олох явцад хоосон нүд байвал тасалдал үүсэж болно. 
Үүссэн тасалдалыг хөдөлгөөнт хүрээ шугамаар 
зохицуулна. Хулганын зүүн товчийг дараастайгаар 
нийлбэрийг нь олох мужаа тэмдэглэнэ.

Математикт зэрэг дэвшүүлэх, язгуур 
гаргах үйлдэл түгээмэл хэрэглэгддэг. Зэрэг 
дэвшүүлэх үйлдлийг POWER (нүдний хаяг 
1; нүдний хаяг 2) функцээр гүйцэтгэнэ. Энэ функц нүдний хаяг 1-д 
өгсөн тоог нүдний хаяг 2-т өгсөн зэрэг дэвшүүлнэ. Зураг 2.3.9-ийн А1 
нүдэнд -7, А2 нүдэнд 3 гэсэн тоон утга өгөгджээ. Зэрэг дэвшүүлэх функц  
-73 = -343 гэж бодож гаргасан дүнг дүрслэв.

Язгуур гаргах үйлдэл нь зэрэг дэвшүүлэх 
үйлдлийн урвуу үйлдэл байдаг. Цахим хүснэгтэд 
квадрат язгуураас гаргадаг SQRT(нүдний хаяг) 
функц аргументад заагдсан нүдэнд орших тооноос 
квадрат язгуур гаргана. Түүнчлэн нүдний хаягийн 
оронд тоо бичвэл нэгэн адил квадрат язгуураас гаргах үйлдлийг хийх болно. 
SQRT(1225) = 35.  

Нүдэнд оруулж байгаа томьёог тэнцүүгийн тэмдгээр (=) эхэлдэг бол 
[Formulas]→[Insert Function] (F3 товчлуур) команд нь тэнцүүгийн тэмдгийг 
өөрөө үүсгэдэг. 

Оруулсан томьёо тань алдаа заавал засварлахын тулд F2 товчлуурыг 
дарах буюу томьёоны мөр байрлах хэсэгт заагчийг 
байрлуулан хоёр товшилт хийн гүйцэтгэнэ.

Функц сонгоход үүсэх харилцах цонхны эхний 
талбар ихэвчлэн функцийн үйлчлэх мужийг тэмдэглэх 
эхлэх нүд: төгсгөлийн нүд байгааг туршиж үзээрэй.

Хуулах, шилжүүлэх үед бичвэр болон тоон өгөгдөл хэвийн хуулагдах боловч 
харьцангуй хаяг бүхий томьёотой хэсгийн өгөгдөл бусад нүдний өгөгдлөөс 

хамаарах учраас үл зохицол үүсэж болно. 
Зурагт үзүүлсэн сануулга гарвал томьёоны 
өгөгдөл тохирохгүй байгааг илэрхийлнэ. Иймд 
томьёогоо шалгаж зохих өөрчлөлтийг хийх 
хэрэгтэй. Нүдний мэдээллийг хуулахдаа тоон 
утгыг төдийгүй түүний форматыг, томьёог, 
томьёогоор бодогдож гарсан зөвхөн тоон утгыг 
хуулж болно.

Тусгай хуулалт хийхдээ Зураг 2.3.13-д 
үзүүлсэн дарааллыг баримтална.

Зураг 2.3.10 Квадрат 
язгуур гаргах үйлдлийн 

үр дүн

Зураг 2.3.9 Зэрэг 
дэвшүүлэх функцын үр дүн

Зураг 2.3.11 Үл 
зохицлын сануулга

Сонголт Үйлчлэл
All Бүгдийг хуулна
Formulas Зөвхөн томьёог
Values Зөвхөн тоон утгыг
Formats Хэвжүүлэлтийг
Comments Тайлбар, зүүлтийг
Validation Шинжүүрийг
All Expert Borders Хүрээнээс бусдыг

Зураг 2.3.12 Хуулалт хийх 
сонголтын тайлбар
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Сурах бичгүүдийг хямд үнэтэйгээс нь 
эхлэн эрэмбэлье. 

[Data]→[Sort] хэрэгслийг сонгоход 
Зураг 2.3.12-т үзүүлсэн цонх нээгдэнэ.

[Sort by] талбарт эрэмбэлэх утга буюу 
бидний жишээнд үнэ бичигдсэн баганыг 
[Colums C], [Sort on] талбарт тоон утгаар 
буюу [Values] Order талбарт бага утгаас 
эхлэн [Smallest to Largest] гэсэн сонголтыг 
хийвэл эрэмбэлэгдэнэ.

Мэдээлэл оруулсан талбар нь хэмжээ 
ихтэй, мэдээллийн тоо хэмжээ их байвал 
сонирхож байгаа тодорхой нэг утга, эсвэл бичвэрээр хайлт хийх боломжтой.  
[Home]→[Find & Select]→[Find] сонголтыг хийж, нээгдэх цонхны хайх утгын 
талбарт “Нийгмийн ухаан” гэж бичээд [Find Next] товч дарвал ажлын талбарт 
ялгавартай харагдана.

Хайлтын үр дүнд олон утга олдсон бол [Find Next] сонголтоор дараагийн 
утгуудыг харах боломжтой.

Хүснэгт 2.3.1 Сурах бичгийн үнийн 
жагсаалт (Эх сурвалж:  

http://news.zone.mn/content/read/35125.htm.)

№ Сурах бичгийн нэр Үнэ
1 Монгол хэл IX 3,150
2 Математик IX 4,050
3 Монгол бичиг III 2,720
4 Уран зохиол III 3,150
5 Физик III 3,500
6 Хими II 3,500
7 Биологи III 2,720
8 Газарзүй III 2,720
9 Дүрслэх урлаг, технологи VI 2,820

10 Зураг зүй I 2,820
11 Түүх III 3,100
12 Нийгмийн ухаан III 2,310
13 Англи хэл V 3,200
14 Орос хэл III 2,820
15 Мэдээлэл зүй III 1,930
16 Хөгжим IX 1,930
17 Эрүүл мэнд VI 1,930

2.3.3. Өгөгдлийг тодорхой шинж чанараар эрэмбэлэх,  
хайлт, шүүлт хийх

9 дүгээр ангийн сурах бичгийн зах зээл дэх үнийн жагсаалтыг Хүснэгт 
2.3.1-д харуулав. Мэдээллийг хүснэгтэн мэдээлэл боловсруулах программд 
оруулаарай.

Тоон мэдээллийг их утгаас эхлэн буурах, эсвэл бага утгаас эхлэн өсөх 
дарааллаар нь эрэмбэлэх шаардлага тохиолддог.

Хуулах нүдээ 
идэвхжүүлнэ.

Зөөх нүдэнд хулганын 
заагчийг байрлуулна.

[Edit] цэсний [Paste Special] 
командаас сонгоно. 

Зураг 2.3.13 Тусгай хуулалт хийх дараалал

Зураг 2.3.14 Эрэмбэлэх цонх

Зураг 2.3.15 Хайлт хийх цонх ба хайлтын үр дүн
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Хүснэгтэн мэдээлэлд тоон болон 
бичвэр өгөгдөл олон удаа оролцсон бол 
шүүлт хийн тооцоолол хийх боломжтой. 
[Home]→[Sort&Filter]→[Filter] сонголтыг 
хийвэл гарчиг байрлах мөрд доошоо 
харсан сум үүснэ. Энэ сумыг сонговол 
шүүлт хийгдэнэ. [Select All] сонголтын 
өмнөх тэмдэглэгээг хүчингүй болгосны 
дараа хүссэн өгөгдлөө сонгон ялган 
гаргаж болно. Шүүлтүүр тавих 
командаас гарахдаа [Filter] командыг 
идэвхгүй болгоно.

2.3.4. Хүснэгтэд тоон цуваа үүсгэн тооцоолол хийх

Математикийн хичээлийн тодорхой завсартай тоон өгөгдөл бүхий зарим 
бодлогыг цахим хүснэгтийн томьёо ашиглан хялбархан бодох боломжтой. 
Бүхэл тоон шийд бүхий бодлогуудыг цахим хүснэгтэд хэрхэн загварчлах 
аргатай танилцъя.

Бодлого 1. Хэсэг жуулчид автобусаар 1 цаг, дараа нь явганаар 6 цаг 
аялжээ. Автобусны хурд явган аялагчдын хурдаас 18 км/ц илүү байсан бөгөөд 
нийтдээ 67 км замд аялсан бол явган аялагчийн болон автобусаар аялсан 
хурдыг олоорой.

Шинэ хуудас нээж В3 нүдэнд “Явган аялсан хурд”, С3 нүдэнд “Автобусаар 
аялсан хурд”, D3 нүдэнд аялсан замын урт гэсэн хүснэгтийн толгой үүсгэе. 
Явган аялагчийн хурд тодорхой хязгаартай учир В4 
нүднээс эхлэн таваас арав хүртэлх утгыг оруулъя. 
Автобусаар аялсан хурд, явган аялагчийн хурдаас 
18 км/ц-аар илүү гэсэн бодлогын нөхцөлийг С4 
нүдэнд =В4+18 гэсэн томьёогоор тооцвол нийт 
67 км аялсан гэсэн нөхцөлөөс D4 нүдний утга 
D4 нүдэнд =6*В4+С4 байна. С4 ба D4 нүдний 
томьёог идэвхжүүлэн С9, D9 хүртэл хуулбал хурд 
бүрд харгалзах аялсан замын урт тооцоологдоно. 
Хүснэгтээс харвал явган аялагчийн хурд 7 км/ц, 
автобусаар аялсан хурд 25 км/ц үед 67 км зам 
туулж болох нь харагдана. Ингээд бодлогын 
шийдийг оллоо.

Бодлого 2. Есдүгээр ангийн гурван бүлэгт 119 сурагч 
суралцдаг байв. 9а ангийн сурагчдын тоо 9б ангийнхаас 
4-өөр илүү, 9в ангийнхаас 3-аар цөөн байсан бол анги 
тус бүрд хэдэн сурагч суралцдаг вэ?

Шинэ ажлын хуудас нээж В4 нүднээс эхлэн 9а, 9б, 
9в, Нийт гэсэн хүснэгтийн толгойн мэдээллийг оруулъя. 3 
ангийн сурагчдын тоо 119 учир нэг ангид 41-ээс илүүгүй, 
35-аас цөөнгүй сурагч суралцдаг болохыг хялбархан 
тооцоолж (119 : 3 = 39.6) болно. 

Шүүлтүүрийн үр дүн

Шүүлтүүр үүссэн тэмдэг

Зураг 2.3.16 Мэдээлэлд шүүлтүүр 
хийх

Явган 
аялсан 

хурд

Автобусаар 
аялсан 

хурд

Аялсан 
замын 

урт
5 23 53

6 24 60

7 25 67

8 26 74

9 27 81

10 28 88

Зураг 2.3.17 Бодлого 1-ийн 
шийд

9а 9б 9в Нийт
35 31 38 104

36 32 39 107

37 33 40 110

38 34 41 113

39 35 42 116

40 36 43 119

41 37 44 122

Зураг 2.3.18 
Бодлого 2-ын шийд
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2.3.5. Цахим хүснэгт ашиглан шугаман тэгшитгэл бодох
Бодлого 5. 3+11y=203+y тэгшитгэлийг бодохын тулд А3 нүдэнд “х”-ийн утга, 
В3 нүдэнд “3+11у”-ийн утга, С3 нүдэнд “203+у”-ийн утга гэсэн толгойн хэсэг 
үүсгэе.

А4 нүднээс эхлэн А27 нүд хүртэл эхний 24 натурал тоон утга, В4 нүдэнд 
=3+11*А4, С4 нүдэнд =203+А4 томьёонуудыг оруулж оруулсан томьёогоо 5-27 
дугаар мөрний харгалзах баганад хуулъя. Хоёр илэрхийллийн утга тэнцүү 
үед бидний бодож буй тэгшитгэлийн шийд гарна. Хүснэгтээс харвал 22-т мөр 
буюу х-ийн 20 гэсэн утгад 223=223 утга гарчээ.

Энэ нь тэгшитгэлийн шийд х = 20 болохыг илтгэнэ. 
Бодоход цаг хугацаа шаарддаг бүхэл ба бутархай тоон утгатай тэгшитгэлийг 

цахим хүснэгт хоромхон хугацаанд тооцоолох чадвартай.

Бодлого 6.  тэгшитгэлийн бүхэл тоон шийдийг ол.

Тэгшитгэлийг бодох хүснэгтийн толгойн хэсгийг 2 дугаар мөрд үүсгэе. 
Томьёог оруулахдаа у хувьсагчийн оронд у-ийн авч буй утга байрлах нүдний 
дугаар (A3)-ыг бичнэ. B3 нүдэнд =(B3+5)/(B3*B3-5*B3), С3 нүдэнд =(B3-5)/
(2*B3*B3-10*B3), D3 нүдэнд =B3+C3, E3 нүдэнд =(B3+25)/(2*B3*B3-50)

В5–В11 нүдэнд 35–41 хүртэлх утгыг оруулж, С5 нүдэнд бодлогыг нөхцөл 
ёсоор =В5–4, D5 нүдэнд =В5+3, Е5 нүдэнд нийт хүүхдийн тоо буюу =В5+C5+D5 
томьёог оруулж, 11 дүгээр мөр хүртэл хуулбал зурагт үзүүлсэн тоон утга бүхий 
хүснэгт үүснэ. Хүснэгтийн 10 дүгээр мөрд байх тоон утга бодлогын нөхцөлд 
тохирч байх тул анги тус бүрийн хүүхдийн тоог гаргаж чадлаа.
Бодлого 3. Фибоначчийн дараалал гэж нэрлэгддэг эхний хоёр гишүүн нь 
нэгтэй тэнцүү дараагийн гишүүд нь өмнөх хоёр гишүүнийхээ нийлбэртэй 
тэнцүү байдаг дарааллын 14 дүгээр гишүүнийг олоорой.

А3 нүдэнд “Дарааллын дугаар”, А4 нүдэнд “Дарааллын гишүүд” бичвэр, 
В3-аас О3 нүдэнд дараалсан 14 тоог хялбар аргаар оруулж, В4 ба С4 нүдэнд 
1 гэсэн утгыг оруулна. D4 
нүдэнд =B4+C4 томьёог 
оруулж, О4 нүд хүртэл 
хуулбал 377 гэсэн тоон утга 
гарна. Энэ нь Фибоначчийн 
дарааллын 14 дүгээр гишүүн 
байна. 
Бодлого 4. Сурагч Номин 500,000 төгрөгийг сарын 1.2 хувийн хүүтэй нэгэн 
банканд хадгалуулав. 

Номингийн хадгаламж 12 сарын дараа хэдэн төгрөгөөр өсөх вэ? Зураг 
2.3.18-д үзүүлсэн цахим хүснэгт үүсгэж, В4 нүдэнд =A4+A4*0,012 томьёог 
оруулна. Оруулсан томьёог С4-М4 нүдэнд хуулна. Үр дүн нь 576947.3₮ гарч 
байна.

Зураг 2.3.19 Фибоначчийн дарааллын гишүүд

Зураг 2.3.20 Хадгаламжийн хүү тооцох томьёо оруулах
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Дөрвөн нүдний томьёог 20  
дугаар мөр хүртэл хуулахад 
гарсан утгаас тэнцүү байгаа 
утга бүхий мөрийг хайвал y=15 
гэсэн утга олдоно. 

Хүснэгтийн 7 дугаар  мөрд 
y=5 утгад #DIV/0! сануулга 
нь тоог тэгд хувааж болохгүй 
гэсэн утгыг илэрхийлж байна. 
Өөрөөр хэлбэл тэгшитгэлийн 
тодорхойлогдох мужаас y=5 
гэсэн утгыг хасах ёстой.

Бүхэл тоон шийдтэй 
тэгшитгэлээс гадна бутархай 
тоон шийдтэй тэгшитгэлийг 
бодож болно. Анх өгсөн 
хувьсагчийн утгаас шийд 
хаана оршиж болохыг сүүлийн 
хоёр баганын утга ойртож байгаа тоон завсрыг таамаглаж болно. Уг завсартаа 
бутархай утгыг өгөх замаар шийдийг олж болно.

2.3.6. Тоон өгөгдлөөр график, диаграмм байгуулах

Цаг уур судлалын хүрээлэнгээс нэг хоногийн цаг агаарын мэдээг хоёр цаг 
тутамд хэмжсэн дүнг гаргажээ.

Хүснэгт 2.3.2 Нэг хоногийн агаарын хэм

Цаг 0 2 4 6 8 10 12 14 16 18 20 22 24

Агаарын хэм Сº 3 0 -1 -3 -1 0 2 5 7 5 4 4 2

Хүснэгтээс төдийлөн 
тодорхой харагдахгүй 
байгаа агаарын хэмийн 
өөрчлөлтийг цахим хүснэгт 
ашиглан график байгуулан 
ойлгомжтой, тодорхой 
болгож болно.

Математик, газар 
зүй, физик, биологийн 
хичээлээр байгуулдаг 
график, диаграммуудыг тоон өгөгдөл ашиглан байгуулах аргатай танилцъя.

Дээрх өгөгдлийг цахим хүснэгтэд А1 нүднээс эхлэн оруулж, оруулсан 
мэдээллээ бүгдийг идэвхжүүлье.

[Insert]→[Scatter]→[Scatter with Smooth Lines] сонголтыг хийвэл зурагт 
үзүүлсэн график үүснэ. Тухайн хүснэгтийн шинж чанар, агуулгаас хамаарч 
графикийн төрлийг сонгоно. Бид график байгуулах олон аргуудаас 
тохиромжтойг нь сонгож авлаа.

Зураг 2.3.21 Бодлого 6-ын шийд

1

2

3

Зураг 2.3.22 График сонгох дараалал
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Дасгал 1. График, диаграмм байгуулах технологи
1. График байгуулах өгөгдөл бүхий мужийг сонгоно.
2. Агуулгыг илэрхийлэх график, диаграммын тохиромжтой хувилбарыг 

сонгоно.
3. График, диаграммын оноосон нэр, X ба Y тэнхлэгийн нэр, олон өгөгдөлтэй 

бол өгөгдөл бүрийн тайлбарыг оруулна.
4. [Chat Tools]→[Design] сонголтоос тохиромжтой хэлбэрийг сонгоно.

Хүснэгт 2.3.3 График хэлбэржүүлэх сонголтууд

Standard Types Графикийн стандарт төрлүүд
Custom Types Хэрэглэгчдийн төрлүүд
Data Range Өгөгдлийн хязгаар
Series in Rows Мөр дэх утгаар график зурна.
Columns Багана дахь утгаар график зурна.
Series График зурах тоон утгын цуваа үүсгэнэ.
Add Цуваа нэмнэ.
Remove Цуваа хасна.
Name Цуваанд өгөх нэр
Values Цуваанд орох тоон утгууд
Category X axis labels X тэнхлэгийн утгуудыг заана.

Series in графикийн хэвтээ тэнхлэгт хүснэгтийн мөрийг дүрслэх, эсвэл 
баганыг дүрслэх сонголтыг хийнэ. 

Математикийн хичээлээр судалдаг бүх төрлийн графикийг хялбархан 
байгуулах боломжтой.

Дасгал 2.   ба  фунцкийн графикийг байгуулаарай.

Хоёр функцийн утгын хүснэгтийг [-4;4] завсарт хагас нэгжийн алхамтайгаар 
үүсгэе. 
Урвуу функцийн  тодорхойлогдох мужийг тооцох шаардлага үүснэ. Эхний 
функц 0 цэг дээр тодорхойлогдохгүй учраас бодолт хийхгүй. 

Зураг 2.3.23 График байгуулах талбар
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График нь зурагт үзүүлсэн хэлбэртэй гарна. Гэхдээ хэвтээ ба босоо 
тэнхлэгийн нэгжийн урт нь ихэвчлэн адилгүй зурагддаг. Ийм учраас нэгжийн 
харагдах уртыг адил болтол графикийн хэмжээнд тохируулга хийнэ. Ихэнх 
графикт хэвтээ шугамууд зурагддаг боловч босоо 
шугамууд дүрслэгддэггүй. Дүрслэхийн тулд [Add 
Minor Gridlines] сонголтыг хийнэ. 

Графикийг зурж буй шугамын өнгийг сонгохдоо 
хулганын заагчийг график зурсан хэсэгт байрлуулах 
үед гарах сонголтоос хийнэ.

0 1

1

-1

-2

-3

-4

-5

2

3

4

5

-1-2-3-4-5 2 3 4 5

y=2/x функцийн график

Зураг 2.3.25 График сонголт

Хэвтээ тэнхлэгийн 
0 шугамд заагчийг 
б а й р л у у л ж 
хулганын баруун 
т о в ч л у у р ы г 
товшиход гарах 
с о н г о л т о о с 
[Format Axis] 
сонголт хийж дээд 
ба доод утга, 
алхмын хэмжээг 
тогтоосон цонхны 
зургийг баруун 
доод буланд 
дүрсэллээ. График 

байгуулах үед зарим сонголтууд хулганын заагч 
тодорхой цэгт байрлах үед идэвхжихийг сурагчдад 
сайтар сануулж өгөх хэрэгтэй болдог.

Зураг 2.3.24 Бодолт

Хүснэгт 2.3.4 График хэлбэржүүлэх сонголтын тайлбар

Titles Графикийн гарчиг тавих 
хэсэг Legend Тайлбарт тохируулга хийнэ 

Chart Title Графикт гарчиг өгнө. Show Legend Тайлбар гаргана.
Category X axis X тэнхлэгт гарчиг өгнө. Placement Байрлалыг заана. 

Value Y axis Y тэнхлэгт гарчиг өгнө. Data labels Графикт өгөгдлийн утгыг 
гаргана. 

Axes Тэнхлэгийн утгыг гаргана. Show value Утгыг харуулна. 

Gridlines Тэнхлэгийн дагуух шугам Data Table Доод хэсэгт тоон утга бүхий 
хүснэгт гаргах эсэхийг заана. 

Major gridlines Үндсэн шугам Show data table Хүснэгтийг гаргана. 

Minor gridlines Туслах шугам Show legend keys Хүснэгт дээр өнгийн тайлбар 
гаргана.

Зураг 2.3.26 Үүссэн график 
ба хэлбэржүүлсэн график

y=2/9*x^3 функцийн график
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Дасгал 3. Нэг хувьсагчтай шугаман тэгшитгэлийн системийн шийдийг олох 
бодлого бодъё.

 системийн шийдийг цахим хүснэгт ашиглан олцгооё.

y-ийг х-ээр илэрхийлж   хэлбэрээр тооцоолол хийнэ.

Өгөгдлийг цахим хүснэгтэд оруулж А4–С8 мужийг идэвхжүүлэн график 
байгуулах технологийг хэрэгжүүлбэл зурагт үзүүлсэн хоёр функцийн график 
зурагдана. Эндээс системийн шийд (3;2) болох нь харагдана.

Байгуулсан график, диаграммын 
тоон өгөгдөлд өөрчлөлт оруулахад 
график шууд өөрчлөлтийг хүлээж 
авдаг. Энэ боломжийг ашиглан бүхэл 
тоон шийдтэй систем тэгшитгэл 
зохиож, туршаарай. Дэвсгэр өнгө 
болон диаграммын өнгийг [Chart 
Tools]→[Design] сонголтоос хийж 
болох боловч тухайн шугам, баганыг 
идэвхжүүлэн сонгох боломжтой. 

8 дугаар ангийн газар зүйн 
хичээлээр судалсан Монгол орны 
нууруудын тухай тоон мэдээллийг цахим 
хүснэгтэд оруулсан зургийг дүрсэлжээ. 
Хүснэгтээс А2–В8 мужийг идэвхжүүлэн 
[Insert]→[Column]→[Clustered Column] 
сонголтыг хийж, зурагт үзүүлсэн 
диаграммыг байгуулна.

Диаграммд тоон утгыг гаргахдаа 
баганыг идэвхжүүлэн хулганын баруун 
товчлуурыг товшиход гарах сонголтоос 
[Add Data Labels…] сонголтыг 
хийгээрэй.

Утгын хүснэгтэд нуурын нэр ба 
талбайн хэмжээ зэргэлдээ биш хоёр 
баганад оршиж байгаа үед график 
байгуулахын тулд яаж идэвхжүүлэх 
вэ?

Нуурын нэрийг идэвхжүүлж, Ctrl 
товчлуурыг дарж, С3–С8 сонголтыг 
хийнэ. Одоо хэвтээ баганан диаграмм 
сонгож байгуулъя.

Зураг 2.3.27 Тэгшитгэлийн 
системийн бодолт ба үр дүн
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Эдгээрээс Хяргас, 
Увс нуур давстай 
болохыг газар зүйн 
хичээлээс мэддэг 
болсон учир багана нэг 
бүрийн өнгийг өөрчлөн 
будаж болно. Үүний 
тулд өнгийг нь өөрчлөх 
баганаа сонгоод 
[Format Data Point] 
командаар баганын 
өнгийг өөрчилнө.

Манай анги 35 
сурагчтай. “Авьяас” 
хөтөлбөрийн хүрээнд 
шатрын дугуйланд 6, бүжгийн дугуйланд 2, сэтгэн бодох чадварын дугуйланд 
5, сагсан бөмбөгийн секцэд 3, волейболын секцэд 2, найрал дууны дугуйланд 
2, хөнгөн атлетикийн секцэд 3, хөл бөмбөгийн секцэд 4 сурагч суралцдаг бол 
манай ангийн сурагчдын хэдэн хувь нь дугуйланд хамрагдаагүй вэ? 

Дугуйлан, секцийн нэр, тоон утгыг оруулсны дараа С12 нүдэнд  
C12 нүдэнд =35–SUM(C4:C11) томьёог оруулбал 8 гэсэн утга гарч байна. 
Дугуйлан бүрд суралцдаг хүүхдийн тоог хувьд шилжүүлэхийн тулд D4 нүдэнд 
=6/35 томьёог оруулж, гарсан тоон утгыг [%] хэрэгслийг ашиглан хувиар 
илэрхийлнэ. Гарсан томьёог D5-D12 нүдэнд хуулна.

Энэ тоог хувиар илэрхийлэн диаграмм байгуулж харуулбал дээр бичигдсэн 
46 үгтэй урт өгүүлбэрийг хэн ч хараад ойлгох зураг хэлбэрт үзүүлж болно. 
Нэгэн бүхлийн бүтцийг харуулахад дугуй диаграмм тохиромжтой. Тоон утгыг 
цахим хүснэгтэд оруулж дугуй диаграмм байгуулъя. 

Өнгөөр ялгасан тайлбарыг диаграмм дээрээ бичиж болдог.
График, диаграммуудын олон төрөл, хэлбэрээс төлөөлөл болгон авч 

үзлээ. График диаграммын төрөл, хэлбэрийн сонголт нь үзүүлэхээр зэхэж 
буй өгөгдлийн агуулгаас хамаарахаас гадна тоон утгуудын дундаж утгын 
хазайлтаас нэгэн адил хамаарна. Зөрүү ихтэй хоёр тоон утгыг баганан 
диаграммаар дүрсэлбэл бага утгыг төлөөлөх багана зурагдахгүй байхад хүрнэ. 
Диаграммыг дүрслэгдэх хэлбэрээрээ хоёр хэмжээст ба гурван хэмжээст гэж 
ангилдаг. Бид нууруудын талбайн хэмжээг гурван хэмжээст диаграммаар 
дүрсэлсэн болохыг эргэн санаарай.

Зураг 2.3.28 Диаграмм байгуулах дараалал ба үр дүн

Зураг 2.3.29 Хэвтээ баганан диаграмм
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Хүснэгт 2.3.5 График, диаграммын төрөл, хэлбэр

Төрөл Харагдах хэлбэр

Шугаман

 Босоо баганан диаграмм Хэвтээ баганан диаграмм

Дугуй

Хоёр хэмжээст дугуй диаграмм Гурван хэмжээст дугуй диаграмм

График

Зураасан график Эзлэхүүнт график

2.3.7. Хэмжигдэхүүний хамаарлыг цахим хүснэгтэд загварчлах

Компьютерт үүсгэж буй математик загвар нь ихэнхдээ хэмжигдэхүүний 
хамаарлыг илэрхийлсэн байдаг. Аливаа объектын судалгааны нэг чиглэл нь 
түүний шинж чанарыг тоогоор илэрхийлэхийг зорьдог. Ингэж илэрхийлсэн 
тоон утгыг хэмжигдэхүүн гэнэ.

Хэмжигдэхүүний нэр нь түүнийг шууд нэрлэсэн, эсвэл 
төлөөлсөн тэмдэглэгээ байдаг. Жишээ нь хөдөлж буй биеийн 
нэгж хугацаанд туулсан замыг хурд гэж нэрлээд V үсгээр 
тэмдэглэдгийг мэднэ. Физик болон бусад шинжлэх ухаанд 
математикийг хэрэглэхдээ төлөөлсөн тэмдэглэгээг түгээмэл 
хэрэглэдэг. Хугацааг t, хүчийг F, даралтыг P гэж тэмдэглэдгийг 
физикийн хичээлээс мэдэх билээ. Хэмжигдэхүүний тоо хэмжээ 

нь өөрчлөгдөхгүй бол тогтмол хэмжигдэхүүн, өөрчлөгдөж байвал хувьсах 
хэмжигдэхүүн гэж нэрлэдэг. Пи тоо π=3.14259 нь тогтмол хэмжигдэхүүн бол 
цаг хугацаа ихэвчлэн хувьсах хэмжигдэхүүн байдаг. Хэмжигдэхүүний гурав 
дахь шинж чанар нь түүний төрөл юм. Төрөл нь хэмжигдэхүүний авч болох 
утгын мужийн илэрхийлэл бөгөөд тоон, дүрсэн, логик төрөлтэй байж болно.

Зураг 2.3.30 Дугуй диаграммын өгөгдөл ба үр дүн

Х
эм

ж
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Утга
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Дасгал 1. 8 см ба 18 см талтай тэгш 
өнцөгтийн талбайтай тэнцүү талбайтай 
квадратын талыг олоорой.

Тэгш өнцөгтийн талбай талуудын 
үржвэрээр, квадратын талбай талын квадратаар тодорхойлогддог болохыг 
өмнөх ангиудад математикийн хичээлээр 
судалснаа санаж байгаа биз дээ.

Цахим хүснэгтийн гуравдугаар мөрд 
хүснэгтийн толгойг, дөрөвдүгээр мөрд тоон 
утгыг оруулъя. D4 нүдэнд =B4*C4, E4 нүдэнд 
=SQRT(D4) томьёог оруулахад бодлогын шийд 
гарна. В5 ба С5 нүдэнд тоон утга оруулж, D4 ба 
Е4 нүдний томьёог хуулж өөр өгөгдөлтэй ийм 
бодлого зохиож болно.

Дасгал 2. Ангийн шал 7.6 м урттай, 5.4 м 
өргөнтэй тэгш өнцөгт хэлбэртэй. Ангийн шалыг 
120 см урттай, 19 см өргөнтэй бэлдцээр бүрэхэд 
хамгийн цөөндөө хэдэн ширхэг бэлдэц орох вэ?

Ангийн шалны талбайг нэг ширхэг бэлдцийн 
талбайд хуваавал хамгийн цөөндөө хэдэн 
ширхэг бэлдэц орохыг тооцоолж болно. Шал 
ба бэлдцийн талбайг олох томьёо нь өмнөх 
бодлоготой адил. Хамгийн цөөндөө хэдэн ширхэг бэлдэц орохыг тооцоолохын 
тулд шалны талбайг нэг бэлдцийн талбайд хуваана (Е5 нүдэнд =D4/D5).

Бодит амьдрал дээр бэлдцээр шалны уртын дагуу 6 бүтнээр бүрэхэд 
40 см үлдэнэ. Дараагийн эгнээ нь хагас бэлдцээр эхэлнэ гэж тооцоод бодит 
тооцоог гаргаарай.

Дасгал 3. Гурвалжны талууд 22 см, 12 см, 14 см бол талбайг олоорой.
Гурвалжны гурван талын урт мэдэгдэж байхад талбайг нь Героны 

томьёогоор олж болдог.

Энэ томьёог цахим хүснэгтэд өмнөх хичээлээр судалсан квадрат 
язгуур гаргах функцийг ашиглан тооцоолж болно. А2–А6 нүдэнд математик 
тэмдэглэлийг В2–В4 нүдэнд тоон утгыг оруулъя. а, в, с гурвалжны талын 
урт, р-ээр хагас периметрийг тэмдэглэдэг. В5 нүдэнд хагас периметрийг 
бодож гаргая. В5 нүдэнд хагас периметр болох p=(a+b+c)/2 томьёог B5 
нүдэнд =(B2+B3+B4)/2, Героны томьёог B6 нүдэнд =SQRT(B5*(B5-B2)*(B5-
B3)*(B5-B4)) оруулснаар талбайн утгыг тооцоолон олно. Гурвалжны талын 
утгыг өөрчлөх замаар энэ төрлийн бүх бодлогыг бодох боломжтой. Ингэснээр 
бодлого бодох хүснэгтэн загвар үүсэж байна.

=

Цахим хүснэгт нь загварчлах өргөн боломжийг олгодог учраас түгээмэл 
хэрэглэгддэг. Геометрийн зарим дүрсийн талбайг тооцоолох, бодлого бодох, 
бодлого зохиох, физикийн бодлого бодоход цахим хүснэгтэн загвар үүсгэх 
технологийг судалъя.

Зураг 2.3.31 Дадлага 1-ийн 
үр дүн

Зураг 2.3.32 Дадлага 2-ын 
үр дүн
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Өөрийгөө сориорой

1. Нэг ангийн 12 сурагчийн математикийн хичээлийн ижил даалгаврыг 
гүйцэтгэсэн хугацааг минутаар тооцон гаргажээ.

 23, 18, 25, 20, 25, 25, 32, 37, 34, 26, 34, 25
 Тэгвэл даалгаврыг гүйцэтгэхэд зарцуулсан дундаж хугацаа, хамгийн бага, 

хамгийн их хугацааг олоорой.
2. Ангийнхаа дотны таван найзын 10 хичээлийн дүнгээр хүснэгт үүсгэж, үсгэн 

үнэлгээг тооцон гаргаарай. 
3. Таван охин, таван хөвгүүний гурван хичээлийн дүн бүхий цахим хүснэгт 

үүсгээд хөвгүүд, охидын дундаж дүнг тооцон гаргаж, дүгнэлт хийгээрэй.
4. Та нар өдөрт 2400 орчим 

Ккал энерги зарцуулдаг. 
Өдөрт зарцуулах 
энергийнхээ 60 хувийг 
өдрийн хоолоор нөхөж 
авна гэж тооцоод дараах 
мэдээллээр цахим хүснэгт 
үүсгэн хоолны цэс зохиогоорой.

5. Зарим аймгийн төв, хотуудын уур амьсгалын үзүүлэлтээр диаграмм 
зохиогоорой.

Хүнс Энерги 
ккал/кг Хүнс Энерги 

ккал/кг
Сүү 5867 Тахианы өндөг 5735

Цагаан будаа 3831 Буурцаг 3907

Төмс 1037 Манжин 1037

Цахим хүснэгтийн толгой хэсэгт гурвалжны талуудын урт, хагас периметр, 
талбайн тэмдэглэлийг оруулж, хагас периметр ба талбайг тооцоолох томьёог 
оруулъя. Хагас периметр нь гурвалжны гурван талын нийлбэрийн хагасыг 
олохдоо a, b, c-ийн утгад харгалзах нүдний хаягийг, талбайг олохдоо Героны 
томьёог хагас периметр ба гурван талын уртад харгалзах нүдний хаягаар 
илэрхийлсэн томьёог оруулна. Томьёог оруулмагц утга нь шууд харагдах 
болно. Талуудын утгыг өөрчилж, гурван талын урт нь өгөгдсөн төрөл бүрийн 
гурвалжны талбайг тооцоолон гаргах загвартай 
боллоо.

Зураг 2.3.33 Гурвалжны талбай олох томьёо ба үр дүн

Аймгийн төв
Жилийн дундаж хэмжээ

Хур 
тундас

Агаарын хэмийн 
өөрчлөлт

Архангай 337.8 0.3

Баянхонгор 206.7 -0.1

Алтай 171.2 -1.4

Сайншанд 115.9 3.7

Арвайхээр 247.2 0.9

Баруун-Урт 203.7 0.8

Мөрөн 232.5 -1.1

6. Наймдугаар ангийн биологийн 
хичээлээр судалсан 100 г хүнсний 
бүтээгдэхүүнд байх уураг, өөх тос, 
нүүрс усны найрлагын хэмжээгээр 
хэвтээ баганан диаграмм 
зохиогоорой.

7. Химийн хичээлээр металлын хайлах 
температурыг судалснаа эргэн 
санаарай.

Хөнгөн цагаан 659 хэм, зэс 1083 
хэм, алт 1063 хэм, хар тугалга 163 
хэм, никель 1452 хэм, мөнгө 951 
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10. Баруун гар талын зурагт өгсөн 
тоон өгөгдлийг программд 
оруулж, томьёо ашиглан будсан 
нүднүүдийн утгыг олоорой. 

11. Баруун гар талын зурагт өгсөн нэг 
оронтой тоонуудын нийлбэрийн 
хүснэгтийг цахим хүснэгтэд 
хамгийн цөөн тоо ба томьёо 
оруулж үүсгээрэй.

12. Цахим хүснэгтийн муж нь:
а. Ямар ч хэлбэртэй байж болох 

нүднүүдийн олонлог
б. Цахим хүснэгтийн өгөгдөл 

бүхий нүднүүдийн олонлог
в. Цахим хүснэгтийн хоосон 

нүднүүдийн олонлог
г. Тэгш өнцөгт хэлбэртэй 

сонгосон нүднүүд
д. Квадрат хэлбэртэй сонгосон 

нүднүүд

13. Хүснэгт дэх А5:D8 мужид хамаарах 
нүдний тоо нь:
а. 2   б. 20  в. 8   г. 16  д. 13

хэм, цайр 419 хэмд хайлдаг. Энэ 
өгүүлбэрийг диаграмм болгоорой. 

8. Монгол улсын дотоодын нийт 
бүтээгдэхүүн болон эдийн засгийн 
бодит өсөлтийг харуулсан графикаас 
хүснэгтэн мэдээлэл үүсгээрэй.

9. Дараах графикт дүрслэгдсэн муруйг 
ажиглаад тоон мэдээллийн агуулгыг 
өөрийн бодомжоор зохиогоорой.

Монгол Улсын эдийн засгийн өсөлт
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14. Цахим хүснэгтийн нэг нүдэнд  =2/3^2–(13–6)/2/4 арифметик илэрхийлэл 
өгөгджээ. Энэ илэрхийллийн математик бичиглэлийг сонгоно уу?

а.   б.  в. 

г.   д. 

15. Цахим хүснэгтэд оруулсан тоон өгөгдөл ба томьёог 
зурагт дүрсэлжээ. В3 нүдэнд гарах үр дүнг сонгоорой. 
а. 2.4  б. 2.2  в. 4.2  
г. 4   д. 4.4

16. В1 нүдэнд =IF(A1>3;7;IF(A1>0;6; -2)) томьёог оруулжээ. Хэрэв А1 нүдний утга 
2 байвал В1 нүдний утга хэд гарах вэ?
а. 7   б. 6  в. – 2  г. 2  д. 3

17. Цахим хүснэгтийн A2 нүдэнд =IF(A1>1;"K";IF(A1<-1;"M";"G")) томьёо оруулжээ. 
А2 нүдний утга G гарахын тулд А1 нүдэнд олгох утгыг сонгоорой. 
а. 1.1  б. - 2  в. 0.9  г. 1  д. -1

18. Цахим хүснэгтэд зурагт дүрсэлсэн тоон утга ба томьёог 
оруулжээ. $ нь тогтвортой хаягийг дүрсэлдэг бол В2 
нүдний томьёог В3 ба В4 нүдэнд хуулахад гарах утгыг 
олоорой.
а. 12 ба 13  б. 11 ба 12 в. 10 ба 11 
г. 22 ба 23  д. 33 ба 36

19. В1 нүдэнд =IF(A1>3;7;IF(A1>0;6; -2)) томьёог оруулжээ. Хэрэв А1 нүдний утга 
2 байвал В1 нүдний утга хэд гарах вэ?

 а. 7  б. 6   в. – 2  г. 2  д. 3

20. В1 нүдэнд =0,693Е+1*3*А1 томьёо оруулсан байв. Хэрэв А1 нүдний утга 3 
байвал В1 нүдний утга нь:

 а. 1.1  б. - 2  в. 0.9  г. 1  д. -1

21. Цахим хүснэгтэд оруулсан тоон өгөгдлөөр график 
байгуулжээ. Дараах графикуудаас аль нь B2:D3 мужийн 
өгөгдлөөр байгуулагдсан бэ?
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Номин ямар алдаа гаргав? Багш 
ямар шаардлага тавих ёстой 
байв?
• Номин бусдын бүтээлийг 

зөвшөөрөлгүй хувилж, 
ашигласан. 

• Багш сурагчийн үйлдлийг 
буруутгаагүй.

Чингүүн ямар алдаа гаргав? 
• Оюуны өмч, зохиогчийн эрхийн 

ойлголтгүйн улмаас бусдын 
бүтээлийг зөвшөөрөлгүйгээр 
нийтэд тараасан. 

• Киног найзууддаа өгөхөөсөө 
өмнө эгчээсээ асуух ёстой 
байсан. 

2.4. ЦАХИМ ХАРИЛЦАА, ИНТЕРНЭТ ТЕХНОЛОГИ

Яагаад судалж байна вэ?
Интернэт, үүрэн холбооны хэрэглээ, эдгээр технологиудад суурилсан 

үйлчилгээ улам бүр өсөн нэмэгдэж байгаа өнөө үед хүн бүр интернэт, цахим 
үйлчилгээг зөв, соёлтой ашиглаж чаддаг байх шаардлагатай. 

Сэдвийг судалснаар юу хийж сурах вэ?
Хэрэгцээ шаардлагадаа нийцсэн мэдээллийг оновчтой хайж чаддаг, 

зохиогчийн эрхийн зөрчилгүй мэдээллийг интернэтээс авч ашигладаг, үүрэн 
холбооны технологи, цахим үйлчилгээг ашиглаж сурах болно. 

2.4.1. Интернэт ба зохиогчийн эрх
1.  Номин бодлогын хураамжийн номгүй тул найзынхаа номыг хувилж авав. 

Номын дотор нүүрэнд “Зохиогчийн зөвшөөрөлгүйгээр хэсэгчлэн болон 
бүтнээр хувилах, хуулбарлах, олшруулахыг хориглоно” гэсэн анхааруулга 
байсныг Номин ч, хувилах үйлчилгээ үзүүлэгч ч тоосонгүй. Багш хувилсан 
номыг хараад юм хэлсэнгүй. Номыг ингэж хувилан ашиглаж болох уу?

2.  Чингүүний эгч шинээр гарсан монгол киног худалдан авч компьютертоо 
суулгаад гэр бүлээрээ үзэцгээв. Чингүүн эгчээсээ асуулгүйгээр уг киног 
CD дээр хувилан найзууддаа өгөв. Бүгд л шинэ киног ямар ч үнэ төлбөргүй 
олзуурхан үзэцгээв. Найзууд нь баярлаж байсан тул Чингүүн ихэд урамшин 
киног улам олон хүнд үзүүлэхийн тулд интернэтэд байрлуулж, хаягийг нь 
интернэтээр тараав. Чингүүний энэ үйлдэл зөв үү? Энэ үйлдлээс болж 
киног бүтээсэн продакшн ямар нэгэн хохирол амсах уу? 

Дасгал 1. Дээрх жишээнүүдэд зохиогчийн эрх зөрчигдсөн асуудлыг авч үзье.
Мэдээллийг зөвшөөрөлгүй нийтлэх, зохиогчийн (кино продакшн) 
зөвшөөрөлгүйгээр бүтээлийг ашигласан байна. 
Мэдээллийг зөвшөөрөлгүй хуулбарлан нийтэд түгээх. Зохиогчийн 
зөвшөөрөлгүйгээр бүтээлийг хуулбарлан нийтэд хүртээсэн, улмаар уг 
үйлдлийнхээ үр дүнд шууд ба шууд бусаар ашиг олсон үйлдэл тул Зохиогчийн 
эрх болон түүнд хамаарах эрхийн тухай хуульд заасан зөрчил болно. 

Бид төрөл бүрийн мэдээллийг интернэтэд байршуулан хүргэж, бусадтай 
хуваалцдаг. Мэдээлэлтэй ажиллах соёл нь бид хүрээлэн буй орчноосоо өөрт 
хэрэгцээтэй мэдээллийг хүртэх, хүлээн авах, түүнийг зөв ашиглахаас эхэлдэг. 
Иймээс бид зохиогчийн эрх, оюуны өмчийн талаар ойлголттой байж, бусдын 
бүтээлийг зөвшөөрөлгүй ашиглахаас зайлсхийх хэрэгтэй. Хүмүүс интернэт 
дэх дурын мэдээлэл, программыг зөвшөөрөлтэй эсэхийг нь шалгалгүйгээр авч 
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Зохиогчийн эрх болон түүнд хамаарах эрхийн хуулиар  
хамгаалагддаг бүтээлүүд

• Шинжлэх ухаан, утга зохиолын бичмэл буюу аман бүх төрлийн бүтээл, компьютерын 
программ, хөгжмийн урлагийн үгтэй болон үггүй бүх төрлийн бүтээл; 

• Дүрслэх урлагийн бүх төрлийн бүтээл; 
• Чимэглэх болон хавсарга урлаг, тайз чимэглэлийн бүтээл;
• Архитектурын бүтээл, уран баримал, уран барилга; 
• Бүжгийн урлагийн бүх төрлийн бүтээл, уран нугаралт, пантомим; 
• Жүжиг, хөгжимт жүжиг, тайзны урлагийн бүх төрлийн бүтээл;
• Гэрэл зургийн болон түүнтэй төсөөтэй аргаар туурвисан бүх төрлийн бүтээл;
• Дуу авиа бүхий дүрст бүтээл);
• Үүсмэл бүтээл (өмнө бүтээгдсэн бүтээлд тулгуурлаж түүнийг оюуны бүтээлч хүч 

хөдөлмөрөөр засварлах, найруулах, хөрвүүлэх, хураангуйлах, эмхэтгэх болох 
бусад хэлбэрээр өөрчилж шинээр бий болгосон бүтээл);

• Материалыг нь сонгон түүвэрлэх, байршуулах зэргээр бүтээлч хөдөлмөрийн үр 
дүнд бий болсон, өөрийн бүтэц агуулгаараа оюуны бүтээлд тооцогдох тайлбар толь, 
лавлах, зохиолын цоморлог, өгөгдөхүүн мэдээллийн сангийн бусад эмхэтгэлүүд.

Зохиогчийн эрхээр хамгаалагддаггүй бүтээлүүд
Албан ёсны баримт бичиг, ардын урлагийн бүтээл,  төрийн бэлгэдэл ба тэмдэг, санаа, 
үзэл баримтлал, зарчим, үйл явдал ба үйл баримтын тухай мэдээлэл. 

• Интернэтээс мэдээлэл авч ашиглахдаа эх үүсвэрийг нь заавал дурдаарай. 
• Зохиогчийн эрхээр хамгаалагдсан бүтээлийг түүний зохиогчийн 

зөвшөөрөлгүйгээр ашиглаж болохгүй.

1. Номыг хэсэгчлэн болон бүтнээр нь хувилах үйлдлийн талаар шүүн 
хэлэлцэнэ үү. 

2. Бат ардын урлагийн бүтээлийн талаар веб сайт хийж интернэтэд 
байршуулжээ. Энэ нь зохиогчийн эрх зөрчсөн үйлдэл мөн үү? Ардын 
урлагийн бүтээлийг дурын хүн ашиглах боломжтой юу? 

3. Монгол улсын болон бусад улсын дүрс, дуу авиа бүхий хөгжим урлаг, тайз 
дэлгэцийн бүтээлүүдийг вебд байршуулан нийтэд түгээж болох уу? 

ашигладаг, бусдад дамжуулдаг, онлайн харилцаагаа ямар ч хараа хяналтгүй 
чөлөөтэй гэж боддог нь өрөөсгөл юм.

Мэдээлэл, харилцаа, холбооны технологи хөгжиж, дэлхий нийтээр 
даяарчлагдахын хэрээр зохиогчийн эрх ихээр зөрчигдөх болсон. Зохиогчийн 
эрх зөрчигдсөнөөр нийгэм, байгууллага, хувь хүнд сэтгэл санааны болон эдийн 
засгийн хохирол учирдаг. Орчин үед зохиогчийн эрх болон түүнд хамаарах 
эрхээр хамгаалагдах бүтээлийг дэвшилтэт технологиор хамгаалах болсон.

Зохиогчийн эрх гэдэг нь зохиогчийн оюуны бүтээлч үйл ажиллагааны 
үр дүнд бий болсон утга зохиол, урлагийн бүтээлийг өмчлөх эрх юм. Манай 
улс 2006 онд батлагдсан “Зохиогчийн эрх болон түүнд хамаарах эрхийн 
тухай” хуулийг мөрддөг. Уг асуудлыг Оюуны өмчийн газар (http://www.ipom.
mn) хариуцна. Олон улсын хэмжээнд Дэлхийн оюуны өмчийн байгууллага 
ажилладаг. Зохиогчийн эрхийн зүйл нь биежсэн буюу бодит хэлбэрт орсон 
зүйлд хамаарах бөгөөд харин санаа, үйлдэл, үйл ажиллагааны арга, эсвэл 
математикийн үзэл баримтлал зохиогчийн эрхээр хамгаалагддаггүй. 
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• Хөдөлгөөнт холбооны технологийн программ хангамжийн хөгжил нь 
өргөн боломж бүхий “халаасны компьютер”-ыг бий болгосон.

• Гар утсыг хэрэгцээндээ нийцүүлэн зохистой зөв хэрэглэх ёстой. Гар 
утсыг хэрэглэхдээ эрүүл ахуйн наад захын шаардлагыг сахиж, эрүүл 
мэнддээ аюулгүй байхад анхаарна.

• Үзвэр, номын сан, хичээлийн танхим, эмнэлгийн өрөөнд утсаа 
унтраана.

• Яриа болон мессеж нь нэг сүлжээнд болон нэг сүлжээнээс нөгөөд 
тодорхой технологиор дамжуулагддаг.

• Үүрэн холбооны технологи хурдацтай хөгжиж буйн тод илрэл бол гар 
утас. Ирээдүйд ямар байхыг төсөөлөхөд бэрх.

4. Монгол дуу хөгжим, клип, программ хангамж бүхий 10-аас доошгүй тооны 
веб сайтыг хайж олоод өөрийн дуртай дуу, программаа татаж аваарай. 
Чиний хайж олсон веб сайтууд монгол дуу хөгжим, клип, программ 
хангамжуудыг зөвшөөрөлтэй эсэхийг шүүн хэлэлцээрэй. 

2.4.2. Үүрэн холбооны технологи
1. Чингүүний эгч гар утсандаа зураг, дуу, хэрэгцээт файлаа хадгалж, цахим 

шуудан, нийгмийн сүлжээгээ ашиглаж, ажлын хуанлиа хөтөлнө. Түүний 
хувьд гар утас бол сэрүүлэг, тооны машин, зургийн аппарат, видео камер, 
жижиг зурагт, газар зүйн байршил тогтоогч, газрын зураг, гар чийдэн, 
ФМ радио, хөгжим тоглуулагч, компьютерын үүргийг давхар гүйцэтгэнэ. 
Тэрээр “Гар утсаа хаяж гээснээс түрийвчээ хаясан нь дээр” хэмээн хэлэх 
дуртай. Бүх утсанд ийм өргөн боломж байдаг уу?

2. Номин гар утсаа ямагт биедээ авч явдаг, тэр ч бүү хэл дэрнийхээ хажууд 
тавиад унтдаг. Тэрээр унтахаасаа өмнө найзуудтайгаа зурвас (мессеж) 
солилцдог. Нэгэн удаа кинотеатрт кино үзэж байхад гар утас нь чангаар 
дуугарч түүнийг ихэд сандаргасан билээ. Номингийн гар утасны хэрэглээг 
юу гэж дүгнэх вэ? Гар утаснаас яриа ба мессеж хэрхэн дамжуулагддаг вэ?

3. Чингүүн шинээр гарсан Самсунг Галакси утас авав. Гэвч тун удалгүй 
дараагийн хувилбар гарав. Гар утас, үүрэн холбооны технологийн хөгжил 
5 жилийн дараа ямар байх бол? Ирээдүйд бид ямар гар утас ашиглах бол?

Дасгал 1. Багаар (4-5 хүнтэй) ажиллаж, үүрэн холбооны бичил судалгаа хийх. 
Санал болгож буй хувилбарууд;
• Урьдчилсан төлбөрт үүрэн холбооны үйлчилгээний үнийн судалгаа;
• Үүрэн холбооны хэрэглэгчдийн судалгаа;
• Үүрэн холбооны хэрэглээний судалгаа (анги, сургуулийн түвшинд);
• Үүрэн холбооны нэвтрэлт, технологийн судалгаа.
Судалгаанд Мэдээллийн технологи, шуудан, харилцаа холбооны газар, 
Харилцаа холбооны зохицуулах хороо, үүрэн холбооны оператор компаниудын 
веб хуудсыг ашиглаарай. 
1. Судалгааны зорилго, хамрах хүрээг тодорхойлно.
2. Судалгаанд шаардлагатай мэдээллээ тодорхойлно.
3. Хэрэгцээт мэдээллийг цуглуулна.
4. Цуглуулсан мэдээллээ боловсруулж, үр дүнг нэгтгэнэ. 
5. Судалгааны үр дүнд задлан шинжилгээ хийж, дүгнэлт гаргана.
6. Судалгааны үр дүнг танилцуулга боловсруулах программ ашиглан хамт 

олондоо танилцуулна. 
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Утасгүй холбооны систем нь анх 1898 онд утасгүй телеграфийн холбоогоор 
тавигдсан. 1920 онд АНУ-ын Детройд хотын цагдаагийн газарт анхны утасгүй 
холбооны системийг ашиглаж баижээ. Үүрэн холбооны технологийн хөгжлийн 
үе шатыг 1G, 2G, 2.5G, 3G, 4G гэж хуваан үздэг. GSM, CDMA, AMPS, TDMA, 
TACS гэх мэт стандартыг ашигладгаас сүүлийн жилүүдэд GSM, CDMA 
технологийн систем зонхилох байр суурь эзэлж байна. 2014 байдлаар нийслэл, 
21 аймаг, 330 сум, сууринд үүрэн холбооны үйлчилгээ хүрч, үүрэн телефон 
хэрэглэгчийн тоо 4 сая болсон (Эх сурвалж: Цагаан ном-2014, МТШХХГ).
Германы эрдэмтэн Jochen Schiller үүрэн холбоог: 
• Хэрэглэгчийн хөдөлгөөнт байдал (хэзээ ч, хаана ч, хэнтэй ч холбогдох)
• Төхөөрөмжийн авсаар байдал (зөөвөрлөх, сүлжээнд холбогдох)
• Утасгүй холболт (дурын газраас утасгүй холбогдох) гэж тодорхойлжээ. 
Мессеж нь 7 битийн 160 хүртэлх үсэг, тоо, тэмдэгт агуулахаас гадна яриа, 
өгөгдөл, факстай хамтдаа дамжуулах боломжтой. Мессеж нь хадгалах ба 
дамжуулах зарчмаар ажилладаг. Энэ нь хүлээн авагч гар утас үүрэн холбооны 
сүлжээнд холбогдох боломжгүй байсан ч мессежийг тодорхой хугацаанд төв 
дээрээ хадгалж, гар утас сүлжээнд холбогдмогц мессежийг илгээдэг гэсэн үг. 
Мессеж бичээд “илгээх” товчийг дарснаар ямар үйл ажиллагаа явагддаг вэ? 

1. Гар утсаараа 
интернэтэд 
холбогдоно.

2. Программ 
хангамжийн санд 
холбогдоно. 

3. Толь бичгээ 
хайж олно. 

4. Үйлчилгээний 
нөхцөлтэй танилцаад 
толь бичгээ татаж авна. 

• 1983 онд анхны гар утсыг АНУ-д 4000 ам.доллароор худалдаалж байжээ. 
• Дэлхийн анхны SMS мессеж бол 1992 оны 12 дугаар сарын 3-нд Их Британийн 

Vodafone компанийн лабораториос илгээсэн “Merry Christmas” мессеж юм. 
• 2012 онд Apple компани өдөрт 340 000 ширхэг iPhone борлуулдаг байжээ.
• Гар утас нь 00-ийн суултуураас 18 дахин их тооны бактери агуулдаг ажээ. 

Зураг 2.4.1 Гар утасны ярианы технологи 

А-ийн гар утаснаас 
Б-ийн гар утас руу 

дуудлага хийж 
байна.

Хэрэглэгч А

Хэрэглэгч Б

Б хэрэглэгчийг 
хайна.

Холболтын үйлчилгээний төв А хэрэглэгч мөн 
эсэхийг шалгахын зэрэгцээ ярианы суваг байгаа 
эсэхийг шалгана.

Холболтын үйлчилгээний төв Б 
хэрэглэгч мөн эсэхийг шалгана. 
Ярианы суваг байгаа эсэх, яриа 
тогтоох боломж байгаа эсэх болон 
ярианы туршид үүрний шилжилт 
болон тасралтыг хянана.

Хамгийн сайн дохио 
ирж байгаа үүрэнд 
яриа хийгдэж эхэлнэ.

Холболтын 
үйлчилгээний 

төв

A-ийн гар утас 
хамгийн сайн дохио 
ирж буй үүрийг 
хайна.

(Эх сурвалж: Б.Авирмэд, “Хөдөлгөөнт холбоо, 2010 он).

Дасгал 2. Ухаалаг утсанд толь бичиг суулгах
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Зураг 2.4.2 Нэг операторын сүлжээнд 
байгаа А, B, C, D хэрэглэгч мессеж 

солилцох
Зураг 2.4.3 А сүлжээнээс Б сүлжээний 

хэрэглэгч рүү мессеж дамжуулах

1. Манай улсын үүрэн холбооны оператор компаниудад ашигладаг 
технологийг судалж мэдээрэй.

2. Гар утсандаа англи хэлний тестийн программ татаж суулгаад татсан 
программаа сонгосон үндэслэлээ тайлбарлаарай. 

3. Дараах сэдвээс сонгон эсээ бичиж, багшдаа илгээгээрэй. 
• Гар утас малчны хотхонд
• Гар утас бидний амьдралд

Гар утас А

Гар утас Б

Гар утас В

Гар утас В

Бааз станц 1

SMS төв

Холболтын 
үйлчилгээний төв

Бааз станц 2

Бааз станц 3
(Эх сурвалж: Б.Авирмэд, “Хөдөлгөөнт холбоо, 2010 он).

Сүлжээ Б

Гар утас Холболтын 
үйлчилгээний төв

Сүлжээ А

Бааз станц

Гар утас Холболтын 
үйлчилгээний төв

Бааз станц

• Гар утсыг цэнэглэж байх үед ашиглаж болохгүй.
• Дуу цахилгаантай бороотой үед, онгоцоор зорчих үед, шатахуун 

түгээгүүрийн газар зэрэгт гар утас ашиглахыг хориглодог.
• Олон нийтийн газарт гар утсаараа чангаар ярих нь зохимжгүй. 
• Гар утсандаа программ татаж суулгахаасаа өмнө хэрэглэгчийн үнэлгээ, 

үйлчилгээний нөхцөлийг харгалзан сонгоорой. Зарим программ гар 
утасны үйл ажиллагааг удаашруулж, гацаадаг. 

2.4.3. Хайлтын систем, ажиллах зарчим
1. Чингүүн хөл бөмбөгийн баг, тамирчдын зураг цуглуулж, тэмдэглэл хөтлөх 

хоббитой. Гэвч интернэтээс олсон зургууд хэт олон байдгаас сонголт 
хийхэд хэцүү байв. Баг, тамирчдын тухай монгол хэл дээрх мэдээлэл бага, 
голдуу англи хэлээр байв. Чингүүн хэрэгцээт зургаа хэрхэн олж авах вэ?

2. Төгсөх ангийн сурагч Номин гадаадад тэтгэлгээр суралцах сонирхолтой. 
Интернэтээс хайж олсон мэдээллээс заримыг үзсэн ч хэрэгцээт мэдээллээ 
олж чадсангүй, нэг бүрчлэн үзсэнгүй. Номин сонирхсон мэргэжлээрээ 
хүссэн сургуульдаа тэтгэлгээр суралцах мэдээллийг хэрхэн олох вэ?

Мэдээллийг интернэтээс оновчтой хайхын тулд яах ёстой вэ? 
• Хайлтын системийг ашиглана. 
• Хайлт хийх түлхүүр үгийг зөв тодорхойлох хэрэгтэй.
• Интернэтээс зургийг хайхдаа зургийн шинж чанарыг нарийвчлан 

тодорхойлох замаар хайлтын үр дүнг илүү тодорхой болгоно.

• Үүрэн холбооны хөгжил ирээдүйд
• Үүрэн холбооны хэрэглээ
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Дасгал 1. Түлхүүр үгээр хэрхэн оновчтой хайлт хийх вэ?
Хашилт {“ “}. Хайлт хийх түлхүүр үгсийг хашилтад бичиж өгвөл хайлтын 

систем үгсийг өгсөн дарааллаар хайна. Тодорхой хэллэг, холбоо үгс, 
оноосон нэрийг хайхад тохиромжтой. Жишээ нь “Туул гол” хайлтын үр дүн 
нь хашилтгүй бичсэн Туул гол хайлтын үр дүнгээс өөр байна. Хашилтгүй 
бичсэн Туул гол хайлтын үр дүнд Туул гол, Туул, эсвэл гол гэдэг үг орсон 
веб хуудасны жагсаалт гарна.

Хасах тэмдэг {–}. Хайж буй мэдээлэлд оруулахгүй байх үгийг хасах тэмдгийн 
араас бичиж хайна. Жишээ нь компьютер - технологи гэж хайвал зөвхөн 
компьютер гэсэн үг орсон бүх веб хуудасны жагсаалтыг гаргана. 

ЭСВЭЛ {OR}. Хайх түлхүүр үгсийн аль нэг нь орсон веб хуудсыг хайна. Жишээ 
нь Туул OR гол гэж хайвал энэ 2 үгийн аль нэг нь орсон бүх веб хуудсыг 
гаргана. 

БА {AND}. Хайх түлхүүр үгс бүгд орсон веб хуудсыг хайна. Жишээ нь Туул 
AND гол гэж хайвал Туул гол буюу энэ хоёр үг хоёулаа орсон бүх веб 
хуудсыг гаргана.

Од {*}. Өгсөн үгийн хувирсан хэлбэртэй үг бүхий хуудсуудыг хайна. Жишээ нь 
компьютер* гэж хайвал компьютер, компьютерын, компьютертой зэрэг үг 
орсон бүх веб хуудсыг гаргана.

Дээр дурдсан аргуудыг хослуулан ашиглаж болно. 

1. www.google.mn 
хаягаа оруулна.

2. Түлхүүр үгээ 
оруулна

Монгол

3. [Google хайлт] товч дээр дарвал тухайн 
үгээр хайж олсон бүх үр дүн гарна. 

Хайлтын системийн тусламжтай зураг, 
мэдээ, видео зэргийг хайх боломжтой. 

Зураг хайхдаа [Зураг] сонголтыг хийгээрэй. 

Нарийвчилсан хайлт хийхийн тулд 
[Хайлтын хэрэгсэл] товч дээр дараад 
талбар бүрд зааврын дагуу өгөгдлөө 

оруулаад [Google Хайлт] товч дээр дарна. 

Интернэтээс мэдээлэл хайхад ашигладаг хайлтын систем (Search Engine) 
буюу тусгай зориулалтын хайлтын сервер нь интернэт дэх олон сая сервер 
компьютерт байрлах веб сайт, файл, баримт бичгүүдийн талаарх бүрэн 
мэдээллийг агуулах бөгөөд уг мэдээллээ байнга шинэчилдэг. 
Хайлтын систем үндсэн гурван хэсгээс бүрдэнэ. Үүнд:
1. Робот-программ. Ийм программыг “веб аалз” (web spider), мэдээллийн 

жагсаалтыг үүсгэх үйл явцыг “веб мөлхөлт” (web crawling) гэж нэрлэдэг. 
Программ веб хуудсанд бичигдсэн бүх зүйлийг нэг бүрчлэн уншиж нягтлаад 
холбогдох бүх холбоосыг зааврын дагуу дагаж мөрдсөөр дараагийн 
хуудсанд ордог. Хайлтын систем бүр өөр өөрийн робот-программтай. 

2. Индекс. Робот-программ хайж олсон текст бүрийг индексжүүлэн индекс 
файлыг үүсгэнэ. Веб хуудсанд орсон өөрчлөлтийн мэдээллийг индекс 
файлд нэмнэ. 

3. Хайлтын системийн программ хангамж. Энэ нь индекс файл дотроос 
өгөгдсөн түлхүүр үгсийн дагуу тохирох веб сайтыг хайж олоод тэдгээрийг 
түлхүүр үгсийн дараалалтай уялдуулан байрлуулсан жагсаалтыг гаргана. 

Дасгал 2. Google (www.google.mn) системээр нарийвчилсан хайлт хийх.
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Зураг 2.4.4 Робот-программ веб хуудасны агуулгыг хараад хэрэглэгч хайж байсан 
хуудсаа олох боломжийг олгодог хайх түлхүүр үгсийг үүсгэдэг.

Веб аалз буюу робот программ

Өгөгдөл 
кодчилно.

Шинжлэх ухаан
Урлаг соёл
Боловсрол
Спорт 

Аялал жуулчлал
Бизнес
Компьютер
Интернэт

Байгаль орчин
Эдийн засаг
Нийгэм
Улс төр

Өөрийн системд үндэслэн 
индекс үүсгэнэ.

Нүүр хуудас

Олсон үг, тэмдэглэлээр үгсийн жагсаалтыг үүсгэнэ.

Өгөгдлийг хадгална.

Хайлтын систем нь мэдээллийн сангаас тодорхой түлхүүр үгээр веб сайт, 
хуудсыг хайх буюу каталог хэлбэрийн зохион байгуулалт бүхий системээс 
мэдээллийг хайдаг. Олон сая веб хуудаснаас хэрэгцээт мэдээллийг олохын тулд 
хайлтын систем нь веб сайт дээр олдсон үгсийн жагсаалтыг гаргадаг. Хайлтын 
системийн мэдээллийн санг дээр өгүүлсэн тусгай робот-программыг ашиглан 
бүрдүүлэх ба “аалз” веб серверт хандаж тааралдсан бүх мэдээллийг уншаад 
түлхүүр үгсийг тодорхойлсны үндсэн дээр хайлтын системийн мэдээллийн 
санд оруулдаг. Интернэтэд шинээр веб сайт нэмэгдэж, хэрэгцээгүй болсон нь 
устгагдахаас гадна веб сайтын хаяг солигдох зэргээр байнга өөрчлөгддөг. Робот-
программ бүх өөрчлөлтийг бүрэн бүртгэж амждаггүйгээс хайлтын системийн 
мэдээллийн санд байгаа зарим мэдээлэл интернэтэд бодитоор байгаа мэдээллээс 
өөр байх нь бий. Зарим мэдээллийн хаяг буруу, эсвэл тухайн мэдээлэл өөр газарт 
шилжсэн байдаг нь үүнтэй холбоотой. Ерөнхий хайлтын систем мэдээллийн 
ангилал бүхий жагсаалтаас гадна хэрэглэгчдэд хайлт хийх үг оруулах талбартай 
байдаг. Жагсаалтаас ангиллаа сонгоод тухайн ангиллаасаа цааш гүнзгийрэх 
байдлаар хэрэгцээт мэдээллээ олж болохоос гадна хайлтын талбарт хайх 
мэдээллийнхээ түлхүүр үгийг оруулан хайлт хийж болно. 

Гүүгл хайлтын системээр сард 11944 тэрбум хайлт хийгддэг. Уг системээр хамгийн 
их хайлт хийгддэг 5 үг: Martini (мартини), Oprah (нэрт хөтлөгч), William Shakespeare 
(зохиолч), Michael Jordan (сагсчин), Dog (нохой).

1. Хайлтын системээр мэдээлэл хайхад гарч байсан бэрхшээл, асуудлын 
талаар хамт олноороо хэлэлцээрэй. Нийтлэг бэрхшээлүүд юу байв?

2. Нэг ижил түлхүүр үгээр хэд хэдэн хайлтын системд хайлт хийж үр дүнг 
харьцуулж, үр дүн яагаад өөр байгааг тайлбарлана уу.

3. Сурагчид агаарын бохирдлыг бууруулах талаар зурагт хуудас гаргах болов. 
Интернэтээс агаарын бохирдол, түүний хор нөлөөг харуулж болохуйц том 
хэмжээтэй, өнгөт, зурмал зургуудыг хэрхэн хайх вэ? 
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Дасгал 1. Интернэт номын дэлгүүрээс ном авах

1. http://www.bookstore.mn/ 
номын цахим дэлгүүрт орно. 

3. “Шинээр бүртгүүлэх” 
сонголтыг хийж, 

бүртгэлийн хуудсыг 
бөглөнө. 4. Цахим шуудангийн 

хаягаар ирсэн бүртгэл 
баталгаажуулах захианд буй 
холбоос дээр дарж бүртгэлээ 

баталгаажуулна. 

5. “Нэвтрэх” хэсэгт хэрэглэгчийн нэр, нууц 
үгээ оруулж, дэлгүүрт холбогдоно.

6. Номын каталогоос сонгосон номын дэргэдэх 
“Худалдаж авах” товчийг дарвал тухайн ном 

дэлгүүрийн сагсанд орно (Эрх ишиг ном). 

7. Төлбөрийн 
төрлөө сонгоно

8. “Үргэлжлүүлэх” товчийг 
дарж, нээгдэх төлбөрийн 
хуудсанд төлбөрөө төлнө.

2. “Нэвтрэх” 
холбоос дээр дарна

Дасгал 2. ТҮЦ машинаас оршин суугаа хаягийн тодорхойлолт авах

ТҮЦ машин мэдээллийг бүртгэж 
аваад УБЕГ-ын мэдээллийн 
сантай тулгалт хийж шалгаад 
мэдээллийг дэлгэц дээр 
харуулна. 

4

“Кредит карт” сонголтыг хийж 2 
дугаарын төхөөрөмжид картаа 
хийнэ. 

6А

“Бэлэн мөнгө” сонголтыг хийж 
9 дугаартай төхөөрөмжид 
үйлчилгээний хураамж болох 500 
төгрөгийг хийнэ. 

6Б

Төлбөрийн хэлбэрээ сонгоно.
5

Дэлгэцээс “Оршин суугаа хаягийн 
тодорхойлолт” үйлчилгээг сонгоно. 

1 

Иргэний цахим 
үнэмлэхээ 
2 дугаарын 
төхөөрөмжид 
оруулна. 

2

10 дугаартай 
төхөөрөмжөөс 
тодорхойлолтоо авна. 

7

5 дугаартай 
төхөөрөмж дээр 
баруун гарын 
долоовор хурууны 
хээгээ уншуулна. 

3

4. Газар зүйн багш Монгол Улсын хүн амын газар зүй сэдэвт хичээлээр хүн 
амын өсөлт, нас хүйс, нийгмийн бүтэц, хөдөлмөрийн нөөц, ажил эрхлэлтийн 
талаар бичил судалгаа хийх даалгавар өгчээ. Хэрэгцээт мэдээллийг 
интернэтээс хайж, олсон хаягуудаа найзуудтайгаа хуваалцаарай.

Хайлтын системүүд нь мэдээллийн сан, мэдээллийн агууламжаараа өөр өөр 
байдаг учир нэг системээр олдоогүй мэдээлэл өөр системээр олдож болно.

2.4.4. Цахим үйлчилгээ ашиглах
1. Чингүүн сургуулиас шаардсан оршин суугаа хаягийн тодорхойлолт авахын 

тулд харьяа хороон дээр 2 удаа очсон боловч бүртгэлийн ажилтан гадуур 
ажилтай байсны улмаас авч чадсангүй. Чингүүн тодорхойлолтыг заавал 
хорооноос авах ёстой юу? 

2. Бага ангид сурдаг дүүгийнх нь хичээлд “Эрх ишиг” ном хэрэгтэй болов. 
Цаг нэгэнт орой болсон тул номын дэлгүүрүүд хаасан байв. Чингүүнд ном 
авахад туслаарай. 
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Цахим сургалт
Алсаас мэдээллийн технологийн тодорхой хэрэгслэл ашиглан мэдлэг 

хуримтлуулах, мэдлэг түгээх буюу дамжуулах үйл ажиллагаа буюу сурагчаас 
орон зай, цаг хугацааны хувьд алслагдсан хэн нэгэн сургалтыг удирдаж 
суралцах хамтын ажиллагаан дээр тулгуурласан сургалтыг цахим сургалт 
гэнэ. 
Дараах хэлбэрээр зохион байгуулагдана. Үүнд:
• Хичээл бүрийн багц материалыг (лекц, лабораторийн хичээл, тест, бие 

даалт, шалгалтын сэдэв, нэмэлт материал, ном зохиолын жагсаалт) 
мультимедиа технологи, тусгай программ хангамж ашиглан оруулж, 
сүлжээнд холбогдсон сервер компьютерт, хичээлийн санд хадгална. 

• Хичээлийн санд хичээл хуримтлуулах; сурагчийг бүртгэх; хичээлийг 
сонгож үзэх эрхийг сурагчид олгох; эрх авсан сурагчид сонгосон хичээлийг 
нь өгөх; хичээлийн явцыг хянах; шалгалт авах; дүнг бүртгэх зэргээр 
сургалтыг удирдах тусгай программ хангамж мөн сервер дээр ажиллана. 
Уг системийг цахим сургалтын систем гэнэ. 

• Суралцах эрх авсан оюутан интернэтэд холбогдсон компьютерын 
тусламжтайгаар байгаа газраасаа өөрийн сонгосон хичээлийг судална. 
Цахим сургалтын хичээл нь ерөнхийгөөсөө цааш задран, цаашилбал 

мэдээллийг зөвхөн унших бус сонсох, илүү ойлгомжтой, бодитой хэлбэрт өнгө 
дүрс хөдөлгөөнд нь харах, сэдэв болон дэд сэдэвт хандахад хялбар, эргэх 
буцах холбоотой, шинэчлэн өөрчлөхөд хялбар байдгаараа давуу талтай.

• ТҮЦ машинаас оршин суугаа хаягийн тодорхойлолт, лавлагаа авч болно. 
• Интернэтээс ном болон бусад барааг худалдан авч болно.
• Цахим үйлчилгээ 24 цагаар ажилладаг, газар зүйн хязгаарлалт байхгүй.

Зураг 2.4.5 Цахим сургалт, түүнийг хэрэгжүүлэх орчин
Орчин үед цахим сургалтад компьютероос гадна гар утас, зөөврийн 

төхөөрөмжийг өргөнөөр ашиглах болсон. Цахим сургалт нь мобайл сургалт 
(m-Learning), хөдөлгөөнт сургалт (u-Learning), вебд суурилсан сургалт зэрэг олон 
чиглэлээр сургалтад нэвтэрч байна.

Цахим арилжаа
Цахим худалдаа (e-commerce) гэдэг нь интернэт зэрэг цахим системээр 

дамжуулан хүмүүст бараа бүтээгдэхүүн болон үйлчилгээг цаг хугацаа болон орон 
зайнаас үл хамааран арилжих, худалдах, солилцох, худалдан авах явдал юм. 

Боловсролын 
асуудал 

эрхэлсэн төрийн 
захиргааны төв 

байгууллага
ЦАХИМ 

СУРГАЛТЫН ТӨВ

Нээлттэй 
сургууль

Сурагч

БагшХууль эрх зүйн орчин

Гадны бусад 
хүчин зүйл
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БҮЛЭГМЭДЭЭЛЭЛ БОЛОВСРУУЛАХ ТЕХНОЛОГИЙН ХЭРЭГЛЭЭ МЭДЭЭЛЭЛ БОЛОВСРУУЛАХ ТЕХНОЛОГИЙН ХЭРЭГЛЭЭ

Цахим банк
Цахим банкны үйлчилгээгээр дамжуулан төлбөр тооцоо, мөнгөн хадгаламж, 
зээлийн үйл ажиллагааг хурдан, шуурхай, найдвартай гүйцэтгэх боломжтой. 
Цахим банк нь дансны үлдэгдэл харах, гүйлгээний мэдээлэл, хуулга хэвлэн 
авах, банк хоорондын төлбөр тооцоо гүйцэтгэх, нэхэмжлэлийн дагуу төлбөр 
гүйцэтгэх, гадаад ба дотоод мөнгөн шилжүүлэг хийх, зээлийн дансны гүйлгээ 
болон үлдэгдлийг шалгах, валют арилжааны хөрвүүлэг хийх, хадгаламжийн 
хугацаа сунгах зэрэг үйлчилгээ үзүүлдэг. 
1. Тодорхой нэг интернэт дэлгүүрийг сонгон авч, түүний бүтэц, үйл 

ажиллагааны талаар судалж, тайлбарлан бичнэ үү. 
2. Интернэт банкны үйлчилгээг судалж, харьцуулаарай. 
3. Аав ээжийнхээ тусламжтай интернэт, гар утсаар төлбөр хийж үзээрэй.
4. ТҮЦ машины бүтэц, ажиллах зарчмыг судалж, үйлчилгээ авах үйлдлийг 

блок схемээр илэрхийлнэ үү. 
5. Мобайл банк ба мессеж банкны талаар судалж, онцлогийг тайлбарлаарай.
Интернэтээс цахим үйлчилгээ авахдаа ердийн веб хөтөч программ ашиглана.

Өөрийгөө сориорой

1. Үүрэн холбооны 1G, 2G, 2.5G, 3G, 4G технологиудын талаар судалж, 
тэдгээрийн хөгжил, онцлогийг бүдүүвчлэн зурж харуулна уу. 

2. Гар утасны сургалтын монгол программ хангамжууд байдгийг судлаарай. 
3. ТҮЦ машины үйлчилгээг судалж, иргэний үнэмлэхийн лавлагааг аваарай. 

Зураг 2.4.6 Цахим арилжаа хийх нь

Барааг худалдан авна
Дэлгүүрийн сагс Төлбөр төлөх

Худалдан авах 
захиалга хийгдэнэ

Хэрэглэгч, дэлгүүр болон 
банк руу мэдээлэл илгээнэ

Агуулахад мэдээлэл 
илгээгдэнэ

Барааны ачилт 
хийгдэнэ

Хэрэглэгчид барааг 
хүргэнэ

Цахим худалдааны хэлбэрүүд: 
• Бизнесээс хэрэглэгчид хандсан (B2C, Business to Consumer) систем. Жишээ 

нь www.amazon.com зэрэг дурын интернэт дэлгүүрээс бараа худалдан авч, 
виза картаар төлбөрөө гүйцэтгэж байгаа худалдан авагч байж болно. 

• Бизнесээс бизнест хандсан (B2B, Business to Business) систем нь байгууллага 
хоорондын хамтын ажиллагааны төрөл бүрийн хэлбэрийг хамруулдаг. 

• Засгийн газраас бизнест хандсан (G2B, Government to Business) систем нь 
засгийн газрын худалдан авалт буюу улсын захиалга байна. Үүнд төрийн ба 
бизнесийн байгууллага хоорондын бүх төрлийн гэрээ хэлцэл хамаарагдана. 
Жишээ нь, засгийн газар худалдан авах бараа, үйлчилгээгээ интернэтээр 
зарлаж, компаниуд хүсэлтээ цахим аргаар илэрхийлдэг.  

• Хэрэглэгчээс хэрэглэгчид хандсан (C2C, Consumer to Consumer) систем. 
Хамгийн өргөн дэлгэрсэн хэлбэр бол цахим дуудлага худалдаа (auction), 
зарлалын самбар юм. Жишээ нь eBay дуудлага худалдаа.


